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64 must-have Mac apps
Your chance to ensure you aren’t 

missing out on any of these great 

apps and utilities that can make your 

Mac even better and your life easier.

Refresh your Mac
You don’t need to dash to a Genius Bar 

to speed up your Mac, thanks to this 

insight advice on clean-up techniques 

you can try out at home.

64 must-have iOS apps
Get even more value from your iPhone 

and iPad with these absolute gems for 

doing everything from keeping a journal 

to making paintings in just a few taps.

3220 46
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offers on
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We’ve been Waiting for updates to 
the iPad lineup for a while now, and 
Apple didn’t disappoint with its late 
March announcement of a replacement 
for the iPad Air 2. More eye-catching, 
though, is the new color option on the 
iPhone 7 and iPhone 7 Plus. You can 
read all about these new devices on 
page 10. Already bought an iPhone 7? 
Apple has new case options to give it 
a fresh look, and has also introduced an 
abundance of new Watch straps, plus a 
bright red smart cover that works with 
the iPad Air 2. So, if you’re happy with 
your existing devices, you can at least 

give them a makeover. Turn to page 16 to learn more. That said, 
next time I upgrade my iPhone, I’ll probably pass on cladding it 
in a case, and opt for the lovely PRODUCT(RED) option.

These new products represent a rather modest start to 2017 
for Apple. Even the new iPad isn’t pushing the envelope given 
that it uses the A9 chip design, which first debuted in the iPhone 
6s and iPhone 6s Plus back in 2015. Of course, a large part of 
the new iPad’s appeal is that it’s more affordable than the Air 2, 
which is a good thing for anyone who is thinking of upgrading or 
buying their first tablet. What we – and you, no doubt – want to 
know is when Apple will get around to delivering truly new stuff.

I hope that all desktop Macs will receive updates very soon. 
However, I think the most exciting things to come in the world of 
Apple this year will be in software. Everyone has their own ideas 
of how Apple should tweak its operating systems and apps, but 
while it takes a steady, considered approach to evolution, some 
areas stand out more than others as deserving attention.

My wish is for HomeKit to become much more capable in iOS 11. 
Right now, I can’t tell the Home app to temporarily disable my 
security camera’s motion detection when I’m home, and to stop 
notifying me that I’ve stood up from my sofa – it should be able 
to do that based on the times I arrive and leave home each day, 
with a little bit of intelligence mixed in to handle exceptions.

apple’s path in 2017

alan stonebridge, Editor

Twitter: @alstonebridge

>>>ThE TEam

J.r. bookwalter
Contributor 

Forget existing apps; tell 

J.R. about your new ones 

so he can review them.

Mat gartside
art editor 

Mat’ll try more apps from 

our must-have list once 

he’s done with Iron Fist.

ed ricketts
operations editor 

Since reading our big 

apps list, Ed has fallen 

in love with Brushstroke.
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Email: letters@maclife.com
FacEbook: facebook.com/maclife  TwiTTEr: twitter.com/maclifeSHarE wiTH US!

We forgot to 
mention a menu 
command might 
change based  
on preferences.

“Apple TV is in decline - what’s going wrong?” in 
the April 2017 issue was of special interest to me. 
The only thing that’s stopped me moving from a 
3rd-generation Apple TV to the latest model is 
that the newer version omits fiber optic audio 
output. My audio receiver has this type of input 
and serves me well for surround sound, but it has 
no HDMI input.

I’ve investigated using a converter to change the HDMI output to 
fiber optic, but I have read that the success of these converters is 
hit-and-miss. As for my older audio receiver, it is still functioning 
well, so I can’t justify spending hundreds of dollars on a new receiver 
with HDMI input just to have surround sound on a new Apple TV.

I know I’m not alone. I have read many reviews where others have 
expressed displeasure at the fiber optic output’s removal. JEFF aTkin

Do you have, or can you borrow, an AirPort Express? All versions of it 
feature a combined analog/optical audio output. With it connected to the 
same network as your Apple TV, you should be able to enable its ability 
to act as an AirPlay receiver, then set your Apple TV to send audio to it.

This adds an extra level of complexity by involving your network in 
getting audio to your receiver, but AirPlay should keep the audio and 
video in sync. We don’t have an audio receiver to try this, so if you have 
no way to try it out rather than spending money, see if your nearest 
Apple Store or reseller can advise further, or try it out with you in store.

conversion confusion
I attempted to follow the 

instructions in “Add your own 

ringtone” (April issue). When 

I went to File > Convert, Create 

AAC Version was not an option. 

Only Create WAV Version was 

there. Did I miss some step?

ron

You didn’t, we did. in that 

advice we overlooked that the 

menu command differs based 

on your choice of encoder in 

iTunes > Preferences > General 

> import Settings. Switching 

the import Using pop-up menu 

to aac Encoder will fix this. 

sent Apple log files in the hope 

it fixes this in 10.12.4.

GEomGUY

You’re wise to use something 

like SuperDuper, too. our next 

issue features a guide to 

backing up. macoS 10.12.4 

was released as we went to 

press; let us know if it works.

Sierra is impersonal
I am a longtime Mac user and 

Mac|Life (and MacAddict) 

reader. Ever since I upgraded 

to Sierra, my personalized 

folder icons stopped working. 

That is, only the ones for aliases 

where the root folders are not 

on my system drive (but on a 

network server).

I can put a new alias that 

shows the custom icon on my 

desktop, but after I restart the 

Mac, the alias returns to the 

standard icon. This is happening 

on both of my Mac Pros – the 

latest, and a 2010 model.

Apple doesn’t seem to know 

what is happening. It suggested 

I reinstall everything.

manrico caGlioni

we’re also puzzled. readers, 

if you know what’s up, email 

us at the address below.

apologies for the oversight; 

our settings are on aac, 

which is the default.

Time machine troubles
Time Machine and Sierra could 

have been a disaster for us. 

Luckily we haven’t had to go 

back and retrieve files; we also 

use SuperDuper to clone our 

drives every night.

We noticed that if we restart 

our Macs, Time Machine loses 

“On My Mac” folders. This does 

not happen if we just use Sleep. 

We never had these problems 

with El Capitan. We’ve tried 

resetting all sorts of things, and 

Let us know if Sierra resets your 
custom folder icons to default.

 maclife.com  May 2017   9
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The first 
new Apple 
hardware 
of 2017
iPhone comes in a new 
color, and iPad receives 
a specification boost
BY Ed RickETTs

in EARlY MARch Apple did 
something very un-Apple-like: 
It launched several new products 
via a few simple change to its online 
store, rather than sending out 
cryptic invites to a One More 
Thing-style launch.

To be fair, the products it 
introduced are updates rather than 
entirely new devices. Most striking 
among them are the new red models 
of iPhone 7 and 7 Plus, which are 
available with 128GB or 256GB of 
storage. Bought SIM-free without 
a contract, and not locked to any 
particular carrier, the lower capacity 
costs $749 in the 4.7-inch iPhone 7, 
and $869 in the 5.5-inch iPhone 7 
Plus. The higher capacity costs $849 
in the smaller phone, and $969 in 
its pocket-filling sibling.
 Specifically, these phones have 

PRODUCT(RED) finishes: This is a 
licensed brand owned by (RED) that 

The red aluminum is 
eye‑catching, and 

almost makes us wish 
we’d waited a while 
to buy an iPhone 7.

Check out the new 
colors of iPhone, 
iPad, and Watch 

accessories  
p16

GO

FEED YOUR MIND. FEAST YOUR EYES.

START
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Feed your mind. Feast your eyes.

Why clips is smarter 
than you think
Apple’s new video capture and editing 
tool could rule social media BY Ed RickETTs

AT fiRsT glance you might 

wonder why Apple has bothered 

to introduce Clips, its upcoming 

mobile video app. Clips promises 

filters, stickers, and simple 

recording that makes it easy to 

create snazzy video, uh, clips – 

but then, so what? Snapchat, 

Instagram, and countless other 

apps have that covered, right?

As usual, though, Apple has 

thought that one step further. 

For one, Clips isn’t a messaging 

app or a social media platform – 

its sole aim is to create video, 

which you can then share using 

the app of your own choice. Hold 

a button to record, and let go to 

stop. Once you’re done, you can 

drag clips into some kind of order 

and add effects, emoji, animated 

icons and the like. It’s like iMovie 

distilled into its purest form.

Plus, of course, there’s text – 

and this is where one of Clips’ 

best features comes to light. 

It’s called Live Titles, and it 

performs the seemingly simple 

task of transcribing your voice 

into written subtitles, while 

following the rhythm of your 

speech: Text appears precisely 

at the moment you say a word, 

making it easy to caption videos.

Live Titles is powered by Siri’s 

dictation capabilities. Reports 

from early testers reveal it to be 

remarkably accurate – and even 

if it does get a word wrong, you 

can edit it later while still keeping 

the time-coding. Live Titles 

supports 36 languages, with 

more to follow.

Adding music to your video is 

also incredibly simple, with a 

selection of fairly typical mood 

pieces. These can alter their 

length to fit your video, with 

parts being selected dynamically 

and seamlessly.

Clips works on iPhone models 

all the way back to the 5s, all 

iPad Air and Pro models, the new 

9.7-inch iPad, iPad mini 2 and 

later, and the 6th-generation 

iPod touch. We can’t wait to see 

the effect it has on social media. 

Apple announced an April 

release for the app.

tries to engage the private sector in 
raising awareness and funds to help 
eliminate HIV and AIDS in eight 
African countries. A share of the 
profits raised from these iPhone 
models will go to that cause.

Meanwhile, the iPhone SE, with its 
more pocketable 4-inch screen size, 
has received a noticeable storage 
bump, with options being doubled to 
32GB and 128GB, costing $399 and 
$499 off-contract, respectively. 
More significantly in hardware 

terms, the iPad Air line of devices 
has ceased to exist, with the iPad Air 
2 being phased out and replaced with 
an upgraded 9.7-inch device that’s 
simply named iPad. 

This new model still features a 
2048x1536-pixel Retina display, 
but Apple says it’s brighter than 
the screen in the outgoing model. 
There’s also a newer A9 chip, as 
opposed to the older Air 2’s A8X, 
and while the new model is slightly 
thicker and heavier, and it has been 
reported that the screen is not 
laminated. The new iPad is more 
affordable than the Air 2 it replaces: 
$329 for the 32GB model and $429 
for 128GB with Wi-Fi only; add $100 
to each price to gain cellular access.

As for the 7.9-inch iPad mini, the 
only change to its specs is in storage 
capacity. The iPad mini 4 now has 
more of it – 128GB instead of 32GB –  
for the same $399 price as before 
($529 to add cellular connectivity), 
while the iPad mini 2, introduced in 
2013, has been discontinued.

Clips looks like a fun, faster way than 
iMovie to make social media videos.

FEED YOUR MIND. FEAST YOUR EYES.

START
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Touch ID looks 
to go ultrasonic

Apple pursues research  
into advanced fingerprint 

recognition for the iPhone
BY GeralD lYnch anD  

alan sToneBrIDGe

apple’s pursuIT of thinner, lighter, bezel-free phones 
seemingly knows no limits, and its quest to make the 
sleekest device possible looks set to focus on improving 
the fingerprint scanner.

A new patent shows the company once again turning 
its attention to the possibility of embedding an ultrasonic 
fingerprint scanner into the display of its future phones, 
though it’s not yet known whether the tech is intended 
for the iPhone 8 or a model further into the future.

It’s the second time we’ve heard evidence of such a 
system being employed, adding weight to the likelihood 
that the feature will eventually make it into the wild.

So, what’s the benefit of this method rather than a 
physical Touch ID sensor that’s built into the Home 
button? As well as the space saving efficiencies of 
putting the tech under the screen, Apple sees the 
ultrasonic tech as “the most accurate but least common 
finger-scanning technology.”

It states that: “Contaminants such as grease, lotion, 
dirt, sweat, and food particles on a finger can degrade a 
captured fingerprint image, which can prevent a 
fingerprint sensing device from matching the captured 
fingerprint image to a known fingerprint image. 

“Alternatively, a finger contacting an input surface 
of the fingerprint sensing device with too much or too 
little pressure can reduce the quality of the captured 
fingerprint image and prevent the fingerprint sensing 
device from recognizing the user.”

The patent also states the idea could be combined with 
the current technology to improve it. It sounds to us, 
though, like it fits with recent hints we’ve heard about 
an iPhone with an on-screen Home button.

As ever with a patent application, it’s not a guarantee 
of a product or feature being in development. But with 
evidence mounting, we’d say this one is steadily edging 
towards inevitability rather than just being a possibility.

>>>Start Feed your mind. Feast your eyes.
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>>> David Chartier is a content strategist and writer with vast experience analyzing the tech world.  

He runs the website Finer Things in Tech (finerthings.in) and hosts its podcast, The Finer Things In.

b
ack in 2007, after Jobs 
walked off the stage from 
unveiling the iPhone, one 
of the people he spoke with 

was Alan Kay. A pioneer of early 
computers and also the first 
graphical interface, Kay famously 
told Jobs: “Make the screen five 
inches by eight inches, and you’ll 
rule the world.”

Once Apple debuted such a 
screen in 2010 with the iPad, it 
initially coined the term “post-PC 
device” to try  to contextualize the 

iPad’s progressive, though at times 
nebulous, place in technology’s 
landscape. More recently, Apple 
has started making a direct pitch 
for the iPad as a PC replacement. 
Of course, there is still plenty of 
work to do toward that goal. But 
I think a number of Apple’s recent 
moves have laid the foundation 
for some significant evolution to 
come, and probably soon.

To understand the iPad’s journey 
toward replacing the PC for a 
broader audience, we can’t think 

about solving problems in 
traditional Mac or PC terms. For 
example, instead of duct-taping 
the age-old windows (lowercase 
“w”) mechanism onto iOS, Apple 
added things like Split View for 
using apps side-by-side, and 
Picture in Picture for watching 
videos in a movable box on top 
of what you’re doing. 

Instead of moving over the 
traditional file system from macOS 
and Windows – where most people 
seem to just ignore it anyway and 
toss everything on the desktop – 
Apple added “Document 
Providers” in iOS 9, which makes 
it much easier to open and move 
files between apps.

Now, these features don’t go far 
enough for everyone yet. But Apple 
is a patient, methodical company. 
Look at Split View and Document 
Providers – two features designed 
to help people work more 
effectively between apps. I expect 
to see more features like this come 
to iOS sooner than later, and 
expanding upon the “drag and 
drop” mechanic feels likely. It’s 
already in iOS in various forms –
long-press on a Home screen icon, 
then drag and drop to rearrange 
them. We can also drag and drop 
to rearrange things like songs in 
a playlist or layers in a photo app. 
Split View feels like an obvious 

next step for drag and drop; it 
would reduce a lot of cross-app 
friction and be a big general 
productivity booster.

I think another likely addition 
sooner than later is some form of 
Xcode for iOS. Developers may be 
a small portion of the iPad’s 
audience, but they are the creators 
that make a platform shine. Since 
most developers can’t build much 
on the iPad, they generally don’t 
use it as a daily device, and thus 
aren’t using or exploring to its full 
potential. Apple’s recent release 
of Swift Playgrounds, a great 
instructional app for learning to 
code, is a strong sign.

Like most things in life, the iPad 
can’t make everyone happy, nor 
should it aspire to. But as Apple 
continues to add tools and close 
the gap, the iPad can open some 
incredible doors and truly become 
a post-PC device for more people.

The iPad’s journey beyond the PC is only just 
getting started, argues david chartier, 
and Apple is in it for the long haul

>the shift

More recently, apple 
has started making 
a pitch for the iPad 

as a Pc replacement

The iPad 
has plenty 
of room 
to improve.
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Feed your mind. Feast your eyes.

F
rankly, it’s hard to 
overstate the impact of the 
iPhone on the game industry. 
In 2007, my field was only a 

$9.5 billion industry. In the decade 
since, it’s exploded to a $91 billion 
dollar industry, with mobile 
making up almost half of our 
sales. By prioritizing accessible 
gameplay, the iPhone gave all of 
us a place to become gamers.

When I speak at colleges, the 
question I’m asked most often is 
“How do I work in the game 
industry too?” Well, the good news 
is that anyone can work in games. 
There’s a false idea that you need 
to have been programming since 
you were a teenager, must be in 
your 20s, and must have a 

specialized degree. None of that 
is true these days. 

Yet I’m often struck by how 
little outsiders to the industry 
understand how to get into our 
field. I often meet people that 
want to be employed by the game 
industry as an “idea person.” 
They have a fantasy of dreaming 
up games and having the rest of 
the company make it for them. 
So I’m here to give you a practical 

how-to guide on becoming a game 
developer in the modern industry.

firstly, the game industry 
doesn’t need any more people 
with ideas; we already have that. 
We need people that can take 
those ideas and turn them into 
reality. You need a skill, or a set 
of skills, to bring to what’s called 
a production pipeline.

Look at this screen, bottom left, 
from one of my favorite games 
on iOS, Vainglory: a gorgeous 
competitive MOBA. Notice all the 
elements here. A 3D modeler 
created the assets, a materials 
artist textured them. A character 
designer created all the heroes, 
and a game designer spent months 
doing playtesting to balance them. 
All of these people were hired 
because they could solve problems 
for the development team.

To work in the game industry, 
you need relevant skills. Find an 
area you’re passionate about, be 
it 3D modeling, animation, or 
programming - and start obsessing 
over it. There’s no shortcut for 
what I call “butt in chair time” – 
the many, many hours you will 
spend failing before you start to 
get good. Start reading industry-
relevant publications, get feedback 
from people that are further along 
than you. Don’t be afraid to make 
mistakes – it’s part of the process.

i’m often asked if you need 
a degree to work in the game 
industry. The answer is no, you 

Just how do you get into the gaming 
industry? Brianna wu reveals what 
development teams are really looking for

>game loop

find an area you’re 
passionate about, be 
it programming, 3D 

modeling, or animation

>>>Start
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>>> Brianna Wu is the head of development at Giant Spacekat, developer of Revolution 60 on iPhone and iPad,  

and a regular speaker at industry events, as well as host on the podcasts Isometric and Rocket.

the best part of 
working on an indie 
team is learning to 
work in a pipeline

need a portfolio - a body of work 
that shows you can deliver. 

With the explosion of gaming 
as a hobby, there’s no shortage of 
colleges catering to young gamers. 
But often these are private schools, 
charging anywhere from $50,000 to 
$100,000 for a degree. I’m often sent 
portfolios by students that have 
managed to graduate, but haven’t 
spent the time perfecting their craft. 
And the truth is, many of them are 
unemployable. But many of the more 
driven students will be picked up to 
work at EA or Activision. As in other 
fields, you get from education what 
you put into it.

Another path is to join an indie 
team and learn as you go. There are 
many meetups in most major cities. 
Although most of these games will 
die from a lack of follow-through, 
even if one doesn’t ship you’ll learn 
things along the way. 

The best part of working on an 
indie team is learning to work in 
a pipeline: getting a part of a game 
from someone, adding to it with your 
skills, and passing it to the next 
person. Game development is an 
extremely collaborative profession, 
and learning to compromise and 

solve potential team conflicts are 
crucial skills. 

It’s worth adding that the most 
stable jobs by far in the game 
industry are for programmers. If you 
have an iPad, you can start learning 
to program right now by launching 

Swift Playgrounds, which is an 
excellent tool. Or play the excellent 
iOS game Human Resource Machine.

Back in college, I put off learning 
my language credits until the very 
last minute. So I spent an entire 
summer, eight hours a day, in 
intensive Spanish classes. It was a 
terrible experience at first, because 
I felt stupid for most of those eight 
hours, not being able to understand 
much of what was being said. But 
eventually I started to pick up the 
language, and I became one of the 
best students in my class.

This is what becoming a game 
developer is like, because it’s an 
extremely frustrating skill to learn. 
You will spend hours being stumped 
by problems. You will get angry. 
And, sometimes, you will want to 
quit. Don’t. Successful game 
developers aren’t any smarter than 
you are; they’re just more stubborn.

Learn to code well 
and you’ll have a 
great chance of 

getting a job.
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Feed your mind. Feast your eyes.

($339) is available in Lime Epsom, 
and Colvert Swift.

Aside from the Hermès straps, 
which are available only for 42mm 
Watches, the other new straps are 
available in 38mm and 42mm sizes.

Last but not least, there’s a new 
PRODUCT(RED) Smart Cover ($39) to 
protect the screen of an iPad Air 2 or 
the new 9.7-inch iPad.

Alongside new ios devices Apple 
has released fresh new colours and 
designs in its first-party lineup of 
iPhone, iPad, and Watch accessories.

There are three new colors each 
in Apple’s ranges of silicone and 
leather cases. The former material 
now comes in Camellia, Pebble, and 
Azure hues, and the latter has added 
Taupe, Berry, and Sapphire variants; 
(the latter two are shown here).

The iPhone SE has a new Saddle 
Brown leather case option, which is 
also shown to the bottom right.

There are also, of course, new 
strap colors for the Watch. You can 
coordinate the Sport Band ($49) with 
your choice of silicone iPhone case, 
as the fluoroelastomer strap is also 
available in the Camellia, Pebble 
(pictured above), and Azure colors. 
Want a strap that evokes energy? 
Apple offers three standalone Nike 
Sport Bands ($49) in Pure Platinum/
White, Anthracite/Black, and Black/
Volt (pictured, top right) combos.

You also have new woven nylon 
band ($49) options: Berry, Orange, 
Red, Pollen, Tahoe Blue, and 
Midnight Blue. The Classic Buckle 
design ($149) now comes in Berry, 
Sapphire, Midnight Blue, Black, Red, 
Saddle Brown, and Taupe. And the 
Hermès Single Tour leather strap 

If you care 
less about  

protecting the 
back of your 

iPad, this red 
cover is half 
the price of 

a Smart Case.
Though not as bright as the PRODUCT(RED) 
iPhone, Apple’s new case colors are still snazzy.

new-look 
accessories 

for your 
iPhone, iPad 

and watch 
Add a splash of new 
color to the devices 

you already own

>>>Start
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Tag Heuer Connected Modular 45
tagheuer.com
From $1,550

>>> Are you put off by the rectangular screen 

on Apple Watch? Apple’s choice doesn’t mean 

you can’t get a smartwatch with a circular face, 

though you’ll need to be happy to mix your 

Apple gear with another kind – in this case, 

the Android Wear system that powers this 

gorgeous-looking luxury device from Tag Heuer. 

This is the first Swiss-made smartwatch, and 

it features an AMOLED display. You’ll need 

an iPhone 5 or newer, running iOS 9 or later. 

It’s nice to have options for personal devices, 

especially when they look as nice as this one.

>>>Start Feed your mind. Feast your eyes.

THE GEAR WE’RE LUSTING AFTER

CRAVE
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Philips Hue E14 candle meethue.com
$29.95 (White ambiance),  
$49.95 (White and Color ambiance)

>>> Philips’ range of Hue bulbs is set to gain two new 

members later in 2017. The forthcoming models will 

feature the E14 thread size, which will enable you to 

use them in lamps and other things with that fitting. 

The White Ambiance bulb is adjustable through 

warm to cool white light, and Philips says it can help 

you to wake up and go to sleep naturally. Meanwhile, 

the White and Color Ambiance bulb can be set to 

one of 16 million colors. The Hue Bridge that enables 

Hue products to work with Apple’s HomeKit system 

consequently means you’ll no longer have to fumble 

for your bedside lamp’s switch – just talk to Siri.

Ultimate Ears Wonderboom
ultimateears.com
$99.99

>>> This portable Bluetooth speaker is designed to 

be used around water. It’s as good for pool parties 

as it is around your bath or shower; its maker says 

it’s entirely waterproof, it floats, and any muck that 

gets on it can simply be washed off. It can survive 

a drop of up to five feet, too. A button on the top 

can pause, resume, and skip tracks. You can also 

pair two of the speaker. Ultimate Ears says the 

Wonderboom can run for 10 hours.

Flow
plumelabs.com
$TBC

>>> It looks a little like a speaker, but Flow is actually 

a smart air quality tracker. It’s not just for inspecting 

air quality indoors, either – it’s a small device you 

can hold in your hand, or tie to your bag so it can 

do its job while you’re outdoors. Flow can sense 

particulate matter and dust, exhaust fumes, ozone, 

household chemicals, temperature, and humidity. 

The idea is that every Flow user feeds data into the 

same system, building a more thorough picture of 

where air is good or bad, and highlighting the best 

places and routes around your city.
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128 128 128
Must-have 
apps for Mac 
and iOS

>
each of us has a 

core set of apps we 

use all the time, but 

what if you haven’t 

discovered the one app that’ll 

totally improve your Mac or iOS 

experience? How would you like 

128 of them? When we started 

making this list, we were adamant 

no entries should be from Apple, 

as you likely know its apps well 

already. (Apple then bought one 

of them, but that shows how good 

it is.) So, here are 64 must-have 

Mac apps, and starting on page 

46 you’ll find our picks for iOS.

>>>Feature
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128 128 128 TweeTboT $9.99

tapbots.com

I use Tweetbot 

to keep up with 

Twitter largely 

to use its ability to keep 

multiple columns open for 

saved searches, direct 

messages, and multiple 

accounts’ timelines. I also 

love its features for muting 

topics that are getting in 

the way, by hashtag or 

keyword, the latter of which 

can be an explicit phrase or 

a matched pattern.

boom 2 $19.99

globaldelight.com

I expect many of 

us play a lot more 

media outside of 

iTunes than in it these days 

– youTube, Facebook videos, 

Spotify, and TV services – 

so the lack of a system-wide 

equalizer that affects all 

Mac apps, rather than just 

Apple’s jukebox and video 

player, is important. That’s 

what Boom gives you.

TonaliTy $24.99

macphun.com

Even in the color-

saturated modern 

world, there’s 

something about the strong 

reactions that black and 

white photography can 

invoke that keeps the style 

fresh and appealing. Simply 

desaturating an image is 

rarely effective, so I use this 

app’s presets and manual 

controls to make my mono 

images look their best.
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DefaulT folDer x $34.95

stclairsoft.com

Power up macOS’s Open and Save dialogs with this 

excellent add-on and you’ll gain: a one-click shortcut 

to focus either dialog on the same location as an 

open Finder window; the ability to specify keyboard shortcuts 

to any folder, not just those Apple provides for the common 

locations in your Home folder; and, perhaps best of all, 

shortcuts to recent files, so you can more easily locate one 

you saved quickly without checking where it would end up.

carbon copy cloner $39.99

bombich.com

Time Machine is a good safety precaution to have in 

place in case you need to recover a file, or roll back 

your system after a bad update. But you should also 

make a complete backup of your Mac in a good state, and 

optionally update that backup on a schedule. Case in point: 

while writing this feature, Time Machine on our MacBook said 

it needed to start backups from scratch. Carbon Copy Cloner 

is a great app for doing this, and you can even start up your 

Mac from the backup it creates to avoid a lengthy downtime.

airmail 3 $9.99

airmailapp.com

AirMail offers neat 

ways to deal with 

messages that 

Apple Mail does not. 

We’re fond of its ability to 

“snooze” messages to help 

focus on the things that 

need immediate attention. 

Also notable are the ability 

to block senders with two 

clicks (instead of setting up 

rules), a customizable delay 

before messages are sent, 

and exempting an account 

from Do Not Disturb.

launchpaD manager $7.99

launchpadmanager.com

Launchpad is a fast way to open Mac apps, without 

the clutter of irrelevant results and the slight pause 

you can get when searching for them in Spotlight. 

However, if you like to browse its iOS-like arrangement of 

icons – rather than just using its search bar – getting them in 

the order you want, one icon at a time, gets tedious. you can 

speed up the process dramatically by using this tool, not 

least because it enables you to quickly group multiple apps.

fanTasTical 2 $39.99

flexibits.com

Fantastical 2 

interprets event 

descriptions that 

you type in natural language 

much better than Apple’s 

Calendar. For example, it 

understands if you append 

“alert 30 minutes” – which 

Calendar doesn’t – and 

it uses animation well to 

show it’s recognizing things 

as you type them. you can 

also tell it to switch to a set 

of calendars automatically, 

based on your location.

pasTe $9.99

pasteapp.me

This Clipboard 

enhancement 

keeps a history of 

whatever you copy – text, 

pictures, links, files, and 

more – and you can save 

items as snippets for reuse. 

Apps can be excluded to 

keep sensitive info private. 

Paste syncs its history and 

snippets across Macs, so 

you won’t lose out on the 

convenience of macOS’s 

Universal Clipboard if 

you’ve gotten used to it.

lisT mias free

dougscripts.com

This iTunes tool 

inspects all the 

items in your 

library and checks whether 

the files they‘re supposed 

to link to are where they’re 

meant to be – hence the 

“MIAs” in its slightly 

confusing name. It then 

displays a list of any tracks 

that are missing, including 

where they were expected 

to be, in case that jogs 

your memory about an 

unintentional move.

>>>Feature
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cheaTsheeT free

mediaatelier.com

Want to look up the many keyboard shortcuts 

available in the app you’re using, without having 

to manually peruse its menus? With Cheatsheet 

installed, hold ç for a moment and it’ll scan through the 

current app’s menus, then display all the items that have 

a keyboard shortcut assigned to them, grouped under 

headings based on their location. It’s a bit like the overlay 

that’s shown when you hold ç on a Bluetooth keyboard 

connected to an iPad, and you can print it for reference.

DaisyDisk $9.99

daisydiskapp.com

Wondering what’s taking up so much of your 

Mac’s storage? you could go digging through 

folders with the help of Finder’s Info window, 

or you can find out a lot more quickly with this app’s 

insightful graphical breakdown, which identifies exactly 

where the space-hogs on your drive are in a few seconds. 

It also enables you to gather files to clear out and then 

dispense with them in one move – though it runs a short 

countdown before actually clearing out the unwanted files.

scrivener $45

literatureandlatte.com

For long-form 

writing, this app 

is a dream come 

true. you may be familiar 

with it as a way to write 

novels and screenplays, 

yet it’s good for any long 

writing task – including 

the feature you’re reading 

right now. Scrivener has an 

excellent set of tools for 

structuring your writing 

in smaller documents, 

and it can stitch them all 

together on export.

bbeDiT $49.99

barebones.com

Our go-to Mac 

app for writing 

all sorts of code 

– HTML, CSS, JavaScript, 

and many more formats – 

has the all-important 

ability to color documents 

based on syntax, plus 

other clever productivity 

boosters such as control 

of how text wraps in its 

window, the ability to 

collapse multiple lines into 

one for clarity, and a side-

by-side view of differences 

in two versions of a file.

ulysses $44.99

ulyssesapp.com

Like Scrivener, 

Ulysses enables 

you to organize 

all your work in one place. 

But it’s really a minimalist 

writing app that helps you 

to focus on words, rather 

than breaking down a 

massive project into more 

manageable parts. The app 

now supports posting to 

WordPress and Medium, 

making it our favorite app 

for publishing to those 

popular blogging services.

TypeiT4me $19.99

ettoresoftware.com

MacOS includes 

a way for you to 

specify that it 

should replace certain 

sequences of characters 

with a longer passage of 

text, but its options are 

rather limited. TypeIt4Me 

provides more obvious 

(and comfortable to edit) 

support for multi-line 

replacements, inserting 

dynamic data such as the 

current date, and, perhaps 

our favorite of all, support 

for rich text formatting.
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ampheTamine free

apple.co/2n9u1h9

Need to keep your 

Mac’s display 

awake, perhaps 

while you’re in the middle 

of a presentation and don’t 

want its contents, mirrored 

by a projector, to keep 

blanking out? Just click 

this dubiously named tool’s 

menu bar icon to stop it 

switching off. you can set 

Amphetamine to work 

indefinitely, for a fixed 

amount of time, or only 

while the app is open.

vlc free

videolan.org

Whether you have 

videos from way 

back that no longer 

play in QuickTime, or they’re 

in a popular but alien format 

(to Apple, anyway) because 

you used to be a Windows 

user, the popular VLC media 

player should be the first 

thing you install to try 

playing them on your Mac. 

MPEG-2, MKV, Windows 

Media, WebM, and many 

other video formats are 

fully supported.

coconuTbaTTery free

coconut-flavour.com

There are a couple 

of places in macOS 

where you can 

easily check details of the 

health of your MacBook‘s 

battery, yet you might want 

to grab this free utility to 

see not just the battery’s 

current capacity when fully 

charged, but the amount it 

was designed to store when 

new for comparison. The 

app can also display info 

about a USB-connected 

iOS device’s battery.

unDock $1.99

flyingpapersoftware.com

About to dash off 

somewhere with 

your MacBook, or 

need to detach your USB 

flash drive in a hurry? 

The controls to eject 

storage devices aren’t far 

away – Finder’s always in 

the Dock, after all – but this 

helpful app lets you eject 

drives with a couple of 

clicks in the menu bar.  

It can safely stop any Time 

Machine backup that’s in 

progress at the same time.

gif brewery free

gifbrewery.com

GIF Brewery is the app to pick if you want extensive 

control over how video is turned into an animated 

GIF. It makes it easy to stitch together multiple clips, 

trim footage, crop into the picture, correct the colors, or 

apply quick presets, and even control frame rates and 

looping. The app can record media that’s playing elsewhere 

on your Mac’s screen, and, of course, you can superimpose 

captions and images on top of your composition. Who knows, 

it could help make yours the next big meme on social media.

screenflow $99

telestream.net

When it comes to recording and editing what 

appears on a Mac or iOS device’s screen – whether 

it’s to show off an app prototype, to deliver training 

to employees, or to create tutorials for youTube – skip the 

complexity of traditional video editors and use ScreenFlow, 

which is purpose-built with screencasts in mind. you can 

easily animate graphics over your video, superimpose 

yourself over footage thanks to chroma key support, and 

make it clear what’s being interacted with by adjusting the 

pointer size and triggering animations that illustrate clicks.

>>>Feature
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clouDmounTer $29.99

mac.eltima.com

A clear advantage of iCloud Drive is its inevitable 

deep integration with Finder, which enables you to 

use it just like a hard drive connected to your Mac 

(albeit at speeds limited by your internet connection). Many 

other cloud storage services may provide their own tool that 

works similarly, or you could install this single tool to handle 

your OneDrive, Google Drive, Dropbox, Amazon S3, WebDAV, 

FTP, and SFTP accounts, saving on the resources that would 

otherwise be used by running several similar, discrete tools. 

walTr 2 $39.95

softorino.com

Not keen on using iTunes to add media to your iOS 

device? you’re far from alone. WALTR makes sending 

files from Mac to iOS as simple as you’ve probably 

wanted it to be for years. Simply drag and drop files onto 

WALTR and it’ll send them over a cable or Wi-Fi to your 

device. It convert formats such as MKV and FLAC to an 

iOS-compatible format on the fly, and files are placed in the 

Music, Videos, and iBooks apps that you already know, rather 

than ending up in some unfamiliar third-party alternative.

hazel $32

noodlesoft.com

Hazel provides automated file management based 

on rules you attach to specific folders. So, you might 

set up one for your Downloads folder that moves 

various kinds of files – Pages, Numbers, and Keynote, for 

example – and moves them to your Documents folder so that 

they don‘t end up accidentally trashed when you’re tidying 

up. It can get rid of incomplete downloads after a certain 

period of time, which we find particularly helpful given our 

impatience when clicking download links.

magneT $4.99

magnet.crowdcafe.com

Magnet enhances 

macOS’s window 

management 

features with shortcuts that 

mimic the window-snapping 

capabilities of Microsoft 

Windows. For example, you 

only have to drag a window 

to the left or right edge of 

the screen to make it fill 

that area. If you’ve switched 

from Windows to the Mac 

you’ll welcome it, and even 

as long-term Mac users we 

adore its convenience.

moom $9.99

manytricks.com

Moom has even 

more power than 

Magnet, and we 

recommend it if you often 

have a lot of windows open. 

We like the way it displays 

icons for preset window 

positions when the pointer 

is over a window’s green 

Zoom button; drag from one 

toward another display and 

it’ll fling the window there, 

too. There’s also a grid on 

which to drag out a precise 

area for a window to fill.

malwarebyTes anTi-malware for mac free

malwarebytes.com

you may feel it unlikely that your Mac will become 

infected with malware or adware, and not really see 

any point in taking up valuable resources running a 

scanner in the background all the time. And if you’re careful 

about social engineering tricks, you might well avoid catching 

anything. But if you share files with people, on a removable 

drive or over the internet, it’s good practice to be sure you’re 

not risking passing things on to other people. This on-demand 

scanner does the job, and it takes just seconds to do so.
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affiniTy Designer $49.99

affinity.serif.com

Rather than manipulating the pixels that make up 

a picture, which is how bitmap editors such as 

Affinity Photo work, Affinity Designer is all about 

drawing vector shapes that can be manipulated without 

losing quality. It backs up the basics with a powerful toolset 

that includes: Symbols, which link multiple objects in an 

illustration so that changing one affects them all; vector- 

brush strokes that can be edited after you’ve applied them; 

and powerful typographic controls.

affiniTy phoTo $49.99

affinity.serif.com

Of all the affordable Photoshop alternatives, this is 

our favorite on the Mac. It packs in layered images, 

the ability to edit Raw photos, correcting for lens 

attributes, selectively applying adjustments using gradient 

masks, and much more. Version 1.5 added a wealth of new 

features, including HDR images from multiple exposures, 

360-degree photo editing, and recordable macros with 

changeable attributes. The app uses macOS’s Extensions tech 

to make some of its tools available in Photos – see page 104.

hanDbrake free

handbrake.fr

When it comes to 

converting videos 

to the H.264 

format that’s compatible 

with iOS devices, look no 

further than HandBrake. 

Originally it was intended 

for converting the contents 

of unprotected DVD-Videos 

(which is why its interface 

is awash with powerful 

controls for selecting titles, 

chapters, audio streams and 

so on), but these days it can 

convert regular video files.

airfoil $29

rogueamoeba.com

Recent versions of 

macOS and OS X 

enable you to 

redirect your Mac’s audio 

to an AirPlay speaker, but 

the most control you have 

over what doesn’t get sent 

is to omit system sound 

effects. Airfoil gives you 

much greater control over 

where individual apps send 

their audio. It also gives you 

the ability to send any app’s 

audio to multiple AirPlay 

speakers at once.

burn free

burn-osx.sourceforge.net

Still got a CD 

player in your car, 

or a relative who 

prefers to receive family 

videos on DVD? Burn is a 

one-stop shop for writing 

optical discs. Drop an AAC 

audio file or an H.264 video 

onto Burn’s window and 

it’ll convert them to the 

appropriate format for 

your chosen disc type. Burn 

even includes a menu editor 

for discs in the DVD-Video 

format – handy given that 

Apple axed iDVD.

max free

sbooth.org

What if your music 

is stored in iTunes 

in a format that 

one of your portable devices 

can’t play? Apple Lossless 

won’t work on a PlayStation 

Vita, for example. Max is a 

batch converter for audio, 

and it’s fast. We used it in a 

similar scenario in the past 

– before iTunes was able to 

resample tracks when 

syncing to anything other 

than the iPod shuffle, which 

we imported into a second 

iTunes library for syncing.

>>>Feature
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liTTle sniTch $34.95

obdev.at

MacOS’s app firewall is purposely designed to 

be very easy to understand: It simply allows 

or blocks apps from talking over the network. 

Little Snitch offers greater control over which servers, 

ports, and protocols each process can use. The frequency 

at which it pops up at first can be daunting, but the built-in 

Research Assistant takes away the worry by helping to 

identify the purpose of all those system processes it warns 

about but you’ve never heard of.

TeleporT Donationware

abyssoft.com

With two Macs on 

your desk – most 

likely a desktop 

and a portable one – 

Teleport enables you to 

use the same mouse and 

keyboard to control both, 

saving you a bit of clutter. 

Install it on both, configure 

a few preferences – 

including telling it how 

your Macs are arranged – 

then simply move the 

pointer over the adjoining 

screen edge to switch 

between controlling them.

The unarchiver free

unarchiver.c3.cx

The Mac can deal 

with Zip files 

perfectly well, but 

what about those other 

archive formats that 

sometimes crop up, such 

as 7Zip, Rar, and StuffIt? 

Even if they’re much less 

common these days, The 

Unarchiver can handle 

those and many more 

exotic formats, and its 

preferences enable you to 

set it as the default app 

for handling as few or as 

many of them as you want.

hiDDenme free free

appersian.net

Hands up: Who 

here keeps files 

on their desktop? 

It’s tempting to quickly 

select them and put them 

all in a folder before going 

to a presentation, or while 

someone’s helping you 

with a problem, but then 

you lose the positions of 

those carefully strewn 

icons. Save yourself the 

strain by temporarily 

hiding those icons by using 

this tool. The paid version 

supports multiple displays.

virTualbox free

virtualbox.org

There are good 

reasons to pay 

for a tool like 

Parallels Desktop or 

vmWare Fusion to run 

Windows apps within 

macOS, but if you need 

those apps infrequently, 

and don’t believe you’ll 

benefit from things like 

Parallel’s Coherence mode, 

which puts Windows and 

Mac apps on the same 

desktop, consider 

installing Windows in 

VirtualBox instead.

TripmoDe $7.99

tripmode.ch

Concerned that iCloud Drive, say, may be sending 

or receiving a lot of data in the background while 

your Mac is connected to Personal Hotspot on 

your iPhone? Or, that you forget about such cost concerns 

when using ordinary apps? Click TripMode’s menu bar icon 

to see apps and services that use a network connection. 

Switch it on and put a check mark next to only those items 

you want to have internet access; the icon then turns red 

as a reminder some things are blocked.
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wunDerlisT free

wunderlist.com

It’s easiest to think of Wunderlist as Reminders Pro. 

It immediately won us over with the ability to group 

lists in folders, as well as its well-structured 

presentation. you can add up to 25 subtasks to a to-do item 

in the app’s free edition, and add hashtags to provide context. 

It keeps collaborative notes alongside the shared lists they 

concern, rather than being conducted by email or elsewhere. 

The free version outright omits a few of the collaboration 

features of the Pro version, but a cost-free account still 

enables the app to sync your lists between Mac and iOS.

filepane $4.99

mymixapps.com

FilePane expands 

the possibilities 

of dragging and 

dropping any file on your 

Mac. Drag a file to the Drop 

Here prompt and a small 

control panel pops up. From 

here, you can quickly resize 

an image file, print the doc, 

send it via email or AirDrop, 

and more. It’s the sort of 

utility you can get so used 

to using that you’d be lost 

without it when using 

another Mac.

iglasses $19.95

ecamm.com

This clever little 

palette of controls 

affects the look of 

video coming from your 

Mac’s FaceTime camera. 

It works with the FaceTime 

app itself, but also with 

Skype and other video 

calling apps. As well as 

brightness, exposure, white 

balance, and other image 

attributes, you can even 

zoom in, effectively 

cropping out surroundings 

you don’t want in the image.

prinTopia $19.99

decisivetactics.com

Let’s say you have 

a printer, and it‘s a 

perfectly good one 

that you don’t want to 

replace just yet. But you 

also have an iPhone or an 

iPad, and you want to print 

things from it. By running 

Printopia on your Mac, your 

iOS devices will be able to 

send things wirelessly to 

your Mac’s printer as if it 

were an AirPrint-compatible 

model – because basically 

now it is!

fluiD $4.99

fluidapp.com

If you use web 

apps, even just a 

webmail service, 

it’s easy to get confused and 

slowed down as you jump 

between them and native 

Mac apps. Provide Fluid with 

the address of a web app, 

along with a name and an 

icon, and it’ll create a 

dedicated Mac app for 

that web page, which then 

appears in the ç+† app 

switcher, and which you can 

stash in the Dock.

Dxo opTicspro for phoTos $9.99

dxo.com

Affinity Photo may be more powerful than you need, 

in which case try this bunch of Photos extensions. 

It includes fixes for distortion and chromatic 

aberration (for select lens makes and models, at least), white 

balance, noise reduction, Smart Lighting (which attempts to 

maximize dynamic range), and a haze reduction tool that 

makes local contrast adjustments. you don’t get much 

control, but if what you want are clean, quick fixes, get this.
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28   MAy 2017  maclife.com



callrecorDer $29.95 ($44.90 for both versions)

ecamm.com

There are two versions of Call Recorder – one for 

FaceTime, the other for Skype – and each is capable 

of recording both audio and video calls. Recordings 

are archived in a companion app, Ecamm Movie Tools, where 

you can replay or export them. Just remember to check 

applicable laws for you and the other person – though it’d be 

wise to ask their permission to record, in any case. you can 

even record regular phone calls that are passed through to 

your Mac by way of macOS’s and iOS’s Handoff feature.

alfreD free

alfredapp.com

Purely as a Spotlight alternative, Alfred immediately 

won our affection because it displays keyboard 

shortcuts (ç and a number) next to its top search 

results. It provides greater specificity than Spotlight, so you 

can enter “define” followed by a word to pull up that word’s 

meaning and nothing else. And there’s much more, including 

a clipboard history, the ability to buffer multiple files to take 

action on all of them at once, and, with the paid-for 

Powerpack, taking direct action on looked-up contact info.

isTaT menus $18

bjango.com

Activity Monitor is all well and good for checking 

your Mac’s resource usage, but its window isn’t 

exactly compact. If you’re keen to keep an eye on 

processes that might be hammering the CPU, thrashing your 

startup disk with activity, or using up a lot of memory, this 

app can display these and much more in the menu bar. Among 

the other things it can display are: info from your Mac’s fans 

and the temperature of components; your startup disk’s 

SMART status, which is normally tucked away in Disk Utility; 

and upload and download rates for your network connection.

spamsieve $30

c-command.com

This enhanced junk mail filter opens automatically 

with Apple Mail (and many other apps like it). you 

can use the scores it assigns to messages to process 

supposed spam in different ways, rather than just moving 

everything to a junk folder – you might simply color some as 

a prompt to offer the tool further training. Thankfully, you can 

also blacklist senders. The utility works with all of your email 

accounts, so you might consider turning off any server-side 

junk mail filters in order to help SpamSieve better learn by 

ensuring it can inspect all messages you receive.

usage free

cheatsheetapp.com

Usage gives you a 

better idea of how 

much time you 

really spend on things like 

Twitter and Facebook. Click 

its menu bar icon and it’ll 

show the hours and minutes 

you’ve spent in various apps 

(which can be grouped, if 

you want). As well as 

shaming yourself back to 

some productivity, it can 

assist you with accurately 

billing clients.

JoysTick mapper $4.99

joystickmapper.com

If you play games 

on your Mac and 

some of them force 

you to use the keyboard, 

this utility can intercept 

button presses on your 

joystick or gamepad and 

tell macOS you’ve pressed 

a particular key. For key 

combos, each key has to be 

separately bound to the 

same button, which takes 

time to set up, but this is a 

no-brainer for Mac gamers.
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beTTerTouchTool Donationware

boastr.net

Apple is somewhat restrained in the number of 

gestures it makes available on its Multi-Touch mice 

and trackpads; it provides shortcuts to trigger key 

features such as Mission Control and Launchpad, but Multi-

Touch is capable of much more. BetterTouchTool unleashes 

that raw potential, enabling you to use taps, swipes, and even 

Force Clicks (on trackpads that support it) to trigger all sorts 

of functions – such as putting your Mac to sleep, mimicking a 

keyboard shortcut, or simulating a ≈-, Alt-, or ç-click.

phoTo wormhole $0.99

apple.co/2mHEcO5

What if your favorite photo editor doesn’t offer 

integration with Photos? In that case, install this 

extension, which enables you to send images from 

your Photos library to other editors, work on them there, and 

return the amended image to your library, where it’s shown 

alongside the original. There’s a quirk in how you call up the 

list of external editors: you must right-click, or secondary-

click using two fingers, because ≈-clicking doesn’t work – 

but the flexibility on offer is worth dealing with that.

menupop $4.99

binarybakery.com

Moving the pointer 

all the way to the 

top of the screen 

to interact with the menu 

bar can get tiresome, 

especially on a large 

desktop like a 27-inch 

iMac’s. Press MenuPop’s 

keyboard shortcut, which 

is customizable, and it 

displays the contents of 

the menu bar in the same 

format as a contextual 

(≈-click) menu, right 

under the pointer. 

popclip $9.99

pilotmoon.com

PopClip adds an 

iOS-style options 

bar that appears 

when you select text. The 

default Cut, Copy, and Paste 

shortcuts don’t exactly 

improve anything, but you 

can also send your selection 

straight to Safari’s search 

engine, and there are many 

more useful commands to 

add at pilotmoon.com/

popclip/extensions. Among 

our favorites is the Google 

Translate shortcut.

barTenDer $15

macbartender.com

Many useful Mac 

utilities add their 

icon to the menu 

bar, which can get a little 

cramped or just plain messy 

as a result. Bartender 

enables you to choose which 

ones are persistently visible 

and hide the rest, either 

configuring them to appear 

when their status changes, 

or in the secondary 

Bartender Bar, which 

appears just below the 

menu bar at the press of 

a keyboard shortcut.

easyres free

easyresapp.com

If your Mac has a 

Retina display, one 

benefit of it is the 

ability to tell macOS to 

render the desktop at a 

different resolution without 

losing much sharpness; 

you can squeeze more of a 

document onto the screen 

this way. However, you have 

to open the Displays pane to 

switch resolution. EasyRes 

enables you to do this from 

the menu bar, where it also 

shows a preview of how 

things will look.
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TinkerTool free

bresink.com

TinkerTool gives 

you easy access 

to many hidden 

macOS preferences you’d 

otherwise need to know 

the right Terminal 

commands to modify. Our 

favorites include a more 

precise default page zoom 

setting for Safari, saving 

screenshots somewhere 

other than the desktop 

(handy if you’ve set Sierra 

to store it in iCloud Drive), 

and dimming Dock icons as 

a reminder of hidden apps.

asTropaD $29.99

astropad.com

Astropad turns 

your iPad Pro into 

a graphics tablet 

for your Mac, and it’s able 

to work over Wi-Fi, not just 

USB. If you’re willing to 

forgo some customization 

options and controls, you 

can skip the Studio version 

entirely (which requires a 

costly $64.99 per year 

subscription); the standard 

version also supports 

Apple Pencil. It’s also the 

only version that works 

with other styluses.

gemini 2 $19.99

macpaw.com

Whatever the 

reason you might 

have ended up 

with duplicate files on your 

Mac, you’re definitely not 

on your own. Gemini helps 

you get out of the mess by 

searching for them so you 

can reclaim disk space. 

you can take the cautious 

approach with it, though, 

by confirming not just how 

many duplicates of each 

file have been found, but 

because it also allows you 

to compare their contents.

maciD $3.99

macid.co

you don’t have to 

keep typing your 

user account’s 

password to log in. MacID 

uses your iPhone’s Touch 

ID sensor to authenticate 

over Bluetooth, which 

should get rid of any envy 

you feel towards owners 

of the latest MacBook Pro. 

Even better, it uses your 

iPhone’s proximity to lock 

your Mac when you wander 

away, and to unlock it 

when you and the iPhone 

come back into range.

a beTTer finDer rename $19.95

publicspace.net

Finder has built-in yet limited abilities to rename 

a group of files according to your requirements, 

and you can make more intricate changes with 

Automator, AppleScript, or Terminal – if you know how. 

For the rest of us, this app is a powerful inbetweener. 

A Better Finder Rename is even able to inspect the 

metadata of music files to add info such as album titles 

to new filenames. you don’t have to risk putting a foot 

wrong, as the app previews results first.

• f
or our •

 • Turn To p46 •
iOS

pickS
ios

picks
DueT Display $14.99

duetdisplay.com

Duet Display cleverly uses your iPad as a second 

screen to extend your Mac’s desktop. There’s 

almost no lag, even when using Duet’s highest 

detail settings and frame rates, though those quality 

settings can be adjusted if you find that it’s sluggish on a 

less capable Mac or using too many resources. Duet is a 

practical add-on for a MacBook on the move. It can also 

simulate Apple’s Touch Bar tech on your iPad, giving you 

new shortcuts to use – see the tutorial on page 94.
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Nate Drake shows how  

to clean up your operating 

system and speed up a 

slow-performing Mac

32   may 2017  maclife.com

>>>Feature



UNlike certaiN  
other operating  
systems, macOS  
is built extremely  
efficiently and does 

not need to be “defragmented” to  
keep ticking over nicely.

However, as with every machine, 
Macs sometimes experience odd 
performance issues. In this guide, we 
will explore some common problems 
along with ways to clean out 
unnecessary files to speed up macOS.

If you’re reading this guide, 
congratulate yourself on deciding to 
investigate further rather than assuming 
that there must be a hardware defect 
with your Mac, or that you have a virus.

Hardware faults and malware can 
cause your system to perform poorly,  
but it is much more likely that this is  
a problem you can solve from the 
comfort of your own home without 
installing any additional software.

Before following any of the steps in 
this guide, try to focus on the issues 
you’ve been experiencing. Does the 
system perform slowly, for instance, 
only when you open a particular game 
but work fine when you’re playing 
videos in QuickTime? If so, the issue may 
relate only to that particular app.

If your issues relate to apps using the 
internet such as FaceTime, try to test 
with another device to see if the problem 
lies with your home internet connection 
rather than the Mac itself.

Once you’re satisfied that the issue 
relates to macOS as a whole, feel free  
to follow the steps in this guide. As ever 
with this sort of thing, we recommend 
that you back up your data first.

>

Refresh your Mac
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The options in Optimized Storage 
free up space by removing old files 
and storing others in iCloud.

Safely remove the clutter of redundant files from your Mac
SpriNg cleaNiNg

>
althoUgh macoS is very efficient  
in terms of using files, over time 
temporary data and third-party 
software can affect the speed of your 
system. These are the most common 

culprits when it comes to poor system performance. 
You may wonder how you can fix such issues if  
the files and apps causing the problems are still 
being accessed in macOS? The answer is safe mode 
– a special way of starting up your Mac whereby 
macOS will only load the software which was 
originally installed on the OS.

the Safety of Safe moDe

In addition to preventing third-party apps from 
opening, safe mode will check your hard drive  
and try to repair corrupted files. It will also try to 
delete unnecessary system and kernel caches.

This guide assumes you are running the most 
recent version of macOS Sierra which has special 
options for configuring file storage. If you have not 

yet upgraded to Sierra, you can do  
so from the Mac App Store. To get 
started, shut down your Mac. When  
the Mac is fully powered off, press  
and hold down ß until you see the 
login window. Log in as normal.  
Note that if you have used FileVault  
to encrypt your disk, you may have  
to do this twice.

You will see a small, grey loading  
bar inching across the screen. This 
shows that the system is entering  
safe mode. If macOS needs to repair 
your disk or there are a large amount  
of cache files to clear, this can take 
some time, so be patient.

When the login screen appears, you 
will see the words Safe Boot in the 
menu bar. (Safe mode and safe boot are 
different names for the same thing). 
Log in to your own account as you 
would normally. Safe mode only uses 
very basic graphics drivers, so don’t 

worry if you see flickering on your screen. Once 
you’re on the desktop, click the  and choose  
About this Mac from the menu bar. Next, click  
on the Storage tab, then the Manage button.  
The options in this window present several ways  
to save storage space.

Click the button next to Store in iCloud.  
You’ll see an option here to optimize your files  
in the Desktop and Documents folders, meaning 
it’ll put those folders and their contents in iCloud 
Drive. This makes them accessible to all devices  
on which you can access that storage area. As your 
Mac’s storage gets full, local copies of files will be 
removed to save space, though they’ll look like 
they’re where you left them and be retrieved from 
iCloud if you try to access them. This only improves 
performance if your internet connection is good. 
Also, iCloud only gives you 5GB of free storage, and 
it could take a long time to upload everything.

Click Optimize Storage to remove watched  
films and TV shows; you can always download 
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> Cache in and clear up

The grey loading bar 
will appear when you 
start up in safe mode. 
It may take some time 
for macOS to load.

The various cache folders contain only temporary data, so you can  
usually delete these files entirely safely. Close your apps first, though.

Your Mac stores temporary 

files in cache folders. Apps 

can perform poorly while 

trying to access a corrupt  

or non-existent cache file. 

If so, you can manually clear 

the folders. Doing so will 

not remove apps or cause 

you to lose personal data, 

but you should still make a 

Time Machine backup first. 

In Finder, choose Go > Go to 

Folder. Enter “/Users/your 

username/Library” (without 

quotes). Open Caches and 

select all of its contents, then 

trash them. If the Mac has 

more than one user account, 

log in to each and repeat the 

steps. Choose Go > Computer, 

and then double-click your 

startup disk and go to  

/Library/Caches. Trash the 

files stored there, too. Restart, 

then in Finder, choose File > 

Empty Trash.

movies again. You can also choose only to download 
recent email attachments or, better yet, only 
download them when opened.

The third recommendation, Empty Trash 
Automatically, deletes files that have been there for 
over 30 days – Time Machine covers you against 
accidentally trashed and removed files.

The final recommendation, Reduce Clutter, 
identifies large files you may no longer need. Click 
Review Files to see an itemized list. You can hover 
over files either to delete them or show them in 
Finder. While this is a quick and easy way to delete 
large amounts of data, be careful not to remove 
anything important. Run a Time Machine backup 
before removing files. You can click the X next to 
some items to send them to the Trash. Others may 
be part of an app, and need to be deleted within it.

If a file or folder is taking up large amounts of 
space but you need to hang on to it, such as your 
iTunes Library, you may be able to store it online  
or on an external drive. Another regular culprit 
for hogging space is your Downloads folder. Items 
in here have been downloaded from the internet, 
so they are almost certainly replaceable. Click the 
Downloads tab to view and delete items.

On the subject of apps, take a look at the items  
in the Optimized Storage window’s sidebar that 
have data that’s taking up lots of space. If you back 

up your iOS device to the Mac, click “iOS Files”  
to see if any large backups are taking up space.  
You may prefer to remove these and switch to  
using iCloud for your device backups.

Go to System Preferences’ Users and Groups 
pane, then click Login Items. Click on the padlock 
icon (at the bottom left of the window) and enter  
your password to allow you to make changes. This 
area details which apps start when you first log in 
to your account. Click on an unnecessary app to 
highlight it, then the minus button. This doesn’t 
remove the app from your Mac, it just won’t start 
up as soon as the desktop appears, which can 
improve system performance.

Refresh your Mac
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Examine your apps and remove anything you don’t need
keep yoUr mac healthy

there are plenty of apps which 
claim to automate the process of 
speeding up your Mac. Some of 
these simply automatically search 
for large files to delete and free up 

your caches, which we already did in the previous 
section. Some are malicious apps that pretend to 
clean up your Mac but instead bog it down with 
junk. Even reputable apps, such as virus scanners, 
will sometimes cripple your machine with multiple 
“threat detection” warnings about harmless files.

In view of the above, we do not recommend  
any third-party software to fix a slow Mac. It’s 
going to be down to you; you should begin by 
examining the apps you already have installed  
to make sure that they’re necessary, because too 
many of them running at once is a common cause 
of poor system performance.

Back to Safe moDe

You can’t remove an app while it’s running, so start 
up in safe mode. If you’re unsure if you’re still in it, 
hold Alt, pick  > System Information, select 
Software on the left, and check “Boot Mode.”

Removing an app doesn’t necessarily remove all 
related files. For instance, removing GarageBand 
will not delete the sound library. This said,  
make sure to run a Time Machine backup before 
proceeding further in case you accidentally remove 
something of importance. Open your Mac’s 
Applications folder and carefully read through the  
list of apps. In general, the system will not let you 
delete any apps which are built in, such as Safari, 
but you can remove third-party ones.

Remove an app by clicking on it once to select 
it, then choosing File > Move to Trash. You should 
do this for apps you don’t recognize, or no longer 
use. You will be asked to enter an admin user’s 
password when removing apps. Simply type it in, 
then press ®. When removing an app, head over 
to System Preferences to see if it has added a pane 
there. If so, ≈-click its icon and choose Remove 
<name> Preference Pane.

Watch out in particular for multiple apps that do 
the same thing. Some inexperienced users believe, 
for instance, that installing two antivirus apps 
makes you twice as safe. In reality, this offers no 
extra security and, in fact, can make your Mac go 
haywire as the two apps interfere with one another.

Removing an app works like a charm as far as 
legitimate apps go but sometimes malicious apps 
can reside elsewhere on your Mac.

Sort StartUp appS

Although you previously checked the Login Items  
in System Preferences for apps which start up on 
boot, there are also several folders on the Mac  
hard drive which list startup apps. Go through the 
steps in the tutorial opposite to review and remove 
these if necessary. Doing so will not remove the 
applications themselves but simply make sure  
you have to launch them yourself from the Dock  
or from the Applications folder after log in. 

Send apps you no longer 
use from the Applications 
folder to the Trash.

>
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After following these steps, you may find that if 
you had antimalware software on your Mac, it no 
longer launches automatically. This is not really a 
cause for concern. Although it’s not entirely true to 
say “Macs don’t get viruses,” most malware and 
viruses are written for Microsoft Windows.

While your Mac is unlikely to be infected, the 
antimalware software itself will take up some 
system resources when performing routine scans. 
Consider only launching software when you need 
to scan individual files, or uninstall it altogether. 
Remember that provided you’re keeping regular 
backups with Time Machine, even if you do 
accidentally download a virus, you can restore 
your system to a point before it was infected.

USiNg activity moNitor

Once you have restarted your Mac, if your system 
is still running slowly, let’s look for reasons why. 
Click on the magnifying glass at the top right of the 

screen, type “Activity Monitor,” then press ®.
Activity Monitor lists all currently running 

processes on the system. Click the Memory tab at 
the top of its window, then the Memory column 
below to list apps, from those that consume  
the most memory to the least. You can click  
on a running process to select it and click the 
X at the top left to stop it altogether.

Naturally, video conferencing with a friend over 
FaceTime will be more resource hungry than simply 
opening Calendar, so do not be surprised if certain 
apps hog more memory. However, if you believe an 
app is taking up too much memory, make a note of 
it so you can troubleshoot it further later on.

If the app is part of macOS, such as FaceTime, 
you may need to reinstall macOS to fix the problem, 
which we will cover later. If it is a third-party app, 
try removing it and reinstalling it. If this fails to 
speed up your system, try to find an alternative app 
to serve the same purpose.

clear yoUr perSoNal 

laUNchageNtS folDer

In Finder, choose Go > Go to Folder then 

type “/Users/yourusername/Library.” 

In the LaunchAgents folder, delete 

anything you don’t recognize inside it. 

Repeat this step for each user account.

clear the SyStem’S 

laUNchageNtS folDer

In Finder, choose Go > Computer, 

double-click on your startup disk, 

then open the Library folder. Find 

LaunchAgents here and, once again, 

delete any unrecognized files inside it.

SyStem laUNchDaemoNS 

& StartUpitemS folDerS

Click the back arrow and open the 

LaunchDaemons folder. Delete any 

unrecognized files; do the same for  

the StartupItems folder. Now restart 

your Mac and empty the Trash.

how to Prevent malware by clearing LaunchAgents
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Open your copied Photos 
library and then set it as 
your system library.

Consider keeping large files 

on an external hard drive

move yoUr 
meDia fileS

iN geNeral, the more free space 
you have on your Mac, the faster it 
will run. This is fine in theory, but 
the Mac is made to be used. What if 
you have a large music and video 

collection or thousands of family photos?
If you have a reliable internet connection, some 

of your data can be stored in iCloud. If you are an 
Apple Music subscriber, you can also enable iCloud 
Music Library, whereby all your iTunes music can be 
uploaded and streamed over other devices. This is 
handy in terms of saving space as you can delete 
files locally from your Mac and redownload them 
as and when you want to listen to them. However, 
beware of doing this if the original on your Mac is  
of a higher quality than 256Kbps in AAC format;  
the copy stored in iCloud will be more compressed. 

This feature, however, isn’t always ideal. It doesn’t 
work well with Family Sharing and certain content, 
like home videos, can’t be stored in iCloud this way.

It’s simpler to store your entire iTunes library on 
an external drive. This gives you access to every 
media file even when your internet connection is 
patchy. The steps opposite show how to do this. 
Only delete your original iTunes Media folder once 
you’re certain everything is working correctly.

In order to proceed, you’re going to need an 
external hard drive. The online Apple Store sells 
external drives that have been formatted for 
macOS but, in practice, any USB-connected 
external drive is fine, although you may need to 
format it first. See page 44 for help with this.

Do not be tempted to use the same external drive 
both for Time Machine backups and for storing your 
media. Time Machine deletes older backups as 
space runs out, but you don’t want it to be vying for 
space with your music collection. 

Once your iTunes library has been consolidated 
on the external drive, consider transferring other 
libraries to the drive as well. Your Photos library, 
which is located in your Pictures folder by default, 
can be quickly and easily moved to an external drive 
by selecting it, choosing Edit > Copy, browsing to a 
place on the external drive, and then choosing Edit 
> Paste. Once the transfer is complete, double-click 
the new copy of the library, then choose Photos > 
Preferences. The new photo library will be listed 
beside Library Location. Click on Use as System 
Photo Library to make this change permanent. 
As with iTunes, only delete the original library on 
your Mac once you’re sure your photos are safe.

imovie aND Safari

The iMovie app, which is used for editing home 
videos, can also take up huge amounts of space. 
Moving its library is very simple, but first open the 
app itself and select your library from the Libraries 
list. Next choose File > Consolidate Library Media. 
This should make sure that any video clips, images 
and so on are stored within the library itself.

Next, quit iMovie and, in Finder, go to your user 
account’s Movies folder. Move the library in the 
same way as for the Photos app by using Edit 
> Copy, navigating to the external drive and 
choosing Edit > Paste, then double-clicking to 
open. Bear in mind that the original copies of any 
videos or images you imported into iMovie will still 
be in their original location, so you may need to 
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coNSoliDate itUNeS fileS

Open iTunes and choose iTunes > 

Preferences. Click on the Advanced tab 

and make sure “Copy Files to iTunes 

Media folder when adding to library” 

is checked. Click OK, then choose File >  

Library > Consolidate files.

move yoUr itUNeS folDer

In Finder, navigate to Music/iTunes 

in your user account’s folder. Select the 

iTunes folder and choose Edit > Copy. 

Navigate to your external drive and 

choose Edit > Paste. Don’t delete the 

original iTunes folder just yet.

UpDate itUNeS

Open iTunes’ preferences and click 

the Advanced tab. Click on the Change 

button next to “iTunes Media folder 

location.” Navigate to the new iTunes 

Media folder on your external drive, 

and click Open.

how to Store your iTunes library on an external drive

delete these manually, along with the original 
iMovie library. As before, only do this once you’re 
sure your media is safe.

By default, the Safari web browser on your  
Mac saves any downloaded content to your user 
account’s Downloads folder. Over time this folder 
will grow in size, slowing down your system. 
Fortunately you can change the location of your 
Downloads folder. In a Finder window, navigate to  
your external drive. Choose File > New Folder, name 
the new folder, and press ®.

Open Safari’s preferences and click the General 
tab. Click the pop-up menu next to “File download 
location” and choose Other. You can now select the  
new folder you created on the external drive; click 
Open to confirm your selection. From now on Safari 
will store all downloads on that drive.

If you do choose to store content on the external 
drive, while this may speed up your system, 
remember that the drive must be connected at all 
times for you to access your content. This may 
sound obvious, but if certain apps, such as Photos, 
cannot access your library on the external drive 
they may create a new one in your user account’s 

folder with none of your personal data in it. If this 
happens, open the library on your external drive 
once again by double-clicking it.

Remember that Time Machine does not back up 
external drives by default. You can change this by 
opening System Preferences’ Time Machine pane 
and Options at the bottom right. Highlight your 
external drive in the list and click the minus button 
to include it in backups to your Time Machine drive. 
This may take up a lot of space so make sure your 
Time Machine drive has plenty available.

In Safari’s General preferences, click “File download location” and 
choose Other to save future downloads onto an external drive.

Refresh your Mac
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If it’s a while since 
you updated macOS, 
a combo update will 
quickly bring the 
system up to date.

Dig a bit deeper for more system-sapping culprits
fUrther tipS aND tweakS

with UNNeceSSary files and apps 
removed and large files moved to  
an external drive, if there’s still no 
noticeable improvement in system 
performance, there are further 

modifications you can make.
First, check for new system updates. You can 

usually do this by opening the App Store and 
clicking Updates. If you’re having trouble with the 
Mac App Store, consider downloading a “Combo 
Update” directly from the Apple Support website.

iN the Spotlight

The Spotlight search feature – accessed by clicking 
on the magnifying glass at the top right – functions 
as a system-wide search engine. Each time you 
create or modify content, Spotlight indexes it so 
you can find it later on. As handy as this indexing 
is, it can sometimes go awry. You also may not want 

to index certain folders for privacy reasons.
If macOS gets stuck reindexing files, this can 

slow down your system. Go to the Spotlight pane  
in System Preferences. Click on the Privacy tab to 
see locations which are excluded from indexing. 
Click the “+” button and choose your startup disk, 
which is usually named Macintosh HD. You will  
see a warning message stating that this will disable 
the search feature. Click OK.

Now select your Mac hard drive in the Privacy tab 
and remove it from the list using the minus button. 
These steps force the Mac to reindex your data, 
which can improve search speeds. If you do not 
want to index certain folders such as your personal 
Documents folder, take this opportunity to add 
them now using the “+” button once again.

Leave the Mac on for a few hours to allow 
reindexing to complete. You can check its  
progress by clicking the Spotlight icon again.

fixiNg fiNDer

By default, when you open Finder, it will display 
every file in your account. If you have a large 
number of files this can take a long time to load. 

You can change the default view from All My  
Files to something else by opening Finder’s 
preferences. In the General tab, find “New Finder 
windows show” and click its pop-up menu to 
change to another location, such as your home 
folder. If Finder is still sluggish, click Go and Go  
to Folder. Type “~/Library/Preferences” and press 
Return. Choose View > As List, find the file named 
“com.apple.finder.plist,” and move it to your 
desktop. Restart your Mac, then delete that file 
from the desktop.

Delete garageBaND loopS

GarageBand stores files in several locations which, 
as you might imagine, can take up large amounts  
of space. Consider removing unnecessary audio 
loops. In Finder, choose Go > Go to Folder. Type 
“Macintosh HD/Library/Audio/Apple Loops” and 
press ®. Delete loops you no longer require and 
then empty the Trash.
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DiSaBliNg filevaUlt

Thanks to FileVault 2 and the recent trend towards 
SSDs in MacBooks, encrypting your system should 
not reduce performance noticeably. There are  
many online guides which recommend disabling 
FileVault to increase system performance. While  
it is true that using FileVault requires slightly  
more resources, as data has to pass through  
an encryption layer, disabling the feature is 
unlikely to make much difference and leaves data 
vulnerable. If you have already enabled FileVault, 
we recommend you leave it as it is.

pUrge virtUal memory

Previously, we used Activity Monitor to see which 
processes were running and check the available 
amount of memory. As the system runs out, it will 
start to use your hard drive as temporary “virtual 
memory” to free up RAM for other tasks. You can 
tell the system to purge its virtual memory by 
clicking Spotlight and typing “Terminal.” Open 
Terminal, type “sudo purge,” press ®, and enter 
your password. The system’s virtual memory will 
be cleared. More recent versions of macOS try to 
use memory efficiently, so this will probably not 
do a huge amount on newer Macs.

reSet Smc

Resetting the SMC (System Management 
Controller) is usually done to fix problems with 

starting up your Mac in the first place, but it can 
also help to remedy a sluggish system.

If you have a desktop model, resetting the  
SMC is as simple as unplugging it from the wall, 
waiting 15 seconds, then plugging it back in. Wait 
five seconds and then power on the Mac.

If you have a MacBook, shut it down fully and 
disconnect the charger. Next, with your left hand, 
hold ß, ≈ and Alt together while holding down  
the power button with your right hand. (If you have 
a 2016 MacBook Pro with a Touch Bar, the Touch ID 
button is also the power button.) Keep all these 
keys pressed for 10 seconds, then release them.

If the SMC reset fails to improve the Mac’s 
performance, there’s likely a hardware fault or your 
system files have been damaged. We’ll discuss ways 
to remedy this in the next section.

Clear the checkbox next to any unrecognized or unwanted extension.

To fix a sluggish Finder, 
delete the com.apple.
finder.plist file, then 
restart your Mac.

> Excruciating extensions
Most browsers support 

extensions – software  

add-ons, such as allowing  

you to save passwords. 

Sometimes clicking on the 

wrong link results in malicious 

extensions being installed. 

Usually these are designed  

to show adware – pop-up 

advertisements which are 

annoying and can slow down 

your system. While in safe 

mode, open Safari, then  

choose Safari > Preferences.  

In the new window, click the 

Extensions tab to see what 

you have installed. If you 

don’t recognize an extension, 

clear the checkbox to disable 

it. Click More Extensions to 

browse legitimate extensions 

for Safari. Install both Adblock 

Plus (adblockplus.org) and 

Ghostery (ghostery.com) to 

help you avoid harmful links 

and prevent websites from 

tracking you easily. Log  

out and repeat these steps 

for every user account on 

your Mac.

Refresh your Mac
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haviNg rUN through all the 
previous potential fixes, if your Mac 
is still running slowly, you’ll need to 
take more drastic steps. While your 
Mac may be experiencing hardware 

failure, if it is still functioning, however slowly, it’s 
more likely the problem has to do with your system 
software. If this is the case, try to run a backup of 
your Mac before doing anything else.

time machiNe

Your Mac has a built-in app for running backups, 
named Time Machine. Time Machine makes hourly 
backups of your data which it can then save either 
to an external hard drive, or to an AirPort Time 
Capsule or the latest AirPort Extreme. The latter 
devices can create a fast wireless network and are 
useful for backing up several Macs, but an external 
USB hard drive is the simplest and cheapest option.  

The first time you connect an external hard  
drive, macOS will ask if you wish to use the drive  
for backing up. Click Use as Backup Disk to have 
Time Machine automatically format the drive to be 
compatible with your Mac and begin transferring 
files. This process will erase any data already on  
the drive, so try to have a dedicated one just for 
backing up. The capacity of the drive should be at 
least equal to the hard drive inside your Mac, but 
the larger it is the better, as more space enables 
Time Machine to keep longer file histories.

All the data on your Mac will be backed up. You 
can go to System Preferences’ Time Machine pane 
to view the status of your backups at any time.

There you can click “Show Time Machine in 
menu bar” to display a Time Machine icon at the  
top right of the screen. Click this once to quickly 
view the status of backups. If you have already been 
using Time Machine, click this and choose Back Up 
Now before proceeding further.

SyStem reStore

Time Machine performs a complete initial 
backup, and subsequently keeps incremental 
backups of only files that have changed since 
the previous one. It can display these backups 
in chronological order so you can, for instance, 
easily retrieve a three-month-old version of a 
Pages document you’ve trashed or altered.

The Recovery feature of macOS even allows you 
to restore your system to exactly how it was on the 
date of a previous backup – even an incremental 
one (if you don’t exclude system files). This can be 
useful if, say, your Mac has some form of malware 
as Time Machine will have backed up beforehand.

This feature, however, isn’t very useful if your 
system is running poorly due to corrupted system 
files. The reason for this is quite simple – if any of 
your system files were damaged at the time the 
backup was made, your Mac will simply be replacing 
files with older versions of themselves which may 
also be damaged. You’re likely to have more success 
by erasing the hard drive and restoring data from 
the backup manually. 

The first time you connect a new 
hard drive, click “Use as Backup 
Disk”. The Mac will do the rest.

Don’t back out of backing up – it’s so easy to set up
time machiNe BackUpS
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opeN DiSk Utility

Power on and hold ç+R to 

start up in macOS Recovery. Choose 

Disk Utility. Next, click on your Mac’s 

startup disk on the left-hand side. 

If you’re using FileVault, choose File  

> Mount and enter your password.

create image

Choose File > New Image >  

Image from Macintosh HD. In the  

panel that appears, open the  

Where pop-up menu and select your 

external drive. Under Format choose 

Compressed, and then click Save.

verify image

The image creation process can 

take several hours. Once complete, 

eject your external drive and connect it 

to a working Mac. Double-click on the 

.dmg file to open it in order to verify 

it can be mounted like a real disk.

how to Create an image of your Mac’s hard drive

target DiSk moDe

The previous steps assume that your system 
is running to the extent that you can actually 
run Time Machine. If this isn’t the case and you 
don’t have a recent backup, you may still be able  
to retrieve your personal files before wiping your 
machine and reinstalling macOS.

If you have access to two Macs with FireWire or 
Thunderbolt ports and the right cable, you may be 
able to use your Mac in Target Disk Mode. This is 
extremely simple to do. First connect the FireWire/
Thunderbolt cable between the two Macs, then 
switch on your own Mac while holding down T.

A picture of a disk should appear on your screen. 
On the other Mac, your computer’s hard drive 
should then be accessible under Devices in Finder’s 
sidebar. Your personal data should be stored in the 
Users folder. It’s easiest to copy the folder named 
after your user account to the new computer. You 
can copy your own files back over to the old Mac 

once you’ve erased and reinstalled macOS by 
putting that computer into Target Disk Mode.

laSt reSortS

If you can’t use Target Disk Mode, you may be able 
to create an image of your Mac’s hard drive using Disk 
Utility in macOS Recovery (see apple.co/2nPc4bW 
for more). Once the copy process is complete, you’ll 
need to connect the drive to another Mac – you may 
want to do this at your local Genius Bar – to check 
that the files have been copied over properly.

This process doesn’t always work if files are 
corrupted. Your best bet in this case is to purchase 
an external hard drive and install macOS to it. You 
can then start up your Mac from that drive and try 
to access your files on the Mac’s internal hard drive. 

This won’t help you recover apps, but you can 
copy and paste over any data you created in your 
home folder, located in /Users. Just copy the 
entire home folder to the desktop.

Refresh your Mac
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Run First Aid on your 
startup disk before 
reinstalling macOS. 

If that doesn’t improve 
performance, continue 

with reinstallation.

Fix your faulty system 

files by reinstalling the OS

reiNStalliNg 
macoS

oNce yoU have backed up your data, 
you can eliminate any corrupted files 
by erasing the Mac’s hard drive and 
reinstalling macOS.

This is done in macOS Recovery,  
a separate area of your hard drive which contains 
tools to diagnose and fix problems, such as the 
system running slowly or failing to start up.

Access the Recovery system by powering on your 
Mac and holding down ç+R. With luck you’ll see  
a welcome screen in various languages and an arrow 
button you can click to continue.

If for any reason Recovery fails to load, restart 
your Mac, start up with ç+å+R held instead. 
You’ll see a message stating “Starting Internet 
Recovery”. If you see the Choose Network option, 

select your Wi-Fi network and enter its password 
to download the Recovery system.

Once Recovery has loaded, double-click on the 
fourth option, Disk Utility. Disconnect your backup 
drive and others before going further, so you don’t 
accidentally wipe any of them.

iNSiDe DiSk Utility

Erasing is a scary word, so it helps to think of this 
process as resetting your Mac back to its factory 
settings. Once Disk Utility has loaded, you can 
select your hard drive in the left pane and run 
First Aid to try to fix the damage. Note, though, 
that this process also runs when you start the Mac 
in safe mode, as you did in the previous section, 
so it may not make a difference.

It’s also possible to reinstall macOS in place, 
which replaces only system files and leaves your 
personal files untouched. However, this is time 
consuming and not guaranteed to fix the issues 
you’ve been experiencing. Ensure your Mac’s  
usual startup disk is selected on the left. This is 
usually named “Macintosh HD.” Next, click the 
Erase button in the toolbar.

Make sure that the format of the drive is “Mac OS 
Extended (Journaled),” then click the Erase button, 
bottom right. Once you confirm, the drive will be 
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erased. This should only take a few seconds.
Quit Disk Utility and you’ll be returned to the 

macOS Utilities window. If you connect to the 
internet using Wi-Fi, look at the top right corner  
of the screen and click on the Wi-Fi icon. Check 
that there is a check mark next to your own Wi-Fi 
network. If not, connect to your network now.

Next, click Continue to begin reinstalling macOS. 
Click Continue again on the setup page and then  
on the blue Continue button. macOS Recovery will 
check which system your Mac is eligible to run. 
Click to agree to the terms and conditions. You’ll 
now be asked where you wish to install macOS. 
Choose the drive you erased moments ago, unless 
you want to install macOS on an external drive  
(see right), then click Install.

The Recovery system will download the version 
of macOS you had installed on your hard drive; the 
time taken depends on your connection speed.

SetUp aSSiStaNt

Once the reinstall has completed, the Mac will  
go through the Setup Assistant. The options here 
are fairly self-explanatory, and you can change any 
of them after the process is complete. If you have  
a recent Time Machine backup, you can quickly 
restore your user account using Migration 
Assistant. This only copies across personal files, 
without affecting the system files. Connect your 
Time Machine drive to the Mac before proceeding.

In the Transfer Information section, the system 
will ask if you want to transfer information “From 
a Mac, Time Machine backup, or startup disk.” 
Select this and then click on your Time Machine 
drive when it appears, then click Continue at the 
bottom of the screen. If your backups were 
encrypted, the system will ask for their password. 
The next page asks which info to transfer. It’s 
best to select only your home folder here, as you 
can reinstall apps from the Mac App Store or 
redownload them from the internet.

The Setup Assistant will begin migrating 
(copying) data from your most recent Time Machine 
backup to the computer. Once it’s complete you’ll 
be able to log in with your previous password. If you 
use your Apple ID to log in and have since changed 
your password, it will be the same password you 
used at the time you ran the backup; after logging 
in, your account password updates to your new one.

If you have erased your hard drive and reinstalled 
macOS, this should have eliminated any software 

You can choose to  
bring back all your 
personal data, but it’s 
best just to restore 
your user account and 
download apps later.

Holding down Alt as you power on your Mac reveals 
a list of volumes your Mac can start up from.

> Installing to an external drive
The macOS 

Recovery system 

can install the OS to 

an external drive, 

then start up from it.  

Using an SSD can 

get this done a lot 

faster; your best 

option is to replace 

your Mac’s hard 

drive with one, but 

using an external 

device is easier, and 

a replacement could 

invalidate your 

warranty. To proceed, 

connect the external 

drive and follow the 

steps opposite, but 

choose your SSD 

(under External in 

Disk Utility’s left 

pane). Select the 

SSD itself, not a 

volume on it. Once 

complete, hold  

down Alt as the 

Mac powers on, then 

choose the SSD to 

start up from it.

issues. If the system is still slow and you chose  
to migrate your data from a previous backup, try 
repeating the above steps and set up an entirely 
new user account without any of your data. This  
will help you know for sure whether the problem  
is with your Mac’s hardware. 

If you’re still experiencing issues, then it’s  
best to seek professional help – have your device 
examined at a Genius Bar or an Authorized Service 
Provider (look one up at locate.apple.com).

Refresh your Mac
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For the last few months I’ve been in love 

with MyScript Nebo, which is great at 

handwriting recognition when using an Apple 

Pencil – even with my scrawl. On iPhone, I will 

never uninstall Soulver, a scratchpad for 

math that’s easier than using a spreadsheet.

If Safari’s Reading 

List is too basic  

for you, I wholeheartedly 

recommend pocket. 

The ability to tag things 

you save makes them 

much easier to look up 

later on. My other 

favorite app is Skype; 

FaceTime is good, but 

its lack of availability 

on non-Apple devices 

is just too restrictive.

I’m a bit of a Netflix junkie these 

days, but its interface doesn’t do 

much to aid discoverability. That’s why 

I use JuStWatch to see what content 

has been added recently. (It isn’t just for 

Netflix, though.) I also couldn’t bear to 

be without Spark, an email app whose 

ability to snooze messages is superb.

Must-have 
apps for

and now 
for our
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poiSoN MapS $1.99

platform iPhone, iPad

This app pairs a wealth of info from OpenStreetMap 

with an interface that makes it a breeze to drill down 

into categories. Mooching about Manhattan and 

fancy a bite to eat? Tap the food and drink icon. Something 

quick? Tap Fast Food. Pizza? Sounds good.

Each tap filters the POIs and buttons shown, arrows point 

at nearby locations when you zoom in, and maps and icons 

are easy to read. The only snag is it takes up 1.2GB, though 

there are regional versions, each of which is a free download 

with a 99¢ in-app purchase to unlock all categories.

Flipboard 4 Free

platform iPhone, iPad

Tell Flipboard 

which subjects 

interest you and 

it’ll show you relevant, high-

quality content in an eye-

catching way. you can tell it 

to create custom magazines 

that you can share, or smart 

magazines that include the 

best content by source or 

based on a hashtag. Read 

our review of the new-look 

version on page 58.

v For Wikipedia $4.99

platform iPhone, iPad

Although you can use this app to search Wikipedia in 

the normal way, it starts out by displaying a Nearby 

tab, providing articles about interesting things in 

your vicinity, with lines snaking their way from locations on  

a map to large clickable tabs at the foot of the screen. It’s a 

practical way to find out about a place without resorting to 

review-oriented web services. V for Wikipedia’s typography 

and layout are smart and sleek.

reading and learning
Get the information you need faster  
and more clearly than ever before

reeder 3 $4.99

platform iPhone, iPad

With apps like 

Flipboard around, 

old-school RSS 

readers get a bad rep, yet 

it’s handy to read updates 

from sites chronologically. 

Reeder is straightforward 

for browsing and reading 

them, and its Readability 

view quickly loads text and 

pics from those that only 

supply brief synopses.

kitcheN StorieS Free

platform iPhone, iPad

Most cooking  

apps and books 

make assumptions 

regarding your abilities. This 

one greets you with a wall  

of gorgeous photography; 

each step in its recipes has 

a picture that shows exactly 

how things should be. Some 

provide tutorial videos for 

potentially tricky parts. 

Fancy some Vietnamese 

pho, but not sure how to 

peel ginger, prepare a chili, 

or thinly slice meat? This 

has you covered. Its 

presentation – especially on 

iPad – more than makes up 

for the narrow range of 

recipes than in rival apps.

duoliNgo Free

platform iPhone, iPad

Duolingo is entirely 

free from in-app 

purchases, which is 

extremely generous given 

the quality of the app and 

its potential for helping you 

learn a new language. It’s 

full of bite-size quizzes  

that you can dip into at any 

time to gradually build your 

vocabulary and grammar in 

the 10 supported languages.

google traNSlate Free

platform iPhone, iPad

When you’re online, 

this app translates 

written, spoken, or  

photographed text between 

many languages. Amazingly, 

between English and French, 

German, Italian, Portuguese, 

Russian, or Spanish (either 

way), it tries to translate in 

real time whatever’s in front 

of your iPhone’s camera — 

even when you’re offline.

goodreader $4.99

platform iPhone, iPad

This is the iPad’s 

best PDF reader, 

and a means of 

editing such docs. you can 

annotate them, extract text, 

rearrange pages, and split 

and combine files, making  

it indispensable if you often 

work with PDFs. The app 

can preview many other file 

types, and connect to a wide 

range of online services.
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System enhancements
Overcome built-in iOS limitations with 
this selection of awesome add-ons

caleNdarS 5 $6.99

platform iPhone, iPad

We’re big fans of 

Fantastical as a 

replacement for 

Calendar and Reminders, 

but this alternative is more 

conventional. It has clearer 

calendar views than Apple’s 

app, natural-language event 

input, and a task center that 

makes Reminders look truly 

abysmal. It also works with 

existing data in iCloud and 

various other services.

hiya Free

platform iPhone

Hiya uses iOS 10’s 

CallKit technology 

to add extra info to 

your iPhone’s incoming call 

screen to identify likely 

spam and scam calls before 

you answer them. That info 

is gathered from the app’s 

users, and you also have the 

option of blocking either or 

both types of unwanted call 

altogether. Turn to page 108 

for a tutorial on using Hiya.

WiFi priority $0.99

platform iPhone, iPad

This app deals with 

a shortcoming of 

iOS itself: with 

several Wi-Fi networks 

available, your iPhone may 

sometimes automatically 

join the wrong one – and 

there’s no way of setting an 

order of priority for them. 

To save you going into 

Settings to correct it, this 

app lets you select and sign 

in to a network, and then 

block it from being auto-

joined. (you can still connect 

to it manually in Settings.)

aNyFoNt $1.99

platform iPhone, iPad

From its earliest days, the Mac was in part a product 

of Steve Jobs’s obsession with typography. Although 

iOS includes a large range of fonts, it lacks the easy 

font extensibility of a Mac, which is where AnyFont comes in. 

It enables you to pull in new fonts from your Mac via iTunes 

or Dropbox, making them available to the likes of Pages, 

Keynote, and Microsoft’s Office suite. Sadly, there’s no bulk 

Dropbox import, and the app must create a separate profile 

for each imported font. These limitations initially irk, but also 

force a sense of focus, encouraging you to add only the fonts 

you really need rather than a collection of thousands.

lauNch ceNter pro $2.99

platform iPhone, iPad (separate apps)

More or less a speed dial for regularly performed 

tasks, Launch Center Pro can be a huge timesaver. 

It takes complex sequences of actions and turns 

them into tappable items. you can create shortcuts for things 

like posting an update to Tumblr, sending your most recent 

photo to Twitter, adding items to list-making app Clear, and 

opening a specific view in Google Maps, and you can arrange 

your shortcuts in groups. Launch Center Pro is an essential 

purchase, and well worth its low price tag if you regularly use 

even just a few of the apps that support it. Check out the list 

of those apps, and the actions that Launch Center Pro can 

automate in each, at bit.ly/2mXZqmy, and you’ll begin to see 

the value of this tool.
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entertainment
Sit back, put your feet up, and enjoy  
a whole new world of sound and vision

ceSiuM $1.99

platform iPhone

Apple’s Music app 

has somewhat 

sidelined personal 

collections, instead heavily 

focusing on the Apple 

Music streaming service. 

Cesium is designed to help 

you focus on your own 

library. It marries old-

school functionality with 

modern iOS design, using 

tabs to quickly switch 

between artists, albums, 

songs, or playlists. If you 

want a music player for 

your iPhone that’s tasteful, 

smart, full-featured and 

free of gimmicks, get this.

overcaSt 3 Free

platform iPhone, iPad

Podcast 

management  

is a perennial 

problem for serious 

listeners, and if you’re 

finding that Apple’s own 

Podcasts app isn’t cutting 

it you may wish to invest 

in something more 

substantial: Overcast is 

definitely it. This third 

major release offers an 

almost complete redesign 

of the already excellent 

interface, with a card 

metaphor applied 

throughout, a useful slide-

up player, quick and easy 

access to show notes and 

other interactive elements, 

and awesome effects. 

If you’ve always wanted 

to speed up a podcast by 

intelligently cutting out 

silences, you’re in luck.

Npr oNe Free

platform iPhone

Apple Music and other services sometimes 

provide full, exclusive access to select albums 

before launch, but they tend to focus on big 

names. If your tastes are a little away from the pinnacle of 

pop, download this NPR app and search for “First Listen” 

to soak up some different sounds. Of course, NPR One is 

also a means to tune in to public radio’s wide range of 

current affairs and cultural programming.

However, it’s those First Listens that really catch our 

attention, as they often showcase albums ahead of their 

full release on newer, supposedly more cutting-edge 

services. We like to think of First Listens as curation with 

a different outlook to the likes of iTunes and Beats 1.

air video hd $7.99

platform iPhone, iPad

Where Infuse is about streaming from network or 

cloud storage, Air Video HD does a similar job for 

videos that are stored on a Mac or PC that’s 

running its free companion server app. All content is live-

encoded as necessary, ensuring it will play on your device, 

and there’s full support for offline viewing, soft subtitles, 

and AirPlay to an Apple TV. Perhaps the best bit about the 

software is how usable it is. The app’s simple to set up and 

has a streamlined interface. A single tap downloads a file 

for local storage. you don’t even need to be on the same 

network as your server either – Air Video HD lets you 

access your content over the internet. Just watch your 

data downloads if you’re on a limited cellular plan!

iNFuSe pro 5 $12.99

platform iPhone, iPad

The idea behind Infuse is to stream your video 

content from a local network drive or cloud 

storage to your iPhone or iPad. When necessary, 

the app converts video on the fly to make it compatible 

with iOS. Got a load of MKV files? Infuse will make short 

work of them. It also excels in presentation; with files 

appropriately named, it fetches cover art and subtitles 

automatically. If you use it across multiple devices – the 

purchase includes the Apple TV, iPhone and iPad versions 

– your progress through videos is kept in sync between 

them by way of iCloud. On iPads that support Split View 

and Picture in Picture, the app works with those, too.

Pay attention that there’s a free version of Infuse on the 

App Store, which offers an optional, annual subscription 

($6.49) to Infuse Pro, including updates even to major new 

versions. However, you can buy Infuse Pro 5 outright for 

$12.99 and only get updates for its current major version. 
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iMgplay Free

platform iPhone, iPad

Bring life to whatever you capture with your iPhone, 

or fine-tune the motion in things that already move. 

This app can work with still photos, videos, Burst 

mode images, or Live Photos. you can stitch stills together 

for a low-end stop-motion effect. Things get really interesting 

with Live Photos and Burst shots: take the video or sequence 

of images, trim the result (even removing individual frames), 

add a filter and text, and export a video or an animated GIF. 

For free, ImgPlay is full-featured. A $1.99 in-app purchase 

adds more filters, and removes ads and watermarked output.

videograde $5.99

platform iPhone, iPad

VideoGrade has 

13 color-grading 

and repair tools for 

changing the look of video. 

Though powerful, it’s also 

straightforward: pick a tool 

(such as Tint, Vibrance, or 

Brightness), then a setting, 

and slide a finger to adjust 

the effect. Move up then left 

or right for subtler changes. 

Results are shown on the 

selected frame, and there 

are horizontal and vertical 

before and after split views. 

Settings can be saved for 

reuse, and exports queued.

Ferrite recordiNg Studio Free

platform iPhone, iPad

As a free app, this mightily impressive, beefed-up 

alternative to Voice Memos lets you bookmark bits 

of recordings to refer to later, and edit and combine 

recordings in its multitrack editor. A $9.99 in-app purchase 

turns it into a fully-fledged podcast creation studio, with 

layered track and project length limits removed. It also adds 

professional effects, which can help transform your projects 

by making audio cleaner and more engaging.

audio and video
Make music and tweak recordings with  
a whole digital studio in your hand

leechtuNeS $1.99

platform iPhone, iPad

LeechTunes uses 

your device’s  

entire display for 

gestural input, enabling 

you to control your music 

without looking at your 

screen, handy when driving, 

exercising, or somewhere 

noisy. In all, there are 15 

configurable options, and a 

sleep timer. One niggle is 

the need to start playback 

in Music if your tracks are in 

iCloud, but LeechTunes can 

then take over control.

luMaFX $2.99

platform iPhone, iPad

We hadn’t counted 

on an app enabling 

rapid layering of 

advanced video effects just 

by blithely tapping away, but 

that‘s LumaFX in a nutshell. 

you can crop and fit videos, 

change speeds, alter colors, 

and play with a catalogue of 

quickly rendered vignettes, 

blurs, and pixelation effects.

dJay pro $9.99

platform iPhone

Djay presents you 

with virtual decks, 

sliders, and various 

buttons, yet on an iPhone it 

looks it’s meant for toddlers. 

you probably won’t bang  

out your latest set using it 

alone, but it can connect to 

a range of audio hardware to 

serve as the brains behind  

a controller. Far from being 

a novelty, it’s worth a look 

for mobile experimentation, 

whether you’re a wannabe 

or pro DJ, and for features 

such as a sampler, four 

decks, and beat-matching.

iStopMotioN $11.99

platform iPad

Unleash your inner 

Laika to create 

frame-by-frame 

stories. The camera overlay 

makes it easy to compare 

the current and previous 

scenes. There’s also time-

lapse functionality, and your 

iPad can control an iPhone’s 

cam if the free iStopMotion 

Remote Camera app is 

running on the latter device. 

youSiciaN Free

platform iPhone, iPad

yousician uses the 

visual and timing 

devices found in 

games like Guitar Hero to 

teach you guitar, piano, or 

ukelele, using your device’s 

mic to track your skills. 

Remarkably effective, and 

with a difficulty curve that’s 

slight. For free, only your 

daily lesson time is limited.
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coMic liFe 3 $4.99

platform iPhone, iPad

Go the whole hog with comic creation: pick from 

predefined templates or basic page layouts, import 

images, then get down to work with plenty of control 

over sound effects and speech balloons, plus a script editor. 

The app’s filters aren’t brilliant at getting a hand-drawn look, 

but this is still a great way to craft stories, and you can 

export to various formats to share with friends – or Stan Lee.

priSMa Free

platform iPhone

Many apps try to turn photos into art, but none hit 

the spot quite like Prisma. It’s almost disarmingly 

simple to use: shoot or select a photo, crop it, and 

then pick an art style; options range from classic paintings 

to comic book doodles. your photo is transformed into a mini 

Picasso or Munch in seconds, and the slide of a finger adjusts 

the effect intensity. We’ve found the app rarely comes up with 

a duff result. Our only criticism is its low-res (2.2MP) output.

procreate pocket $2.99

platform iPhone

Procreate for iPad’s ethos of an interface that gets 

out of your way is even more successful in this 

iPhone version. The top toolbar gives fast access to 

brushes, smudging, an eraser, layers, and adjustment tools, 

while at the sides are handles for changing brush size and 

opacity. Great for actual artists, yet friendly for dabbling in 

digital painting, you can even record your process as a video.

creativity
Beauty is in the eye of the beholder, and 
in the fingers of the iOS device holder

eNlight $3.99

platform iPhone, Pad

As well as photo-

editing basics, this 

app’s painterly and 

classic film filters look the 

part. It can process 50MP 

images on iPad Pro, reduce 

noise, freeze areas during  

edits, and precisely mask 

any effect. you can’t later 

adjust effects, only undo, 

but that’s our only niggle.

over Free

platform iPhone, iPad

Put text over pics 

using an app that’s 

fun to work with, 

but also powerful. you can 

overlay multiple layers of 

text, art, and images, and 

edit things at any point. The 

focused and classy effects 

are perfect for adding 

beautiful type with a subtle 

drop shadow for a birthday 

card, as a watermark, or for 

Lock screen wallpaper.

bruShStroke $3.99

platform iPhone, iPad

Brushstroke turns 

your real life stills 

into gorgeous 

watercolor paintings. Pick 

an image, tap the Go button, 

and after a few seconds you 

get a freshly painted image 

you can further customize 

with different brush styles, 

colored paints and textured 

canvases. you can also 

tweak settings such as 

saturation and brightness.
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MiNdNode $9.99

platform iPhone, iPad

Mindmaps are usually associated with dull  

business tasks, much like huge whiteboards and  

the kind of lengthy meetings that make you hope 

the ground will open and swallow you up. yet they’re ideal  

for getting thoughts out of your head and organized. On 

paper, this process can be messy, and so MindNode is a boon. 

you can quickly and easily add and edit nodes, your iPad 

automatically positioning them neatly. Photos, stickers and 

notes can add more context, and your finished document can 

be shared publicly or privately using a number of services.

WorkFloW Free

platform iPhone, iPad

Workflow provides 

over 200 actions 

for automating 

tasks in Apple’s and third-

party apps. Automations 

can be triggered from within 

Workflow, the Today view, or 

purpose-built Home screen 

icons, and examples help 

you get started. If you need 

further convincing of the 

tool’s worth, how about its 

recent acquisition by Apple?

pdF eXpert $9.99

platform iPhone, iPad

Editing PDFs may feel like it should be done on your 

Mac, but PDF Expert makes it a cinch on iPad. you 

can grab docs from iCloud or Dropbox, and get to 

work rearranging pages, adding new content, creating notes, 

completing forms, making highlights, and even doodling with 

your finger. The app is an impressive PDF reader too, ably 

dealing with large files. The text-to-speech mode highlights 

words as it speaks, and enables you to adjust its speed.

productivity
Get organised, get smart, and get  
serious stuff done in just the right way

pcalc lite Free

platform iPhone, iPad

The iPad’s lack of 

a built-in calculator 

app is no bother; 

this one’s pretty much ideal. 

Text on its big buttons can 

be made bolder and larger, 

and for free you get a few 

unit conversions, too. In-app 

purchases add paid-version 

features, such as more 

conversions, extra themes, 

and a virtual paper tape.

ScaNbot 6 Free

platform iPhone, iPad

The free version of 

Scanbot turns your 

iPhone into a great 

scanner with cloud storage 

integration, support for QR 

codes, and the means to 

detect edges for any page 

you want to digitise. The 

$7.99 Pro version enables 

you to add pages to existing 

scans, quickly name files 

using a smart-naming 

system, and search for and 

extract text from previous 

scans. Scanbot can 

automatically detect the 

likes of phone numbers and 

email addresses in your 

scanned pages, and turn 

them into one-tap buttons.

due $4.99

platform iPhone, iPad

Apple’s Reminders 

isn’t exactly great 

for presentation 

or usability. This app offers 

more helpful navigation  

for adding alert times and  

a repeating schedule. Our 

favorite things about it  

are that item descriptions 

can span several lines, and 

that each item can have  

a different snooze duration.

byWord $5.99

platform iPhone, iPad

Although Editorial 

and Ulysses are 

more powerful text 

editors, this no-nonsense, 

distraction-free app is great 

for writing. Its subdued look 

and typewriter-style font 

feel resolutely old-school, 

yet it’s also modern thanks 

to Markdown support, a live 

word count, and publishing 

to various blogging services.

editorial $4.99

platform iPhone, iPad

Editorial is the text 

editor to choose  

if you want lots of 

control over processing 

output. The app’s writing 

interface is strong, but 

what makes Editorial great 

is that it gives you the 

means to add custom 

snippets, and to integrate 

workflows that extend the 

app and save you time.
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Notability $9.99

platform iPhone, iPad

Of all the iPad’s 

note-taking apps 

Notability hits 

that sweet spot of being 

usable and feature-rich. 

you can scribble on its 

virtual canvas using your 

finger or a stylus, and if 

you demand precision, you 

can drag out text boxes  

to type into. you can also 

import docs. One of the 

smartest features is audio 

recording, which enables 

you to record a lecture or 

meeting, and later play 

back your notes and the 

audio together for context.

day oNe $4.99

platform iPhone, iPad

Day One Journal 

is a brilliant way 

to keep a digital 

record of your life. you can 

include photos and use 

richly formatted text to 

make entries appealing 

to revisit. As your journal 

grows you can revisit old 

memories using the built-

in search engine, on a 

calendar, or the map view. 

On the latter, entries are 

pinned to their assigned 

location, so you’ll have no 

trouble looking up what 

you wrote about a trip you 

took to Las Vegas, say.

carbo $7.99

platform iPhone, iPad

Among the wide range of apps that can 

photograph and store your real-world scribbles, 

Carbo tries something more ambitious than most. 

your sketches and notes are cleaned up and converted to 

vectors, while preserving your original stroke. This means 

that images within Carbo retain the character of your 

penmanship, but are also editable in a manner standard 

photographs are not – you can select and move specific 

elements that Carbo intelligently groups, adjust line 

thicknesses throughout an entire image, add tags 

and annotations, and export the result to various formats. 

Carbo’s friendly and intuitive to work with, and efficient 

as well – a typical Carbo note requires only a tenth of the 

storage as the same image saved as a JPEG.

Journals and notes
Turn sketches into editable images, 
track key life moments, and more

paper by FiFtythree Free

platform iPhone, iPad

For a long while, Paper was the iPad’s freemium 

take on Moleskine notebooks. you drew doodles 

and flipped through virtual pages to browse them. 

It has since become free, and been transformed 

into something different and better. Its original tools are 

still present, and joined by the means to add text, photos, 

and checklists. Geometric shapes you scribble can be 

tidied up, without losing character. These additions make 

Paper great for all kinds of notes and graphs. Rather than 

organizing in notebooks, paper stacks explode into walls 

of sticky notes. Some old hands have grumbled about this, 

but we love Paper. It’s smarter, simpler, easier to browse, 

and makes Apple’s Notes look like a cheap knock-off.
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obScura caMera $4.99

platform iPhone, iPad

Obscura’s smart interface makes it worth attention 

over other camera apps with pro-level controls. Next 

to the shutter are big buttons that lock exposure 

and focus. The chunky ISO and shutter buttons can be quickly 

swapped for other controls. Want a different filter? Swipe on 

the viewfinder. Obscura is controllable with one thumb, and 

focuses on quick feature access without its rivals’ fiddliness.

SNapSeed Free

platform iPhone, iPad

Snapseed is an extremely versatile photo editor. 

It can crop, rotate, ‘heal’, and so on, but its filters 

are the really creative part, with blurs, photographic 

effects, and more extreme options like “grunge” and “grainy 

film.” Most effects are tweakable: swipe up and down to pick 

a parameter, and then horizontally to adjust its strength. 

Brilliantly, the app records applied effects as separate layers, 

each of which remains editable until you save your image.

caMera+ $2.99

platform iPhone, iPad

Front and center here is a minimalist viewfinder; 

manual focus, exposure, white balance, and shutter 

speed are in a slide-out panel. The Horizon Level 

option is helpful and unobtrusive, and macro mode is notable, 

too – the viewfinder zoom and focus slider make this one of 

the easiest apps for close-ups. Post-processing tools are 

extensive, and the Clarity option’s great at saving drab snaps.

photography
Manipulate your snaps for great results 
– your digital darkroom is a tap away

SkrWt $1.99

platform iPhone, iPad

If you’ve ever taken 

an photograph of 

a building head-on, 

you might spot that the 

center of the frame bulges, 

causing lines to curve into  

a bowl shape. you can use 

SKRWT to correct distortion 

to straighten lines, such as  

a building you’ve snapped 

while looking upward.

iNFltr $2.99

platform iPhone, iPad

Filters in iPhone 

apps are designed 

to bring a dose of 

creativity to your digital 

photos. However, it’s easy 

to become overwhelmed by 

the choice on offer, and to 

end up relying on the same 

old filters time and again. 

Infltr snaps you out of any 

such rut, largely by using 

a swipe-based system for 

all but unique settings.

vividhdr $2.99

platform iPhone, iPad

Although the HDR 

mode in Apple’s 

Camera app works 

well, it pales in comparison 

to vividHDR. The concept is 

the same: stunning, vibrant 

photos that capture detail  

in highlights and shadows. 

But vividHDR’s combination 

of speed, presets and before 

and after comparisons 

results in better photos – 

which is what really matters.
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calorie couNter aNd diet tracker Free

platform iPhone, iPad

Even with the best intentions, it’s easy to lose track 

of the fine details of the food we consume. This app 

from MyFitnessPal helps to keep you motivated to 

pay attention: when you scan the barcode on some food’s 

packaging, it looks up nutritional information for that product 

in its database. (you can add info about foods it doesn’t know 

about.) you tell it the portion size you’re about to eat, and it 

adds the calories, carbs, fats, and other details to your food 

diary, which displays the total calories you have left for the 

day, based on your goal weight, helping to keep you on track.

traNSloader $6.99

platform iPhone, iPad

Transloader is one 

part iOS app and 

one part Mac app. 

When you encounter a file 

that you want to download 

while using an iOS device, 

you simply paste the file’s 

address into Transloader to 

have it communicate with 

its companion app on your 

Mac, which then downloads 

the file (both must be 

signed in to the same iCloud 

account). This saves you 

adding the file to Reminders 

or using some other easily 

forgotten workaround.

vNc vieWer Free

platform iPhone, iPad

It might seem strange that Apple doesn’t provide  

a screen sharing feature to connect to and control  

a Mac from iOS devices. This free app from RealVNC 

does a good job of it, though. It allows you to move the Mac’s 

pointer using gestures, and type on it remotely, too – the 

keyboard has Mac modifier keys in its top row. you can add 

shortcuts to computers you connect to regularly, or make use 

of Apple’s Bonjour tech to detect Macs on the same network.

other gems to discover
Go further with eight hidden essentials 
that every iOS device needs

deliverieS $4.99

platform iPhone, iPad

Deliveries is a 

package tracker 

that supports 

a wide range of services. 

It keeps watch on their 

locations and delivery dates. 

Its map shows an item’s 

path to your door, which is 

a special kind of geeky fun 

for stuff that ships from 

halfway around the globe. 

It also includes a widget for 

the Today view, and the 

means to send info to the 

app from messages in Mail.

appcooker $29.99

platform iPad

Got a great idea for 

an iOS or Apple 

Watch app? This 

prototyping tool enables  

you to wireframe its main 

functions, even including 

genuine controls. The tool 

also enables you to test 

your mock-up on your iOS 

device, so you can get a feel 

for user journeys through it.

StreetS 3 $1.99

platform iPhone, iPad

Buying an app for 

Street View might 

seem bizarre, given 

it’s free in Google Maps,  

but this one’s compelling. 

Accessing Street View in it 

is simpler and faster than in 

Google Maps, as is changing 

your position on the map. 

Moving in 3D is a bit jerkier, 

but niggles are countered by 

the app’s overall genuine 

usefulness – not least that  

it identifies as a navigation 

app, and so can work as  

a kind of surrogate Street 

View for Apple’s Maps.

WiNZip Free

platform iPhone, iPad

By extension of 

Safari being unable 

to download files, 

there’s no built-in method 

for looking inside archives, 

which is a pain when a site 

decides that’s how it should 

package up a document, or 

if you want to read release 

notes for a zipped-up app. 

Add WinZip to your iOS 

device to overcome that.

1paSSWord Free

platform iPhone, iPad

1Password can 

store secure notes, 

a driver’s license, 

reward card details, and 

more. On iOS, it’s free (the 

developer mostly makes its 

money on the desktop), but 

a monthly sub or one-off 

$9.99 in-app purchase gives 

you multiple vaults, Apple 

Watch support, and tagging.
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MAC

iPAD

iPHONE

Subscribe to 

Choose your 
perfect package

Ahead of the curve, and endlessly entertaining…

Only $18
Every Year

Instant digital access on your iPad, 
iPhone, and Android device.

Only $30
Every Year

Every issue delivered to your door 
at a fraction of the cost.

Get the DiGital eDitiOn Get the Print eDitiOn

interaCtive 
iPaD eDitiOn - 

inCluDeS extra 
imaGeS anD 
interaCtive 

featureS
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Get both the Print & 
 Digital editions for only

 $42
Every Year

Subscribe 
now and get

20% 
Off

Adobe Creative Cloud 
Photography plan

Get the COmPlete Print & DiGital bunDle

It’s easy to subscribe… 
bit.ly/maclife-subs

Save 
71%

TErmS AnD ConDITIonS Prices and savings quoted are compared to buying full-priced print and digital issues. You will receive 13 issues a year.  You can write to us or call us to cancel 
your subscription within 14 days of purchase. Your subscription is for the minimum term specified and will expire at the end of the current term. Payment is non-refundable after the 
14-day cancellation period unless exceptional circumstances apply. Your statutory rights are not affected. Prices and offers correct at time of print and subject to change. For full terms 
and conditions please visit bit.ly/magterms. Offer ends: 05/30/2017

SPeCial 
Offer
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In its earliest 
incarnation, 
Flipboard allowed 
you to view social 

media feeds and other online 
content in a stylish viewer that 
prioritized visual presentation 
and ease of navigation. Later 
versions allowed you to 
“curate” your own magazines 
on specific topics by adding 
links to web pages and feeds, 
and to share those magazines.

Now, Flipboard takes that 
concept a stage further with  
“smart magazines.” The idea 

is that, rather than 
just allowing you to 
add content from 
specific publishers 
or on fairly broad 
topics such as sports 
or tech, Flipboard 4 
drills down to allow 
you to specify niches 
within general areas 
of interest. It then 
builds a smart 
magazine from 
social media content 
and websites, based 
on your choices. 

As before, you can 
“like” articles and 
add them to a read- 

Flipboard 4
Moving from news to “magazines”
Free  Developer Flipboard, flipboard.com

Platform Universal  Requirements Requires iOS 9.0 or later

Flipboard 4

  Drills down to niche interests

  Still looks great

   iPad version lagging behind iPhone

  Ads will annoy some people

great 

Once you’ve 
chosen a topic, 
you need to 
specify at least 
five sub-topics.

later list, or create a new 
magazine for them. If an 
article is of no interest, you can 
also specify that you want to 
see fewer like it.

Each smart magazine has 
a cover image featuring a top 
story, and flipping it reveals 
three stories. Tap one and 
you’re taken to the source. 
Flip up and you move to 
another story. There’s no way 
to search magazines or to see 
a table of contents.

It all works very well, at 
least on iPhone. The iPad 
version, while named version 
4, hasn’t been updated with 
the new smart magazine 
features. However, any 
magazines you create in the 
iPhone version will be available 
on your iPad – provided you’re 
logged into the same account.

There are obvious 
comparisons with Apple News, 
but these really are two very 
different beasts. While Apple 
News allows you to specify 
the type of stories you want to 
read, it’s limited to publishers 
who make their content 
available in the format 
required by Apple. But that 
also means that you can read 

an article without hitting a 
paywall, something you can’t 
do in Flipboard. While Apple 
News’ actual news stories are 
timely, those that appear on 
Flipboard are often a day or 
more out of date. It really is 
a magazine, not a news app.

Flipboard is free and uses 
ads to generate revenue. 
We found that while they 
occasionally got in the way, 
they didn’t interfere with 
content in the way that many 
website adverts do.

the bottom line. Long-
time users may balk at the 
changes, but for many others 
Flipboard just became much 
more useful. Kenny hemPhill

Inside each magazine, stories 
are presented hierarchically.
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Want a Touch Bar but can’t 

afford the new MacBook 

Pro? Quadro turns your iOS 

device into a touchscreen 

that controls your Mac (or Windows PC).

The app requires you to install a 

mini-server on your Mac, which it then 

connects to over USB (effortlessly) or 

Wi-Fi (with a bit of yelling). It scans your 

Applications folder, and if it spots an app 

it knows about, it installs the appropriate 

set of tiles and buttons to control it. For 

example, if you switch to Ableton you’ll 

get a screen enabling you to control track 

transport, mapping, and quantization. 

Move to Calendar and you get buttons 

iMessage got a supersized 

makeover with iOS 10, but 

those new features didn’t go 

quite far enough for some 

avid messengers. ScribbleChat is a 

standalone iPhone messaging app that 

replaces plain text and emoji with a 

buffet of expressive options.

After setting up an account for your 

cell phone number, the app prompts to 

choose one of 17 handwriting styles in 

15 available colors, using this default 

selection to convert typed text every 

time you press Send. If that’s not swanky 

enough, you can tap the magic wand 

button to summon an assortment of 15 

Quadro
No Touch Bar? No problem
Free (Basic), $14.99 (Premium)  Developer Actions, quadro.me

Platform Universal  Requirements iOS 8.0 or later

ScribbleChat
Messages doesn’t look so playful anymore
Free  Developer Gracious Eloise, getscribblechat.com

Platform iPhone  Requirements iOS 9.3 or later

good 

great 

Quadro knows about other, non-Apple apps 
such as the Tweetbot Twitter client.

If you don’t want yet another messaging app, 
share custom animated GIFs with other apps.

for adding events, editing events, going 

to a particular date, and so on. It’s not 

perfect: The transport controls didn’t 

work in Logic Pro X, presumably because 

Apple has updated it recently, and 

Quadro doesn’t automatically recognize 

third-party apps such as Ulysses or Spark 

– but for core Apple apps it’s a lot of fun.

If you subscribe to the $14.99/year 

Premium plan you can create your own 

collections for specific apps and web 

apps, and you can also automate 

repetitive tasks such as sharing data 

between apps or posting to web services. 

That makes it a very powerful thing to 

have on iPod touch, iPad or iPhone.

other ready-made styles, complete with 

3D text and animation.

Most effects styles tend to be on the 

gaudy side of the spectrum, but a few 

like Neon, Stormy, and Taxi add a dash of 

fun to relevant conversations. Animation 

is also used to great effect with reply 

effects, which briefly take over the entire 

screen to “drop the mic,” explode, or 

offer other visual reactions.

ScribbleChat also plays nice with 

others. Tap the Share button, write a 

message in the effect of your choice — 

oddly, only 11 are available here — and 

ScribbleChat converts your missive to a 

more universally compatible animated 

Quadro may look more Windows 10 

than macOS, but it does the job well, and 

the premium version is very powerful.

the Bottom line. Quadro works 

really well, although the free version is 

limited. The premium version could be a 

massive time-saver. gaRy maRshall

GIF, which can then be sent straight to 

Facebook Messenger or any app that 

provides a Share menu extension.

the Bottom line. ScribbleChat 

brings emotion to texting with lively 

effects and animation. 

J.R. BookwalteR
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Is your calendar 
due a makeover? 
Developers seem 
to think so, and 

are going out of their way to 
reimagine how a mobile 
datebook should look and 
function. Apps like Dial 
Calendar (reviewed in issue 
122) have a lot of great ideas, 

but visual flair alone 
isn’t enough to enhance 
your productivity.

Vantage Calendar 
is the latest iOS app to 
give your agenda a 
facelift, but unlike the 
competition, this one 
retains the features 
people want in this kind 
of app. The main view 
resembles a Star Wars-
style opening title crawl 
in reverse, with the 
current day’s activities 
at the bottom, grouped 

Vantage Calendar
Add some flair to your dates
$5.99  Developer Fortyfour, vantage-app.com

Platform Universal  Requirements iOS 9.0 or later

Color themes and a unique 
scrolling timeline stack 
make Vantage Calendar 
one of the better-looking 
datebook apps around.

Vantage Calendar

   Assign unique colors, fonts, and 
stickers to your events

   Quickly change events into to-do 
list items

  Excessive dead space on iPad version

   Custom repeat and additional color 
options require in-app purchases

good 

into stacks that scroll vertically 
into the past or future.

You can also scroll through 
connected iCloud, Google, 
Outlook, or Facebook Events 
calendars with a horizontal 
swipe across the top grid 
followed by a tap to jump to 
a specific day. A tap on any 
event expands to full-screen, 
complete with all the typical 
details found in other apps.

Vantage does have a few 
clever tricks up its sleeve. 
Events can be assigned colors, 
fonts, and stickers to make 
them stand out in the timeline. 
Such embellishments currently 
won’t sync to other calendar 
apps, but too much of that kind 
of thing would start to look 
gaudy anyway. It’s great for 
highlighting the occasional 
special event, however.

In addition to the main 
timeline, Vantage Calendar 

includes weekly summary and 
hourly schedule views, as well 
as a mini-month summoned 
by tapping the current month’s 
name, which displays events as 
colored dots. Need more detail? 
Tap the arrow located at the 
bottom to expand even further 
into a slick full-month view, 
complete with event titles.

Curiously, the app has no 
landscape mode except on the 
iPad, where the timeline is 
surrounded by an excessive 
amount of dead space. 
Although you would expect 
month views to work better on 
a tablet, they wind up being 
artificially crammed into the 
center of the display instead.

We liked the ability to switch 
an event to a to-do list item, 
but if you prefer a lot of alert 
options will be disappointed to 
find the only available choices 
are 15 minutes, 30 minutes, 
one hour, and one day. There’s 
also no way to search events, 
although this is being added.

the bottom line. Offers 
visual flair without sacrificing 
familiar features, but the iPad 
version is a work in progress. 
J.R. bookwalteR

Vantage Calendar 
offers a better-
looking schedule 
view without 
sacrificing the 
important details.
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Here at Mac|Life, we love 

listening to podcasts with 

Overcast – and now, the best 

podcast app out there just 

got even better with version 3. There 

are lots of changes here, most of them 

focused on ease of use.

Playback settings can be accessed by 

swiping left or right, rather than having 

the controls hidden in the corners of 

the screen. The control to change the 

playback order has an explicit label, 

instead of a tiny triangular icon. And best 

of all, you can – at last! – create proper 

playlists. Before, the only option was for 

ScreenPlay is a puzzler 

aimed at 9-to-11-year-olds, 

but despite its name, 

teaching your child the art 

of writing for the movie or TV business 

is not the aim of the game.

Instead, making movies provides a fun 

backdrop and analogy for the game’s real 

objective: helping youngsters develop 

logic and algorithm-building skills that 

will help lay the foundations for learning 

to code, not to mention prospering in 

math and other logic-based subjects.

The gentle progression through 

increasingly difficult levels makes the 

game straightforward to pick up. While 

Overcast
Pure podcast perfection
Free ($9.99 in-app purchase removes ads)

Developer Overcast Radio, overcast.fm

Platform Universal  Requirements iOS 10.2 or later

ScreenPlay
A misleading title for an educational puzzler
$0.99  Developer Barbara Kudiess, twitter.com/Screenplay_Game

Platform Universal  Requirements Requires iOS 10 or later

awesome 

great 

A few interface tweaks can make the world 
of difference, as Overcast demonstrates.

The early levels ease players into the game 
gently, as you might expect.

Smart Playlists, which added new 

episodes based on rules you set (such 

as adding every new episode from one 

playlist, and a handful from another). 

That was fine in some cases, but there 

was no way to make a playlist of cherry- 

picked episodes until this version.

Now you can create a list of favorites 

that isn’t irritatingly updated with every 

new episode. It’s a minor change, but so 

good. Our only gripe is that there’s no 

way to quickly add an episode to a 

playlist from the Now Playing screen, 

which would be great for playlist 

management on the go.

the instructions are scant, most 9-to-11- 

year-olds, perhaps with a little help, will 

have no trouble getting started. 

Taking the role of director, your job is 

to instruct your actors Sam, Zemo and 

Liam and position them on set. You do 

this by sequencing instructions such as 

“walk” and “turn” through pressing the 

appropriate button on-screen. Starting 

points and objectives are clear for early 

levels, but as the puzzles become more 

difficult, you’ll have to think carefully 

about how you order instructions.

Graphically, Screenplay is cute. Some 

of its target age group may feel it looks 

a little too young for them, though they 

But with all the new interface changes 

– plus the app’s clever features such as 

silence shortening and voice boosts – 

it’s still our number one podcast app by 

some distance.

the bottom line. Interface tweaks 

don’t sound exciting, but they make a 

great app near-perfect. Alex blAke

might enjoy the iMessage stickers that 

come with the game. We’re not sure 

the same can be said of the game’s 

soundtrack, which becomes irritating.

the bottom line. A fun way to 

teach kids the basics of coding, but we 

wonder whether it’s engaging enough for 

its target audience. kenny hemPhill
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There’s something 
oddly sweet about 
the premise of 
Warlock’s Tower. 

The villain has set out to 
destroy the world, using his 
life-draining tower to bring 
about the apocalypse. The 
world’s nations have signed 
a letter to say said warlock 
is not, as you might expect, 
hated, and perhaps he’d really 
rather reconsider his actions. 
Tim the mailman becomes the 
hero of the hour, aiming to 
reach the top of the tower to 

Warlock’s Tower
A retro-infused, turn-based puzzler
$1.99  Developer Midipixel, midipixel.com

Platform Universal  Requirements iOS 6.0 or later

The mailman probably reasons 
he’d sooner deal with vicious 
dogs than a nasty warlock.

Warlock’s ToWer

  Really smart puzzles

  Quirky humor

   No undo button

   Aesthetics may grate

greaT 

hand-deliver the note. 
(Letter or not, quite how he’ll 
convince the warlock he’s 
loved despite his genocidal 
ways is another matter.)

The journey plays out as 
a path-finding, turn-based 
puzzle game. Every step you 
take depletes your life force. 
However, regenerating gems 
are dotted about, giving you 
extra steps. You simply need 
to figure out which – often 
circuitous – route will get you 
to the exit before you croak. 

Only it’s not so simple, 
because as you work your 
way upwards the warlock 
occasionally appears before 
you, to gloat and lob further 
complications into the mix. 
Most are welcome and force 
you to shake up your strategy: 
crisscrossing moving 
walkways; levels where you 
switch between two players, 

sharing the moves limit; 
encroaching zombies that 
shuffle your way after every 
few moves. We could, however, 
have lived without levels where 
the lights go out, forcing you 
to inch around in the gloom.

Other aspects of Warlock’s 
Tower may prove divisive. 
The Game Boy aesthetic and 
chip-tune soundtrack may 
evoke feelings of nostalgia or 
just grate, depending on your 
viewpoint; and the controls 
can be a little awkward. The 
biggest flaw, though, is the 
lack of a multiple undo button. 
On larger levels, it can be 
irritating when you once again 
make an error and have to 
retrace your steps to the point 
of failure, in order to try 
something new. 

Still, trying to halt the 
machinations of a magical 
despot was never going to be 
easy, and when it comes to the 
puzzle parts, Warlock’s Tower 
very much has what it takes to 
succeed. Do you?

the bottom line. A great 
puzzle mechanic insures 
Warlock’s Tower comes 
recommended by us. 
CRaig gRannell

Get to the exit 
before you die 
horribly – and 
avoid zombies 
along the way.
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C
ES is a royal flush of nerd-tastic 

gadgets and gear—but most of 

it isn’t exactly tailored to Apple 

fans. You can see everything from TVs 

to washing machines to flashlights in the 

grand halls of the Las Vegas Convention 

Center. That’s why we spent most of our 

time in the Apple-centric iLounge, which 

doubled in size since last year. When the 

dust settled (and our AT&T service bars 

finally reappeared), we distilled everything 

we’d seen down to these favorites. 

By far, the majority of Apple-related 

gear at CES was for iPhones and iPads. 

So when we saw Mac stuff, we took 

notice. By far, the majority of Apple-

related gear at CES was for iPhones 

and iPads. So when we saw Mac stuff, 

we took notice. One of our jackpot finds 

was Mobee’s Magic Charger ($49.90, 

mobeetechnology.com), a nifty and 

utilitarian induction charger for the Magic 

Mouse. You place the custom battery 

pack inside your Magic Mouse, rest it on 

the included charging pad, and it charges 

wirelessly when you’re not using it. And 

it looks rad, as does our other favorite 

Maccessory, the H-Squared Mini mount 

($49.95, store.h-sq.com), which was 

designed in conjunction with Apple’s Mac 

mini team. It replaces your mini’s cover 

with a mountable one you can screw 

right into a wall. Bonus: there’s also a 

screw pattern for VESA mounting, so 

you can attach your mini to the back of 

a VESA-compatible monitor, like, say, the 

Cinema Display. Our favorite little extra is 

an optional white LED backlight that gives 

your mounted mini some ground-effects 

style. 

 And speaking of style, we saw more 

snazzy cases than we knew what to do 

with. Amidst the piles of cases, plentiful 

as poker chips, we found a couple that 

deserved a shout-out. Both Speck 

(speckproducts.com) and Trtl Bot (trtlbot.

com) had sleek cases with pull-out tabs 

for stand-up viewing. Mophie brought ace 

design to its new Juice Pack Plus ($99.95, 

mophie.com), which combines a bigger, 

two-day battery with a grippy rubber 

coating. And its new iPod touch–only, 

gaming-focused Pulse case (price TBA) 

rumbles, giving you the kind of force 

feedback that you’re used to on your Xbox 

or PlayStation. 
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as poker chips, we found a couple that 

deserved a shout-out. Both Speck 

(speckproducts.com) and Trtl Bot (trtlbot.
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coating. And its new iPod rumbles, giving 

you the kind of force rumbles, giving you 

the kind of force rumbles, giving you the 

kind of force rumbles, giving you the kind 

of force touch–only, gaming-focused Pulse 

case (price TBA) rumbles, giving you the 

kind of force feedback that you’re used to 

on your Xbox or PlayStation. 

Scosche (scosche.com) had plenty of 

cases too, but we were most impressed 

with its new heart rate monitor. The 

MyTrek attaches to your arm, instead of 

lying across your chest like a traditional 

monitor. Want to stay in a specific heart 

rate zone? No problem, just tell the 

application, and it’ll help you get there 

with all sorts of beeps. It can also harness 

the iPhone’s built-in GPS to tell you 

how far you ran or biked and how many 

calories you burned in the process.

When we left Scosche, we could hear

CES 2011: BESt of thE BESt
We combed the gargantuan show floor to bring you the early word on this 
year’s most exciting Mac and iOS gear. BY NIC VARGUS
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Poor Mr. Whiskers. 
The maker of his 
favorite dumplings 
is missing, leaving 

a trail of the tasty foodstuff 
that leads far into the distance. 
Needing to discover a taste for 
adventure as well as savory 
dough, our heroic feline sets 
out to locate his friend.

From the off, The Big 
Journey doesn’t take itself 

The Big Journey
A furry hero must find his friend
$1.99  Developer Armor Games, armorgames.com

Platform Universal  Requirements iOS 8 or later

Bugs to eat… Colorful 
landscapes… What’s 
not to like here?

The Big Journey

  Plenty of character

  Suitable for all ages

   Challenge is very slight

   Little variety of play

greaT 

too seriously. The backstory’s 
writing is amusingly silly, and 
the game involves directing 
a decidedly squishy and 
seemingly legless kitten about 
a colorful, hilly, tunnel-strewn 
landscape, while it burps cat 
noises and occasionally eats 
something it shouldn’t, 
leading to a temporary 
hallucinogenic experience.

As ever, the main aim is to 
find each stage’s exit. Along 
the way, you eat bugs, find 
hidden dumplings that make 
you fatter, and discover new 
friends (collectable “cards” for 
bragging rights, and alternate 
cats to play as). Control 
involves either tilting to move 
and prodding to jump, or a left/
right/jump button system.

You get the feeling The Big 
Journey’s creators wanted to 
fashion an approachable game 
for all ages. The challenge is 

slight: enemies are few in 
nature and for the most part 
easily avoidable, and speedrun 
targets are generous. 
Collecting every dumpling and 
bug in each stage is a slightly 
tougher ask, but a general rule 
of thumb is never to trust a 
blurry piece of silhouetted 
scenery – it often hides a 
useful tunnel.

The result is a laid-back, 
arcade-oriented platform 
game that comes across like 
a sedate take on iOS classic 
Rolando, or a stripped-back 
LocoRoco. But despite not 
being terribly innovative, and 
being easy enough to breeze 
through in a few hours, it’s 
hard not to be taken in by The 
Big Journey. The entire game 
oozes character and charm, 
the level design is smart (if 
perhaps lacking a little in 
variety), and its vibrant, 
jolly nature is pretty much 
guaranteed to put a smile on 
your face. Unless you hate cats  
and dumplings, you monster.

the bottom line. An 
entertaining, jolly arcade 
platformer that’s suitable 
for gamers of any age. 
CRaig gRannell

You’re not fooling 
anyone with the 
hard guy act, 
Mr. Whiskers. 
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The great outdoors is a place of 
wonder and beauty, but also a lot 
of questions. What’s out there in 
the first place, and how do we get 
there? Can you eat that plant? 
Wait, where did we park again? 
Relax, valiant explorer. Here are 
six apps to the rescue!

If you’re looking for an offline 
map app and travel guide all rolled 
into one, Pocket earth offline 

MaPs & travel Guides (Free, 
Universal) is your answer. It has 
offline maps for regions around 
the world, travel guides with 
points of interest, hiking and 
cycling guides, transit directions, 
GPS tracking to record the routes 
you take, optional topographic 
maps… you get the idea. In-app 
purchases unlock certain regional 
maps and topographic options.

Whether you blew through your 
food stash with two days to go or 
you’re just feeling curious, you 
don’t have to roll the dice when 
sampling local vegetation. 

Wild edibles foraGe ($5.99, 
Universal) is a guide that helps 
you identify, prepare, and even 
cultivate over 250 plants. You can 
filter by region and season, attach 
notes to a map about the plants 
you find, and more.

For much less than the price of 
hiring a professional tracker, pick 
up itrack Wildlife ($14.99, 
Universal) to identify the local 
animals on your own terms. The 
app is packed with details, track 
images, and skulls of more than 
70 North American species. You 
can search by a wide variety of 
criteria, and the Wikipedia pages 
for every animal are built in to the 
app for offline viewing.

Some people head to the great 
outdoors to get away from it all, 
while others still need cellular 
coverage for a variety of reasons. 
If you’re in the latter camp, check 
out coveraGe? ($2.99, Universal). 
Data coverage maps for all four 
major North American carriers are 

included, and in offline format to 
boot. You can also slice it by LTE, 
4G, 3G, and even 2G, if that works 
for your trip.

Is it gonna rain where you’re 
going? Weather underGround 
(Free, Universal) includes all the 
basics of weather monitoring, 
as well as hyper-local alerts for 
changing conditions, a webcam 
viewer, storm radar, historical 
comparisons, and lots of details 
like air quality and UV risk. You 
can also create custom forecast 
alerts to determine when 
conditions are optimal to do things 
like going for a hike.

Sadly, you have to head back 
to the real world eventually, and 
find My car ($1.99, iPhone) is 
a great way to ensure you do it as 
painlessly as possible. You can 
save your car’s position based on 
GPS, add a photo to help jog your 
memory, jot down details about 
the space, and share it with other 
Find My Car users.

rounduP

6 apps for surviving the great outdoors
Sooner or later, you’re going to have to go outside, you know

by david chartier

Our old adage of “If it’s red, don’t eat it” 
has been blown away by Wild Edibles Forage.

Turns out it’s not a Bigfoot after all… 
Identify local fauna with iTrack Wildlife.

Plan your actitivies the smart way with 
Weather Underground, and avoid the wet.
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If there’s a true “killer app” for 
Apple Watch, it would be task 
management. After all, once 
you’ve keyed a bunch of tasks 
or events into your iPhone, 
it’s just a matter of checking 
them off as each one is 
completed, which can easily 
be done from any smartwatch.

Complete does this and a 
whole lot more, offering full 
sync with Apple Reminders, 
“nag” alerts so you won’t 
forget what needs to be done, 
color-coding, and the ability 
to add new items by simply 

Complete
A supersized alternative to Reminders
$4.99  Developer 24me, twentyfour.me

Platform Universal  Requirements iOS 8.0 or later

requesting an Amazon Alexa-
powered device to enter them 
for you. (Note that the app’s 
developer offers quite a similar 
app called 24me – it’s easy to 
get the two confused.)

Smart alerts provide a 
summary of the day’s agenda 
alongside weather and 
birthdays, and group tasks 
allow for collaboration with 
family, friends, or coworkers.

The app doesn’t lose much 
of its strength on Apple Watch, 
although the watchOS version 
focusses strictly on managing 
events taking place today and 
the two days after that.

With a Force Touch press 
on the Watch’s screen, you 
can quickly add a new task, 
event, or note, each offering a 
comprehensive set of options 
along with voice dictation – so 
the connected iPhone never 
needs to leave your pocket 
while doing so.

Complete manages to pack 
an awful lot into the watchOS 
user interface, and is versatile 
enough to work as a grocery or 
other type of shopping list. 
One of the more unique 
features is the ability to 

auto-complete tasks with a 
single tap to automate sending 
gifts, making calls, sending 
texts or emails, and more.

the bottom line.  
Complete lives up to its name 
as a supersized alternative to 
Reminders, although we’d like 
to browse more than three 
days’ worth of tasks. 
J.R. bookwalteR

Complete

  Comprehensive to-do list app

   Plenty of options when adding 
tasks on Apple Watch

   Browsing on Watch app limited 
to current and next two days

great 

All Apple Watches 

have a generous 

8GB of internal 

storage. To see 

what’s consuming 

space, open the 

Watch app on 

your iPhone and 

browse to General 

> Usage, where 

apps are ranked 

according to how 

much space 

they’re taking up.

watch tiP

Manage storage
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watchOS already 

includes a built-in 

app for remotely 

controlling the 

iPhone’s camera, but 

it doesn’t do much 

beyond taking photos 

and triggering a timer. Iris – Pro Camera 

Control goes the extra mile, offering 

complete remote control over exposure, 

ISO, focus, zoom, color temperature, 

and tint, right from your wrist.

You’ll need to have Iris running on 

iPhone, of course — you can’t control 

the built-in iOS Camera app from this 

one — but otherwise this is a great way 

to fine-tune shots before they’re taken, 

especially when the device is mounted 

on a tripod. A swipe across the Apple 

Watch’s display switches between 

options, which you adjust by turning 

the digital crown.

Once you’re finished making any 

adjustments, simply Force Touch to 

call up a shortcut menu, then tap Take 

Photo rather than swiping all the way 

back to the shutter button. 

the bottom line. A better way to 

remotely control your iPhone camera. 

J.R. bookwalteR

Nothing makes a 

parent worry more 

than when their kids 

head back to college 

but forget to call or 

text that they made it 

home safely. Knowtify 

is a free app that automates the entire 

process, but in this case “free” only 

applies to installing the app.

If you want to do anything with 

Knowtify, you’ll first need to pony up for 

an auto-renewing in-app subscription, 

currently an affordable $2.99 per year. 

The problem is there’s no trial period, 

so you’re stuck paying in the hopes it 

does what it claims. Thankfully, 

Knowtify mostly lives up to its 

promises, although the Apple Watch 

app is a tad on the basic side of things. 

Once you’ve set up a list of your top 12 

contacts on iPhone, they’ll also appear 

in the Watch app, where you can choose 

to automatically notify those people of 

your arrival with an SMS, or remind you 

to do so on your own within five 

minutes of coming back home.

the bottom line. It works, but 

you have no choice but to pay for the 

first year to try it. J.R. bookwalteR

Iris – Pro Camera Control
Shoot from the… uh, wrist
Free  Developer Stephen Anthony, darjeelingapps.com

Platform iPhone, watchOS  Requirements iOS 10 or later

Knowtify
Let others know you’re okay
Free ($2.99 sub required)  Developer BrushMedia, brushmedia.com

Platform iPhone, watchOS  Requirements iOS 8.2 or later

great 

good 

wheRe to? 

Finding a great place to eat 

nearby no longer has to be a 

challenge. Put Where To? ($2.99, 

appsto.re/i67R672) on your 

iPhone, and then on your Watch.

time to eat 

Once you’ve found 

something that sounds tasty, tap 

to read reviews, view opening 

hours, or get directions in Apple 

Maps to guide you to the door.

bUFFet oF choiceS 

Launch the Watch app and 

tap Any Restaurant to see a list of 

all the places to eat nearby. Save 

your favorites so you can quickly 

find them next time.

how to

Find somewhere 
good to eat out
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T
he major appeal of Drobo’s storage 

drives is the ability to start with 

two disks installed and add more 

later to boost capacity whenever suits 

you. The distinguishing feature of this 

model is its USB-C port; a USB-A-to-C 

cable is included, but if your Mac has 

the newer kind of port, you’ll need to 

provide your own adapter or replace the 

cable. This port is limited to USB 3.0 

speeds, though.

Access to the disk bays requires no 

tools: The front panel is magnetically 

attached and easy to remove. The 

downside is there’s no way to lock the 

panel in place. A sticker on its back 

explains the statuses of the lights on 

the front-right of the drive.

Drobo’s online guide walks you 

through inserting 3.5-inch SATA disks 

into the bays, installing the Drobo 

Dashboard on your Mac, and using the 

app to configure the drive. Getting set 

up took us about 10 minutes, then a 

good while longer for the two disks we 

inserted to be initialized. After that, 

you can add more disks at will; 

detection takes roughly 10 seconds. 

Some of the total capacity of your 

disks is set aside as an overhead to 

protect against a disk going bad. With 

the default settings, one of them can 

fail without enduring any data loss. 

Protection against two disk failures is 

an option if you’re willing to sacrifice 

additional space for files. Replace a 

failed disk with one of the same or 

a greater capacity and the array is 

rebuilt automatically for you.

Additionally, the dynamic nature of 

Drobo’s BeyondRAID tech enables you 

to expand on the capacity of whatever 

disks you choose to install in the first 

place; you can remove one disk and 

install a new one of a larger size 

without problem. Again, the drive 

deals with this automatically.

The Drobo Dashboard app shows 

array and disk status info clearly, and is 

complemented by a menu bar icon that 

informs you of problems – a nice touch 

if you place the drive somewhere the 

status lights on its front are out of 

sight. As for Time Machine support, 

there’s an option to limit the space it 

can use by setting aside capacity on a 

separate volume to your other files.

the bottom line. The Drobo 5C’s 

price, set-up process, and supporting 

software make it an affordable and 

flexible pick for protecting files at 

home. AlAn Stonebridge

Drobo 5C
USB-C storage that can grow to suit your needs
$349  manufacturer Drobo, drobo.com

Features 1x USB-C port, five bays for between two and five disks

Drobo 5C

   Flexible for future 
storage expansion

  Excellent software

   Port is limited to  
USB 3.0 transfer rates

   Only one port, so it 
lacks a USB hub feature

gooD 
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MacOS’s full-screen views and Mission 
Control are great for quickly swiping between 
apps and for focusing on a single app. But 
what do you do on those occasions where you 
need to frequently swap between apps, either 
because you’re working on a document that 
references another, or because you need 
access to resources stored in a folder?

That’s where Mosaic comes in. Mosaic, 
like Magnet (reviewed in issue 127), allows 
you to easily manage windows so they occupy 
a set area on-screen, allowing you to view 
two or more simultaneously at the tap of a 
keyboard shortcut, or a quick drag and drop.

Mosaic sits in the background until you drag 

a window, at which point an overlay appears, 

presenting you with a view showing different 

layouts – such as two windows side by side, 

or a grid.  Just drag the active window onto a 
position on that overlay to set it. If you don’t 
want Mosaic to appear every time you move 
a window, you can set it to activate only 
when you press Alt. You can also specify 
whether layouts in the overlay are displayed 
in rows or columns, and where on screen 
the overlay appears.

Mosaic differs from Magnet in that its Pro 
and Business versions enable you to create 
custom layouts for windows and add them to 

Mosaic
More ways to wrangle your windows
$12.99 (Standard), $29.99 (Pro)  Developer Light Pillar Software, lightpillar.com

Requirements OS X 10.11 or later

Mosaic

   It’s easy to change 
window layouts

   Can create custom 
layouts in Pro edition

   Standard layouts make 
elegant use of space

   Some Pro features 
should be in Standard

excellent 

the layout library. If you’re the kind of 
person who has a very specific way of 
working with and arranging windows, 
that may appeal. 

Neatly, Mosaic’s layouts allow for a little 
extra space around windows so that they look 
attractive on screen, and so that shadows 
don’t overlap the neighbouring window. 
As with most other things in Mosaic, you 
can adjust the size of the spacing to suit.

Mosaic supports the Touch Bar on the 
new MacBook Pro, and it even has a remote 
control app for iOS that allows you to resize 
the active window on your Mac by tapping a 
layout on your iPhone or iPad.

There are a couple of important things to 
note. The first is that Mosaic doesn’t work 
well with apps that dictate a minimum size 
for their windows – unless you take that size 
into account when you set up a layout. 

Perhaps more importantly, though, some 
features you might expect to see in the 
standard version, such as keyboard shortcuts 
and Touch Bar support, are limited to the Pro 
and Business Editions, which is a shame. 
(Business carries a monthly subscription.)

the bottom line. Mosaic caters for 
everyone who needs to work with multiple 
windows, whether your needs are simple or 
very specific. Kenny hemPhill

Sadly, only the Pro and 
Business editions enable 
you to create custom 
window layouts.

You can choose whether the overlay shows layouts in 
columns or rows, and where it appears on screen.

>>>Reviews
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W
hen Apple announced its AirPods, 

it revealed the W1 chip would also be 

used in two other headphones; BeatsX 

is one. The chip makes it a cinch to pair the 

headphones and your iPhone; power them on, 

put them near your iPhone, and then confirm 

on screen. The pairing is added to your other 

compatible Apple devices by way of iCloud. 

Although this convenience shouldn’t be your 

reason to buy BeatsX (or AirPods), it’s hard 

not to appreciate it. The headphones can be 

paired with other devices using a button.

The two earpieces are joined with a flat 

cable, the middle of which is shaped to rest 

neatly around the back of your neck. Two 

bars keep it near your collarbone. Above the 

left one is a somewhat cheap-looking inline 

remote control with a mic. Though this seems 

old-fashioned compared to the touch controls 

on some headphones, the responsiveness is 

reassuring. What we missed about the 

AirPods, though, is in-ear detection, which 

pauses or resumes playback when a bud 

is removed or reinserted. Here, that’s manual.

The rest of the cable fits more loosely, 

which avoids an earpiece pulling out when 

you turn your head. The buds even snap 

together magnetically to keep them close by.

There’s an exposed Lightning charging 

port on the left bar, which faces downwards 

if you’re careful to ensure the cable isn’t 

twisted. A full charge lasts eight hours.

The buds fit inside your ear canals to 

afford some noise isolation, but at mid- 

volume we could hear nearby chatter. Sound 

quality is pleasant, and holds up reasonably 

well when pushed louder, thanks to more 

restrained bass than you might expect. 

However, we’ve enjoyed punchier, more 

vibrant sounds from more affordable buds.

the bottom line. BeatsX combines 

some of the convenience of AirPods with 

practical controls and a good fit, but sound 

is merely okay. AlAn stonebridge

BeatsX

Well, they’re harder to misplace than AirPods…
$149.95  manufacturer Beats, beatsbydre.com

Features Bluetooth, inline remote control and microphone, Lightning to USB-A charging cable

BeatsX

  Cable fits well

  Clever magnetic buds

  Good range of eartips

   High cost for merely 
good sound quality

GOOD 

Tough testing, trusted ratings
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Aside from scheduling events or printing 
calendars for future reference, schedule data 
stored in Apple’s Calendar remains mostly 
out of reach to other software. TimeTable 3 
makes Mac calendars more versatile by 
exporting event data that can be used for 
time tracking, invoicing, or a variety of other 
organizational needs.

Unlike the more visual layout of traditional 
calendar apps, TimeTable presents daily, 
weekly, monthly, or yearly event data as a 
list. Default start dates, calendar names, 
and titles are displayed in columns that can 
be resized, sorted, or rearranged to create 
custom layouts which can be saved and 
reused; other column types including 
Location and web address can be enabled in 
the app’s preferences. It’s easy to search 
events or jump to a specific beginning or 
ending date with a few clicks.

TimeTable extrapolates the event length 
into a unique Hours column, which is used to 
display a real-time tally of combined hours 
and/or minutes you’ve devoted to calendar 

TimeTable 3
Get your calendar data out into the world 
$19.99  Developer Steven Riggs, stevenriggs.com

Requirements OS X 10.10 or later

TimeTable 3

   Easily export calendar 
data in text, CSV, or 
TSV file format

   Option to apply 
hourly rates to 
track billable hours

   Calendars aren’t 
organized by 
account type

   Expensive for 
casual use

good 

events during the selected period, along with 
minimum, maximum, and average totals. 
Depending upon how you schedule events, 
this data is useful for calculating billable 
hours by applying an hourly rate, which 
works in tandem with the Cost column.

We typically schedule a lot of all-day 
tasks such as birthdays, which TimeTable 
interprets to be 24 hours long. You can 

globally adjust the length of all-day events 

to anything from zero to 24 hours, or exclude 

this type of entirely, if so desired. You can also 
disable certain calendars to keep them from 
being included in TimeTable’s calculations. 
The only problem is there’s no way to see 
which accounts they belong to; we wound up 
with multiple calendars with the same name 
from iCloud and Gmail.

This inconvenience aside, TimeTable 
makes it super-easy to export calendar data 
in a few different formats: comma-separated 
CSV or tab-separated TSV files for use in an 
Excel or Numbers spreadsheet; as a plain 
text file; or by sending the neatly formatted 
results directly to a new outgoing message in 
Apple Mail. Finally, there’s also an option to 
export only events that have notes added.

the bottom line. Priced at $20, this 
utility is destined to be strictly for die-hard 
calendar jockeys. J.R. bookwalteR

TimeTable 3 enables you  
to export calendar data in 
various useful formats.

The Export Text option can create a standalone formatted 
text file or send data directly to a new Mail message.

>>>Reviews
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DupeZap scans your Mac and/or connected storage to 
find duplicate files, which you can then inspect or delete 
individually or en masse. It’s very fast - incredibly so on 
SSDs - and it’s particularly good for cleaning up iTunes 
libraries, showing not just track names but also bit rates.

The app isn’t just for music, however: it finds duplicates 
of any file type, so it’s a good app for cleaning up your 
Photos library. The file preview supports simultaneous 
multiple files, which is a real time-saver when you’re 
sorting through images. We like the color-coded interface 
too, which makes it easy to see what kind of duplicates 
you’re dealing with: When you move to the results window, 
it’s tabbed with images, music, movies, archives, and more.

There are several ways to fine-tune your search and what 
happens to the duplicates. You can organize results by file 
type, location, or creation date, and if you’re feeling nervous 
you can opt to move the duplicates to a folder rather than 
permanently delete them. 

the bottom line. If you need more power than iTunes’ 
Show Duplicates, DupeZap has it. gary marshall

Almost identical to its predecessor, Disk Care 2 

quickly displays startup disk contents as a circle 

grouped into eight different categories: Mobile 

Apps, Mail Downloads, Downloads, Old iOS 

(software updates downloaded by iTunes), App 

Logs, Cache, Large Files, and Trash.

Click on one or more slices, and the center 

button updates in real time to show how much 

space will be reclaimed by deleting the selected 

content; one last click on the center button, and 

the deed is done.

Slices change color when selected, offering 

peace of mind that those left as the default shade 

of gray will remain intact; you can also add files 

and folders that should never be deleted to an 

exclude list. If you own a new MacBook Pro, you 

can now use the app entirely from the Touch Bar, 

or gain access with Touch ID; regular password 

protection is also available.

the bottom line. If you already own Disk 

Care, skip the sequel unless you’ve got a new 

MacBook Pro. j.r. bookwalter

DupeZap 4
Get rid of of annoying duplicates
$19.99

Developer Hyperbolic Software, hyperbolicsoftware.com

requirements OS X 10.11 or later

Disk Care 2
Easy storage reclamation
$4.99

Developer It’s About Time, helloiat.com

requirements OS X 10.11 or later

DupeZap 4

  Very fast

  Very effective

   iTunes can find duplicates, too

  A little pricey

gooD 

Disk Care 2

  Mac storage space cleaner for eight data types

  Fast, straightforward, and easy to use

  Important items can be added to an exclusion list

   Offers little over macOS Sierra’s storage management

gooD 
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J
ust because something has been around 

a long time doesn’t necessarily mean it’s 

good. Case in point: Finder, the venerable 

Mac file manager which after more than 

three decades remains a core part of macOS 

experience, but which hasn’t really changed 

in its basic operation for most of that time. 

Although Finder isn’t likely to go away 

anytime soon, there’s always room for 

welcome improvement.

ForkLift 3 is a Mac app that serves 

double duty as a full-featured alternative to 

Finder, as well as a client for transferring files 

between local and remote FTP, WebDAV, 

Amazon S3, or other connections. ForkLift 

offers many advantages over Finder, not the 

least of which is the dual-pane interface that 

makes copying and moving files or folders 

between two different volumes a breeze. 

Like Finder, ForkLift also offers single-pane 

and tabbed window views as well.

To alleviate some of the complexity 

inherent in third-party file managers, 

ForkLift 3 introduces Quick Open, a mouse-

free feature invoked by pressing œ and 

then typing a few letters of the location 

or command you’re looking for. Keyboard 

jockeys will also embrace Quick Select, which 

intelligently prunes a large list of items by 

using a ç+S shortcut to select, add, 

or remove searched files and folders from 

the current selection.

Among our favorite new features are the 

ability to make quick revisions to text files 

directly in the right-hand preview pane — 

no text-editing app required! — and bulk-

rename files using a variety of prefixes, 

suffixes, padding, and sequential numbering 

options. This is a task we’ve traditionally 

relied on A Better File Rename to conquer, 

but having this functionality baked into 

ForkLift means less hopping between apps. 

Even better, you can save frequently used 

settings as a preset, which can be added to 

the sidebar for super-fast drag-and-drop 

access in the future.

ForkLift is also ready to serve when the 

app isn’t running courtesy of ForkLift Mini, 

a menu bar icon from which you can mount 

saved remote connections as desktop 

volumes, perform drag-and-drop transfers by 

opening droplets, and run saved “synclets” 

to synchronize files between local and remote 

targets. Finally, ForkLift now sports a slick 

optional dark mode, and overall feels much 

snappier than the previous version.

the bottom line. Faster and more 

versatile than ever, ForkLift 3 is a winning 

update to the premier Mac file manager 

and FTP client. J.R. bookwalteR

ForkLift 3
Heavy lifting for your file management
$29.95  manufacturer Binary Nights, binarynights.com

Requirements OS X 10.11.6 or later

ForkLiFt 3

   Quick open, select 
keyboard shortcuts

   Edit text directly 
in the preview pane

    Slick optional dark 
mode theme

   Weak documentation 
for many features

great 

>>>Reviews
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Narrow down your file 
and folder selections 
without putting a 
finger on the mouse.

Tough testing, trusted ratings
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Bear promises to be that rare thing: a writing 
and note-taking app that’s Zen enough to 
remove distractions, yet powerful enough 
to use every day for work.

Bear has a familiar three-panel layout. 
There’s a panel showing categories and tags 
on the left, the notes that match the selected 
category or tag in the next panel, and the 
currently selected document in the panel 
after that. You can show all panels or just 
stick to the editor window, and there’s a 
full-screen mode too. You can change the 
editor’s font, text size, and spacing, but if 
you stick with the free version you don’t get 
access to the rather attractive themes.

Bear is a very nice app to spend time in, 

although as with similarly minimalist editors 

you’ll need to know or learn the keyboard 

shortcuts. For example, to apply an H1 
heading style you need to press Alt+ç+1, 
to add a link is ç+K, and a list item is 
ç+L. You can also turn normal lists into 
checklists with a quick ç+t.

Once your muscle memory has mastered 
that, Bear is an exceptionally quick way to 
turn what’s in your head into structured 
documents. There’s a good information 
panel too, which tracks not just word and 

Bear
Does this app provide the – ahem – bare necessities?
Free (with in-app purchases)  Developer Shiny Frog, bear-writer.com

Requirements OS X 10.10 or later

bear

   Near effortless tagging 
and searching

  Inline images

   Limited export options 
without a Pro account

   No WordPress or 
Medium integration

solid 

character counts, but also the approximate 
reading time of your document. 

But things fall down in the free version 
when it comes to exporting: you have just 
two options, Rich Text or Markdown. The 
other options (PDF, JPEG, DOC, and HTML) 
require a Pro account, which is currently 
$14.99 per year or $1.49 per month. If you’re 
wondering why a text editor would want to 
export a JPEG image, it’s for putting text 
in places where you’re limited by character 
counts - Twitter, for example. Unlike rivals 
such as Ulysses, there isn’t any built-in 
support for WordPress or Medium blogs.

Pro also offers something else important: 
syncing between devices. Bear also comes as 
a very nice iOS app (see issue 124), and it uses 
CloudKit and Handoff to sync between your 
macOS and iOS devices, and to enable instant 
transfer from one device to another – so if 
you start work on your iPhone or iPad, you 
can pick up immediately on your Mac. So, 
though our chaotic cashflow means we prefer 
to buy apps outright, the Pro version’s great.

the bottom line. The free app is pretty 
good, but for serious work you’ll need to 
shell out for a Pro subscription. 
gaRy maRshall

Whether you work in  
full-screen or windowed 
mode, Bear looks great.

We particularly like the to-do features, which make it 
easy to track your tasks without any fuss.

>>>Reviews
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The general thinking behind picture-in-picture (PiP) makes 
sense: When viewing a video in Safari, you can click a 
button to free the thing from its web page confines. It’ll 
then continue playing above other windows, and can even 
be stashed as a tab at the side of the screen. The tiny snag: 
PiP doesn’t always work.

Videos using Safari’s standard player get a PiP button, 
but many others don’t. For example, YouTube’s player hides 
the PiP option in a menu that requires you to first ≈-click 
a video twice – not ideal. OverPicture tries to deal with this 
by adding a toolbar button and custom buttons to video 
playback bars. The thing is, that doesn’t always work either.

During testing, we tried OverPicture on a range of sites. 
Sometimes it worked fine. Most notably, it also welded a 
PiP button to YouTube’s playback toolbar, saving us from 
doing the aforementioned ≈-click dance. Unfortunately, 
OverPicture also semi-randomly demanded we “Pause and 
play the video to enable Picture-in-Picture.” This did 
indeed enable PiP to work, but it all felt a bit kludgy.

the bottom line. When it works, OverPicture is pretty 
useful – but it doesn’t always work. Craig grannell

Between Instapaper, Pocket, Pinboard, and a 

variety of RSS sources, Mac users wind up 

bouncing between multiple applications to get 

caught up with news subscriptions. ReadKit unites 

these disparate services under the same roof, 

providing a single destination for all your news.

In addition to those services, ReadKit includes 

its own offline RSS engine for new or imported 

OPML feeds, but also syncs with popular providers 

Feedly, Fever, NewsBlur, Feed Wrangler, and 

Feedbin. Some need a premium subscription to 

work, but free accounts are often okay.

The beauty of having everything under one 

roof is that you can drag and drop articles, 

bookmarks, or feed stories between different 

services with ease. Feeds are grouped by account 

in a sidebar, with a unified Smart Folders inbox 

that sorts unread content into predefined 

categories of your own choosing. There’s complete 

customization over everything, including the 

toolbar buttons, font style, and page width. There 

are four light/dark color themes, and full articles 

can be read in a clean, text-only view.

the bottom line. The one Mac reader to 

rule them all — but where’s the iOS version? 

J.r. bookwalter

OverPicture for Safari
Get the picture (if you’re lucky)
$0.99  Developer Pedro Jose Pereira Vieito, pvieito.com

requirements macOS 10.12 or later

ReadKit
The king of aggregators
$9.99  Developer Webin, readkitapp.com

requirements OS X 10.10 or later

OverPicture fOr Safari

  Adds a Picture in Picture button to YouTube

  Makes opening Picture in Picture faster…

   …when it works, which isn’t always

   Custom button absent from many sites

Okay 

readkit

  Customizable interface with four light/dark themes

   Smart Folders automatically sort content into categories

  Some services require a paid subscription

  No iOS version

excellent 

Tough testing, trusted ratings
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T
his endearingly compact Bluetooth speaker 

is not only weatherproof with an IP67 rating. 

This means it can withstand up to three feet 

of water for up to 30 minutes – it’s also mud-, 

snow-, and shockproof, too.

Its exterior looks just like every other 

waterproof speaker on the market, with its black 

cloth cover and big rubberized buttons. But also 

built into the speaker is a bungee cord that you 

can detach to mount it in various places. Fugoo 

demonstrates this feature by strapping the Go 

to the grill of a Hummer. You know, as you would.

On top of the speaker are volume buttons and 

the “action” button, which is used for features 

such as playing and pausing music, or answering 

phone calls. You can also press and hold the 

action button and the volume keys to select the 

next or previous track. A flap on the bottom of 

the speaker reveals the Micro-USB charging 

port. There’s no aux jack here, so don’t expect to 

be able to use the Fugoo Go with legacy devices. 

The speaker sounds good, but bass isn’t its 

strong suit. We found the sound signature to 

be relatively balanced, with energetic highs and 

lush mids which are perfect for vocal music and 

podcasts. Bass response is nice and tight, but 

the speaker just can’t create as much impact 

as we would have liked. Battery life is average 

with up to 10 hours of playback at 50% volume, 

according to Fugoo – and our tests found this 

to be pretty much the case.

One unique design aspect of the Fugoo Go 

is that you can lay the speaker flat on its back 

for 360-degree sound, or lay it on its side for 

a more directional listening experience. If you’re 

particularly flush, you can buy two and pair them 

for stereo performance.

the bottom line. The Fugoo Go packs 

above-par sound quality into a small, weather-

proof body. You can knock it around on a hike 

and not have to worry about. It’s imperfect, but 

the compromises are minor. lewis leong

Fugoo Go
A versatile, weatherproof speaker at an affordable price
$99  manufacturer Fugoo, fugoo.com

Features Bluetooth 4.2, Micro-USB charging, built-in li-ion battery, Dimensions 1.9x8.9x3.3 inches

Fugoo go

   Waterproof design 
and unique strap

   Syncs with a second 
speaker for stereo

    Great price-to-
performance ratio

   Lacks bass impact

great 
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Let’s be honest: Playing games on iOS can be a chore. 
It’s rare to find a game where your thumb doesn’t end up 
obscuring the action. Add in clumsy controls and you have 
a recipe for frustration.

Gamevice circumvents this issue completely – it’s a 
controller housing for your iPhone with physical buttons 
and joysticks. At the time of writing it was compatible with 
940 App Store games, including big names like Assassin’s 
Creed and Call of Duty, and more are promised.

In use, it works very well; there’s no noticeable latency 
and it feels firm and sturdy. It transforms gaming on iOS 
into an experience not unlike the Nintendo Switch. You 
can adjust the fit for your phone, and there’s a Lightning 
passthrough port and headphone jack too.

That Lightning port is a double-edged sword, though. 
The alternative (Bluetooth) may have presented its own 
set of issues, such as signal interference and high latency. 
But if Apple changes the connection in the future, you may 
find Gamevice no longer fits your next iPhone.

the bottom line. Far better than playing your iOS 
games with clumsy on-screen controls. Alex blAke

This drive has two features that are attractive 

if you deal with very large media files or have a 

high-end display setup: It sports a gigantic 10TB 

capacity, and two Thunderbolt 3 ports.

Such a fast connection to your Mac might 

seem wasted on a traditional disk. The point of it, 

though, lies in the second Thunderbolt 3 port, 

which enables you to daisychain another device 

– great news if you’re running short of places to 

plug things into your Mac, and that device can 

even be a 5K display.

LaCie quotes speeds of up to 240MB/sec. 

As ever, mean averages are lower: 220.7 and 

211.5MB/sec sequential read and write speeds 

respectively, and 108.and 95.1MB/sec when 

reading and writing randomly around the disk. 

The latter is likely to be a rare occurrence at this 

kind of capacity, though.

the bottom line. Sound performance, nice 

design, and tons of space. AlAn Stonebridge

Gamevice for iPhone
The iPhone’s Nintendo Switch?
$99.95  manufacturer Gamevice, gamevice.com

Features Lightning connector, 3.5mm headphone jack

LaCie d2 
Thunderbolt 3
Massive storage, small space
$639.99  manufacturer LaCie, lacie.com

Features 2x Thunderbolt 3, 1x USB 3.1 (Type-C)

Gamevice for iPhone

  Light and comfortable

  Powered by iPhone, so no battery needed

  Plenty of game support

   Expensive

Great 

Lacie d2 thunderboLt 3

  Plenty of connection choices

  Supports high-res displays

  Decent performance

   A backup strategy may be costly in itself

Great 

Tough testing, trusted ratings
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N
ight in the Woods opens with mysteries: 

Why did mae Borowski, a dark blue 

anthropomorphic cat with a ragged right 

ear, burn out of college? Why does she keep 

having nightmares? and who dropped 

something grisly outside the Clik-Clak Diner 

at the edge of town?

answering these questions requires 

spending plenty of time with (and as) mae, 

which isn’t always a pleasant proposition: 

She’s brash, naive, and feckless, with a knack 

for saying exactly the wrong thing to her 

eternally patient friends and family. Still, mae 

is incisively written and believable, and Night 

in the Woods draws its strength from her 

flaws and her redemption.  

Structurally, Night in the Woods operates 

on a day and night schedule, autumnal 

afternoons stretching into spooky dusk. 

Every morning, mae chats with her church 

receptionist mother before heading into town; 

when her hijinks are complete, she watches 

TV with her butcher father before bed. Then 

there are your friends: Gregg, a hyperactive 

fox who works at a bodega called the Snack 

Falcon, and Bea, a surly crocodile stuck 

running her father’s hardware store. Night in 

the Woods is hauntingly pretty and written 

with sharp, heartfelt dialog that both indulges 

mae and her friends’ sardonic imaginations, 

and captures her parents’ rural vernacular.

Night in the Woods’ pacing is languid and 

relaxed. Since mae has no job, she spends the 

bulk of her time exploring historic Possum 

Springs, an aging, deindustrialized 

appalachian town. mae wiles away the hours 

chatting with neighbors, putt-putt golfing, 

stargazing, getting into knife fights, playing 

bass guitar, feeding rats, and investigating 

local ghost stories. Rudimentary jumping and 

running help mae find Possum Springs’ most 

elusive nooks and crannies, but Night in the 

Woods is a narrative adventure at heart. 

The cumulative effect of these scenes and 

conversations is that mae starts to grow up 

as Possum Springs and its citizens become 

fully realized. It is, like so many others, a 

small town in decline, dotted with closed 

storefronts and haunted by abandoned 

mines and mills. Night in the Woods explores 

poverty honestly and earnestly, without ever 

feeling voyeuristic. Instead, it focuses on the 

personal: the Borowskis’ bad debt, mr. 

Santello’s deepening depression, the doe 

working nights at the video rental so that 

her mother can watch her newborn. 

Night in the Woods’ strong suits are its 

dialog and characterization, but it falters 

by cramming too much of its whodunit into 

the last quarter, often through exposition. 

The day-night cycle is partly to blame, too: 

speaking to each character every day 

eventually feels like a chore, even when it 

leads to a funny quip or poignant anecdote. 

The relative lack of action may also grate.

the bottom line. Funny, nostalgic, and 

melancholy, Night in the Woods is a coming 

of age story that recognizes that “of age” is 

a more nebulous and precarious concept than 

it was a generation ago. Joseph leray

Night in the Woods
Like it or not, darkness is coming
$19.99  Developer Infinite Fall, nightinthewoods.com

requirements OS X 10.8 or later

Night iN 
the Woods

   Sharp dialog and 
memorable characters

   Bright, rich 
art direction

   Plot takes too long 
to get started

   Platforming is rare, 
but wonky

great 

Tough testing, trusted ratings
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ast issue we looked at the huge 
explosion in sales of security 
cameras, which are now far and 
away the most popular products 

in the entire smart home category.
But while a security camera is the ideal 

starting point for your home security system, 
even the most advanced models have their 
limitations. A camera can only look out for 
activity in one specific room or location, and 
even cameras that have a night-vision mode 
can only see things a few yards away once it 
gets really dark.

You could, of course, buy additional cameras 
to cover other areas – but with high-quality 
models costing $120-$200 each, that can quickly 
turn out to be very expensive.

Fortunately, cameras aren’t the only security 
option available for the smart home. Once 
you’ve got a camera, you might also purchase 
a number of other security devices, such as 
motion sensors that can detect movement 

even in dark rooms, or contact sensors that can 
tell when a door or window has been opened.

As well as helping to monitor areas that might 
not be easily visible to a camera, these sensors 
are generally a lot cheaper, so you can buy 
several to cover different rooms around your 
home. Like a security camera, a motion sensor 
or contact sensor can connect to your home 
Wi-Fi network and send an alert to an app on 
your iPhone if it detects any suspicious activity.

it’s all connected

While you can generally buy any camera and 
quickly set it up to work with your iPhone, these 
other types of security sensors rarely just work 
on their own. In most cases they are specifically 
designed to work in conjunction with other 
devices made by the same manufacturer.

If you own Netatmo’s popular Welcome 
camera ($199), you can use that to control 
additional “tags” that monitor doors and 
windows (and also the company’s forthcoming 

> get started with…

Security cameras are increasingly popular, 
but you can expand your home security 
system with these affordable sensors

L

By cliFF JosePh

Better living through smarter technology

home liFe
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Security Siren). The tags are well priced – just $99 
for a pack of three – but they don’t work on their 
own, so you do have to budget for the Welcome 
camera as well. 

When you’re starting from scratch, the cheapest 
option is probably to buy a starter kit that includes 
a number of different security devices. Panasonic 
really goes to town here, offering a range of kits 
that contain different combinations of security 
cameras, sensors and sirens. Prices start at $200 
for a basic kit with two cameras and a hub.

Samsung takes a different approach with its 
SmartThings Home Monitoring Kit ($249). The kit 
doesn’t include a camera, opting instead for a 
central hub, two multipurpose sensors, a motion 

D-Link’s Omna 180 
camera supports 
Apple’s HomeKit. 

Motion sensors are 
ideal for entry points.

sensor, and one SmartThings outlet. The latter can 
be used to plug in non-smart devices – a dumb old 
table lamp, for instance – and control it via the 
capabilities of the Smart Kit. The multipurpose 
sensors, meanwhile, really are that: They can detect 
vibration, orientation and angle, temperature, and 
when things open or close. In short, if something 
changes in your home, it’ll know about it and can 
alert you accordingly.

 If you do want a camera, the SmartThings kit can 
be used to control Samsung’s separate SmartCam 
HD Pro ($139). Samsung has also done a good job 
of working with other companies – pay attention, 
Apple! – to make its products compatible with 
SmartThings. There are security cameras from 
both Netgear and D-Link that will work with the 
SmartThings kit, along with some of the latest 
smart locks from Yale, Philips’ Hue lights, and 
even multiroom speaker systems from Bose.

mix and match

Regardless of manufacturer, one thing these kits 
have in common is the inclusion of a central control 
hub that connects to your home router and links 
the different security devices together. Once you 
have the hub set up you can extend your home 
security system by purchasing additional sensors –  
typically for $30-50 each – and Samsung, D-Link, 
and Panasonic all provide a good selection of 
add-on sensors, including motion and contact 
sensors, sirens, and also smoke and water detectors 
that can provide additional protection against 
floods and fire.

The odd one out here is Elgato, with its Eve 
Motion ($50) and Eve Door & Window ($40) sensors. 
These are affordably priced and – unlike most of 
their rivals – they don’t require you to buy a 
separate control hub from Elgato in order to use 
them. The catch here is that they only work with 

>>>Home Life
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Door and window 
sensors tell you 
when your home 
has been entered.

Apple’s HomeKit platform, and for remote access 
and notifications you need to have an Apple TV or 
iPad configured as your ‘home hub’ – see support.
apple.com/HT207057 for instructions.

While a third-generation or later Apple TV 
enables remote access to HomeKit accessories, 
you’ll need the latest, fourth-generation model 
if you want the ability to automate your devices. 
That brings extra security benefits, of course, 
such as the ability to turn on a light after sunset.

So, while a security camera is still the best place 
to start, there are plenty of options available that 
enable you to extend your security system to cover 
key rooms and locations around your home, even 
on a quite modest budget. 

s a m s u n g  h a s 

w o r k e d  w i t h  ot h e r 

c o m Pa n i e s  to  m a k e 

t h e i r  P r o d u c t s 

c o m Pat i B l e  w i t h  i t s 

s m a r t t h i n g s  r a n g e

o n e  t h i n g  m a n y  s ta r t e r 

k i t s  h av e  i n  c o m m o n  i s 

t h e  i n c lu s i o n  o F  a 

c e n t r a l  c o n t r o l  h u B
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Get started with home security with these suggestions

netatmo tags

$99

netatmo.com

> These contact sensors 

provide a quick and easy 

way of extending the 

Netatmo Welcome security 

system. You need the 

Welcome camera in order 

to control the tags, but 

three tags for a hundred 

bucks means you can 

cover a number of 

locations in your home 

fairly inexpensively.

1 2 3 4
samsung 

smartthings 

home monitoring kit 

$249

samsung.com

> Samsung’s starter pack 

provides motion, contact, 

and multipurpose sensors, 

plus a smart plug. You can 

add the SmartCam HD Pro 

as an extra, and the kit 

works with some other 

manufacturers’ products, 

so it’s a good option for 

mix-and-match security.

d-link omna 180

$200

dlink.com

> The Omna 180 supports 

Apple’s HomeKit platform. 

As well as providing 1080p 

resolution, night vision, 

and a 180-degree wide-

angle lens, the camera can 

be used to control other 

HomeKit-compatible 

devices, such as Philips 

Hue light bulbs or the 

various sensors in 

Elgato’s Eve range.

Panasonic smart 

home monitoring 

system 

$68

panasonic.com

> This bundle of smart 

devices includes two 

window/door sensors, a 

motion sensor, a smart 

plug, and the hub unit. 

There’s an iOS app 

available, though the kit 

also includes a “remote 

control” handset, which 

can be used as a phone.

 Five oF 
the Best

>>>Home Life
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yale linus

$tBC

yalehome.com 

> This new secure, key-free 

lock from Yale – due in the 

first half of the year – is a 

coproduction with Nest, 

and works with its range 

of devices should you own 

any of them. Using your 

iPhone, you can lock and 

unlock your doors, give 

guests passcodes, and see 

who’s coming and going at 

any point.

5

M
y husBand and I have 
been using the Find My 
Friends app on our iOS 
devices for a while, mainly 

in the way that a coastguard 
might throw a life ring to a 
drowning swimmer. Notification: 
Christopher Phin left Work 2m. 
Help is on its way, harassed 
co-parent! Switch on Teletubbies 
and await rescue! Open your own 
beer first before helping others 
with theirs!

But now my actual friends have 
started asking to share locations 
on Find My Friends, I’ve found it 
to be a meddlesome tattletale 
that is undermining me in the 
eyes of more organized humans. 

No longer can I claim to be stuck 
in traffic when I’m actually in 
my bedroom frantically chasing 
contact lenses around my 
eyeballs. I can’t pretend to be out 
of town when someone needs 
help moving a couch or washing 
a dog. Worse, my mom knows if 
I’ve taken my kid to the torturous 
Mommy & Me Dance Class she 
insists on paying for, or if I’ve 
skipped out and blown all five 
dollars on Starbucks and crayons. 
Nightmare. I know what you’re 
thinking: Why doesn’t she switch 
her phone off? The very idea of 
doing that brings me out in a cold 
sweat. Or maybe you’re thinking 
how does this woman have any 
friends left? And frankly I wonder 
that too.

i guess i should appreciate that 
Find My Friends is making me a 
better, more responsible person. 
I have to suck it up, go jogging, 
move couches, and pet-sit angry 
cats. Plus, the kid and I are really 
good dancers now.

Find My Friends works both ways, 
JenniFer Phin has realised

>smart home living 
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As any seasoned parent will tell 
you, keeping the little ones 
entertained can be a full-time job. 

Thankfully, there are plenty of Apple TV apps 
designed for this very purpose, and one of the 
latest is Baby Genius TV, which kicks off this 
issue’s all streaming-video app lineup.

With plenty of nursery rhymes and animated 
fun to sing, dance, and learn from, Baby Genius 
is about as straightforward as you can get. 
Choose from all-time favorite videos or enjoy 
curated categories like Animal Rhymes, 
Kindergarten Special, Baby Animal Songs, 
or Mozart and Friends.

Most of the videos are kid-friendly length 
(just a few minutes long), but there are also 
collections that last a half hour or more, perfect 
for when parents need to keep youngsters 
entertained while they get other things done 
around the house. The app is free with no ads, 
but video is mostly SD. J.R. BookwalteR

Baby Genius TV
Sing, dance, learn
Free

Elmedia Player
No conversions necessary
Free

Don’t waste time fiddling about with file formats – just fire up Elmedia 
Player and blast all your video files to your Apple TV with no stress.

There’s not much HD content here, but your little ones 
will be having too much fun to notice that.

Have a collection 

of MKV or AVI 

videos you’d like 

to watch on Apple TV? 

Normally playback of those file 

types isn’t supported, but the 

free Elmedia Player enables 

this straight from your Mac, 

Windows, or Linux computer 

using SMB file sharing.

Based on the popular media 

desktop software, Elmedia 

Player supports all video and 

audio file types without 

conversion, and can also play 

music or photos as well. With 

adjustable playback speed, 

built-in or external subtitle 

support, and options to 

improve video image quality, 

this is a great way to enjoy 

your typically unsupported 

media on the big screen. 

Playback is lightning fast, and 

you can easily jump 10 seconds 

either way with a press on the 

edge of the remote’s touchpad.

Best of all, Elmedia Player 

works great with NAS servers 

— we were streaming movies 

and TV shows buffer-free 

within minutes. The app also 

works well for photos, which 

can be displayed in random 

order or as a slideshow, with 

full control over the length 

and transition of each image. 

J.R. BookwalteR

>>>Home Life

The laTesT tvOs apps and The hOTTesT hardware

apple Tv

88   may 2017  maclife.com



Your phone can probably record HD video 
for Facebook, so why not watch it in style?

More Fox than you can handle, not to mention 
a helping of National Geographic.

Sony BRavia XBR-X900e

$1,699.99 (55-INcH)  SoNy.coM

If you’ve got to have the very 
latest tech, Sony’s 2017 line 
kicks off with this series of 

Android-TV-powered 49-, 55-, 
65-, and 75-inch direct LED 

backlit models that offer 
elegant design, excellent 

motion handling, and clear 
audio. However, we bet you 

still won’t like the rubberized 
remote control.

FlaShmen hDmi to RCa 

av ConveRteR

$16.99  AMAzoN.coM

Apple TV is awesome – until 
you need to plug it into an 
older television without an 

HDMI port. This handy little 
converter takes a 1080p HD 

signal and makes it compatible 
with RCA jacks in NTSC or 
Euro-friendly PAL format. 

There’s composite video and 
stereo audio output, too.

Make the most of 
home entertainmentWatching Facebook 

videos on a tiny 

smartphone screen can 

be a real drag. It was inevitable that 

the top dog in the social media kennel 

would eventually land on Apple TV, 

and that day has finally arrived with 

Facebook Video.

Installed with version 84.0 of the 

Facebook ioS app, this TV edition is 

all about videos you’ve shared on the 

service, as well as what’s been shared 

by friends and those you follow. There’s 

also a Top Live Videos section on the 

Home menu to get caught up on stuff 

you might have missed. our favorite 

part is being able to revisit recently 

watched content from other devices 

on the big screen, sequestered in the 

comfort of our couch. The app’s also a 

great way to relive previously shared 

videos you might have forgotten about. 

J.R. BookwalteR

one downside of cutting 

the cable television cord 

is having to download 

multiple apps just to enjoy favorite TV 

shows. Apparently realizing what a 

nuisance this has become, the Fox 

network improves things with the latest 

release of its Fox Now app.

Although you’ll still need to log in 

with a supported cable or streaming 

provider like DirecTV Now, a single app 

now combines content from Fox, FX, 

FXX, and National Geographic channel 

under one roof, with a unique home 

screen that makes it easy to jump 

between each one. Naturally, you can 

still search for specific shows or catch 

up on old favorites, as well as tune in to 

live prime-time shows. It’s also easy to 

find something to watch by genre, and 

plenty of Hollywood movies, courtesy 

of FX. Best of all, there’s a good supply 

of free content. J.R. BookwalteR

Facebook Video
you’re the star
Free

Fox Now
Four channels, one app
Free

Better living through smarter tech
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For products like JetDrive Lite, ensure you 
buy the right version to fit your MacBook.

There are probably three interlinked 

issues: macOS’s system font, which 

many find too thin to show sufficient 

contrast against white; font size, which 

forces most elements in glyphs to be a 

pixel thick; and the actual blackness of 

display black.

Ruling the third out is easiest to do. 

Find a matte surface that appears fully 

black, and compare it against a black 

rectangle on the display. If the latter 

only appears dark gray, your Mac has 

a display problem. You can confirm 

that by setting it against a known good 

the extreme of using its Zoom feature, 

which brings its own costs.

Important adjuncts to this include 

the adjustment of ambient lighting to 

suffuse and attenuate incoming 

sources of daylight and artificial light, 

and, whenever possible, using a good 

external display, which should deliver 

better resolution and contrast.

Mo’ memory
Can I upgrade my 2013, 21.5-inch 

iMac’s memory?

The memory in your Mac can be 

boosted to a maximum of 16GB, but 

late 2012, 2013, and mid-2014 21.5-inch 

iMacs can only be upgraded by an 

Apple Store or Authorized Service 

Provider. Most other models have user-

replaceable memory; in late 2015 21.5-

inch iMacs, it isn’t upgradeable at all.

What’s the best way to 
free up storage on my Mac?
My 2011 MacBook Pro, with a 320GB 

drive, is running out of space. Much 

of its storage is being taken up by 

music and movies. Can I move them 

to an external drive, or put them in 

the cloud?

Apple provides storage as part of 

iCloud, but to free up a lot of space on 

your Mac, you’ll have to rent more on 

iCloud – you get 5GB for at no cost, 

and if you want more, you’ll incur a 

monthly charge. You can have up to 

2TB of iCloud storage – see apple.

co/1Ak2DSW for pricing.

For movies and TV shows bought 

from the iTunes Store, it’s simplest to 

stop storing them locally. You’ll only 

want to watch one or two movies in 

the next day or so; leave those on your 

The Accessibility pane’s Display preferences can’t increase the contrast between black and white, 
so they’re not going to be of any help if you’re struggling to read text.

Most of the time, the contrast on my 2012, 15-inch MacBook 
Pro is insufficient for reasonable reading. I’ve tried adjusting 
the display’s contrast along with Accessibility settings to no 
avail. Is there any other way of making the system characters 
darker so that they contrast better?

what’s uP wIth My text?

display. If you can’t correct that using 

the Calibrate feature in the Displays 

pane’s Color tab, there may be a 

problem in the graphics processor 

or – more likely in an older Mac – 

the display itself.

The other two things can be 

checked in a text-oriented app by 

comparing different fonts and sizes 

against the system font. Unfortunately, 

many people who experience similar 

problems don’t find the Accessibility 

pane’s tools to be much help in 

addressing them, unless they go to 

TECH SUPPORT & TECHSPLANATIONS
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Mac, and remove all other movies and 

TV shows – you can redownload them 

later on anyway.

In iTunes, select a movie that’s 

stored locally, then choose Movie > 

Remove Download. To watch it, you’ll 

need to download it again, but it 

remains available and costs nothing 

extra to redownload (unless your ISP 

charges for heavy bandwidth usage). 

Do this for TV shows and other large 

content, such as iOS apps which you’ve 

downloaded through iTunes.

You could move your iTunes Library 

to an external drive, but it’ll only be 

available when that’s connected. 

Consider adding a special SD card that 

fits entirely in the SDXC slot. Be wary 

of using apps that claim to “clean up” 

storage, though a tool like DaisyDisk 

($9.99, daisydiskapp.com) can help 

identify what you might offload to 

such SD storage.

Not up to scratch
how can I remove a scratch from 

my iMac’s display?

Scratch repair kits either have no 

effect or may even make the mark 

more noticeable. If the scratch is bad 

enough to warrant replacing the glass 

panel, it’ll cost upwards of $80 to do 

so, or even more if you get it done 

through Apple.

Documents is missing 
from my sidebar
the Documents folder in my Finder’s 

sidebar suddenly disappeared. It’s 

still selected in Finder’s preferences, 

and I’ve restarted my Mac. how can 

I put the folder back in the sidebar?

First check that your Documents 

folder is still where it should be. Switch 

to Finder and then press ß+ç+H; 

If it has inadvertently been moved or 

renamed somehow, you’ll need to put 

it back at the top level of your Home 

folder and correct its name. Or, if 

you’ve used Sierra’s option of putting 

the Desktop and Documents folders in 

iCloud Drive, the two folders should be 

at the top level of that instead.

This problem may have arisen 

because the file that contains Finder’s 

preferences has become corrupted. 

Switch to Finder, hold Alt and choose 

Go > Library, and then look in the 

Preferences folder there for a file 

named com.apple.finder.plist. Move it 

to another location, perhaps inside 

I’ve been given a late 

2012 Mac mini server. 

Can I replace one of its 

hard drives with an ssD?

yes, although doing it 

yourself is a moderately 

difficult task as it requires 

some disassembly, which 

can prove cumbersome. 

you’ll need to remove its 

memory modules, fan, 

and Wi-Fi aerial before 

you reach the first drive. 

Several online videos 

demo this – for example, 

see bit.ly/2l2rt3T.

you’ll need a 2.5-inch 

SSD with a SATA-III 

(6Gbps) connector. The 

drive doesn’t have a 

separate sled or mount 

within the Mac, but takes 

two small mounting bolts 

which you must transfer 

from the side of the old 

drive to the new one. 

A trained Mac service 

engineer should be able 

to do this for you in just 

a few minutes.

Once done, start up the 

Mac from a USB drive 

with the Sierra installer 

on it (refer to apple.co/ 

1EkHpPy). Restoring 

directly from a backup to 

the SSD may cause older 

OS X versions to see it as 

a broken Fusion Drive, and 

this can brick the SSD, so 

a fresh install and then 

restoring files from your 

backups is best.

> Can I add an SSD to my Mac mini?

your Documents folder, then log out of 

your user account and back in again, 

or restart your Mac. Afterwards, you’ll 

need to set up all of your Finder 

preferences from scratch, but you may 

find the Documents folder appears 

properly in the sidebar again.

One final trick which may be worth 

trying is starting up in safe mode (see 

apple.co/1X4HkKy). This flushes many 

system caches, and if nothing else has 

helped, it may get the Finder’s sidebar 

working properly again.

Hi, Sierra?
Is it possible to run sierra on 

a 2008 MacBook?

The App Store might offer it, but 

your Mac won’t install it. There’s an 

unofficial patch to force it (refer to 
Finder settings that won’t persist may 
mean its preferences file is damaged.

Tech Support & Techsplanations
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Interpreting DriveDx’s results 
in terms of expected SSD 
lifetime is not easy.

The Versions feature in macOS is invaluable 
for recovering small portions of work.

(bit.ly/2kZzDgK), but due to Sierra’s 

lack of support for certain older 

components, we don’t recommend 

using it.

Is my Fusion Drive failing?
My iMac has an apple Fusion drive, 

which I’ve checked using DriveDx. 

the wear Leveling Count on its sDD 

part has fallen below 50%, although 

it’s little more than a year old. Is my 

ssD failing?

There are difficulties in estimating 

the life expectancy of SSDs. The 

SMART indicator of Wear Leveling 

Count should indicate lifetime, but 

some SSDs don’t give accurate values, 

or don’t change linearly over time.

Another way to check whether the 

SSD is wearing out is to look at the 

total data written to it, reported as 

Host Writes MiB. Most third-party 

manufacturers provide a figure of 

maximum Terabytes Written beyond 

which the warranty is no longer valid 

(and above which the drive is more 

likely to fail); for example, Samsung’s 

120GB 850 Evo quotes 75TBW.

important, if not essential, when using 

a public Wi-Fi network. Although the 

HTTPS protocol used on the internet 

is still secure, plain HTTP connections 

could readily be intercepted by others, 

and that may enable someone to view 

sensitive info going between your 

device and the internet.

There’s a file missing 
from my backup
when I deleted a column in an 

important Numbers spreadsheet by 

mistake, I went to time Machine to 

find a backup. I stepped back a 

month to when I know it was last 

correct, but couldn’t find the file 

there. More recently it has been 

saved to iCloud, but I can’t find any 

older versions there either. how can 

I get my old version of this Numbers 

spreadsheet back?

In Numbers, open the copy of the 

document that’s now stored in iCloud, 

then choose File > Revert To > Browse 

All Versions – and don’t worry; the 

objective here isn’t to roll back the 

whole document to an older version.

The app’s interface will switch to a 

Time Machine-like interface, with the 

document’s current version on the left 

and previous ones on the right. You 

should find that when you moved the 

document to iCloud, its version history 

was carried over, too; go back through 

the versions on the right to the time 

when the column would last have been 

in the document.

Click the window on the right side to 

take a closer look at its contents. If you 

can find a version that contains the 

Apple, however, doesn’t supply 

these figures for its Fusion Drives, 

and also doesn’t put much trust in 

third-party monitors such as DriveDx, 

despite their sophistication and value, 

preferring its own hardware testing 

tools and those built into Apple 

Diagnostics or Apple Hardware Test.

If you experience errors with your 

SSD, invoke any remaining warranty 

or AppleCare in the hope that it results 

in a replacement.

Power’s out
where have the power management 

settings gone?

They’ve moved around in minor 

Sierra updates. As of 10.12.3, active 

settings are in /Library/Preferences/

com.apple.PowerManagement.[UUID].

plist. The figures in “[UUID]” are 

unique to your Mac, and listed under 

Power in System Information.

A private matter
when should I use VPN on my iPad?

Virtual private networking uses an 

encrypted connection, which is 

>>>Ask
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In macos sierra, I have 

set up substitutions in 

the text tab of system 

Preferences’ keyboard 

pane, which correct most 

of my common errors, 

such as typing “hte” 

instead of “the.” some of 

them only work for a day 

or so before they become 

disabled, and I have to 

enter them again. what 

am I doing wrong?

These aren’t stored in 

a Preferences file, but 

in your user dictionary, 

which is a closed 

database. you can save 

them all to a file by 

selecting all and dragging 

them to a folder in Finder. 

you could quickly add 

them back by dragging 

and dropping that file into 

the shortcuts list, but 

that‘s unlikely to make 

them persist.

One potential issue that 

could be causing those 

settings to change is the 

use of a third-party app 

that also performs text 

substitution or similar 

functions. If you’re certain 

that you have no such 

conflicting software 

installed and running in 

the background, try to 

remove all text 

substitutions and then 

leave the Keyboard pane. 

Open it again, and add the 

substitutions you want. 

Hopefully, that should 

flush out the problem 

for good.

> Transient text substitutions

now-absent column, interact with 

Numbers’ window on the right side 

just as you would on the desktop; click 

the table, then click the header of the 

column you want and press ç+C to 

copy it to the Clipboard.

Next, click the window for the 

current version, add a new column – 

as the menu bar is unavailable here, 

you can do this by selecting another 

column and pressing Alt+‘ to add 

one to the right of it – then select the 

new column and press ç+v to paste 

the Clipboard’s contents over it.

Shut it down
why can’t my uPs shut down 

my MacBook Pro?

In the Energy Saver pane, an 

uninterruptible power supply, or 

UPS, connected using USB can be 

set to shut down a desktop Mac 

automatically after mains power 

outage. macOS doesn’t support 

automatic shutdown of MacBooks in 

the same situation, as they can switch 

to their internal battery for power.

Why does AirPlay Mirroring 
keep dropping out?
My iPhone 7 Plus keeps dropping 

out when trying to use airPlay 

Mirroring. I have a good internet 

connection, have updated to the 

latest versions of ios and tvos, 

turned off background app refresh, 

and tried resetting the apple tV 

and iPhone. how can I stop these 

annoying dropouts?

First determine whether this only 

affects incoming content from the 

internet, or all content streamed to 

your Apple TV. If it doesn’t affect 

locally stored content, then it’s 

probably an issue with your internet 

connection, which may prove hard to 

fix. For example, there may be 

technical reasons for periodic dropouts 

that only your ISP can remedy.

If this is a local problem, work 

through Apple’s recommended setup 

for your wireless router, detailed at 

apple.co/2lSpgHw. Because some 

routers can encounter issues when 

routing between local wired and 

wireless connections, it can sometimes 

help to use a wireless connection 

between your Apple TV and your 

router; other routers may work better 

on a wired Ethernet connection. It pays 

to experiment with the best setup for 

your own situation.

Wireless interference is another 

possible cause, and Apple has helpful 

suggestions for dealing with that at 

the above link. Sometimes, separating 

out your Wi-Fi connections can be 

beneficial. Name your 2.4 and 5GHz 

networks differently; put your Apple 

TV and iPhone on the latter, and other 

devices on the former. Even then, you 

may need to wait for a software update 

for a complete fix.
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Apple’s Touch BAr 
technology puts context-
sensitive controls at the top of 
the keyboard, to save you time 

digging around in menus and windows to 
find the commands you need. Currently, 
the only official way to get a Touch Bar is 
to buy a MacBook Pro, and even if Apple 
were to update its Bluetooth-connected 
Magic Keyboard to include one, it’s 
unlikely to be affordable given 
the existing model costs $99.

However, you can add a Touch Bar to 
your existing Mac by adding an iPad and 
third-party software into the mix. If you 
don’t have an iPad there’s an app that 
enables you to see what the Mac’s latest 
control method would add to your apps 
if you were to upgrade.

Be aware, though, there’s one aspect 
of the real thing that you can’t replicate 
using the following methods: a Touch ID 
sensor for unlocking your Mac, validating 
payments online, waking your Mac, and 
more. (A real Touch Bar has a combined 
Touch ID sensor and power button at its 

right end.) That said, there 
are other ways to imitate 
some of the sensor’s 
benefits; MacID ($3.99, 
macid.co) enables you to 
unlock your Mac using the 
Touch ID sensor on your 
iPhone or iPad.

However, the bigger 
bonus of having a Touch 
Bar to hand is the range of 
time-saving shortcuts it 

Make your own Touch Bar
Discover benefits of Apple’s input innovation and transform your iPad

provides in apps bundled with macOS, as 
well as a growing number of third-party 
ones, which includes OmniGraffle 7, 
1Password, and Mail Designer Pro 3.

If you have a Mac with a built-in Touch 
Bar, don’t assume these pages are 
irrelevant to you; whether you’re using 
the real deal or an iPad as a stand-in, 
you’ll find tips later on how to tailor the 
bar’s contents and ensure you’re getting 
the most from it.

Try iT ouT for free

Any Mac that’s running macOS Sierra 
10.12.2 or higher is silently generating 
the content that would be displayed on 
a Touch Bar if one were present, it just 
doesn’t have anywhere to show it. Also, 
macOS knows how that content should 
behave if you had a way to interact with 
it – which you can, thanks to a couple of 
third-party tools that use that internal 
model to mimic a real Touch Bar.

The quickest way to see what a Touch 
Bar would offer you is Touché, a free 
utility from Red Sweater Software (red-
sweater.com/touche) that renders 
macOS’s internal model of the bar in a 
window. The app isn’t simply a dumb 
display of that content, though; where 
you would tap or swipe controls on a real 
Touch Bar, you can click or drag them on 
Touché’s window to get the same effects.

This doesn’t give you a true feel for the 
real thing, of course, but it’s a good way 
to investigate the shortcuts your favorite 
apps would provide, if they were given 
the right hardware.

REQUIRES
An iPad with iOS 7 or later, 

a Mac with OS X 10.9 or 
later, Duet Display

yoU wIll lEaRn
How to see what a real 

Touch Bar would offer you, 
and how to use your iPad 

as one

IT wIll TaKE
20 minutes

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD
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Get Touché, unpack the archive, move 
the app to the Applications folder, then 
open it. You can place Touché’s window 
where you want – near the bottom of the 
primary display is probably best.

When Touché is running, macOS will 
reveal customization options for the 
Touch Bar in System Preferences and 
compatible apps, which we’ll discuss 
later in the tutorial.

The BeTTer (BuT pAid) opTion

For an experience closer to a real Touch 
Bar, you’ll need an iPad, its USB cable, 
and Duet Display ($20, duetdisplay.com). 
We’ve talked about this app before, when 
we discussed its main purpose: extending 
a Mac’s desktop onto an iOS device.

Duet for Mac and iOS enable the app to 
render the Touch Bar at the bottom of 
your iPad’s screen, covering up a little 
strip across the bottom of the extended 
desktop. With your iPad propped up 
behind your keyboard – ideally a low-
profile one, such as the Magic Keyboard 
– you end up with a rough but usable 
approximation of a real Touch Bar.

Depending on the arrangement  
of your desk – say, if your primary display 

is raised high enough that your iPad 
doesn’t obscure your view of it – this has 
the added advantage of giving you more 
space on which to stash apps you glance 
at only occasionally.

cusToMize your Touch BAr

By default, the Touch Bar displays 
contextual app controls on its left side 
and across most of its width, and a 
shortened Control Strip of system-wide 
controls towards its right end. Tapping 
the arrow at the left of the Control Strip 
expands it temporarily, filling the bar 
with additional items that appear in the 
top row of a regular Mac keyboard.

You won’t need these with Touché or 
Duet Display because you already have 
real keys for this purpose, but you can 
change the Control Strip’s contents to 
include other shortcuts that usually 
require multi-key combinations which 
you may have trouble remembering.

For instance, we particularly like the 
single-key shortcuts for locking the 
screen, putting the Mac to sleep, or taking 
a screenshot. The latter of these even 
offers the ability to open screenshots in 
Preview immediately, or to file them in 

 
JaRGon BUSTER

The Control Strip is also 
the name of a similar 
on-screen set of system 
controls that appeared 
on classic Macs back in 
the 1990s.

Quick look Duet Display’s interface

DUET DISplay’S 
mEnU BaR Icon

This icon tells you Duet is 
running. It’s dimmed if the 

app can’t find your iPad.

DUET DISplay’S 
pREfEREncES
Click this cog to access 
Duet’s preferences, 
including which GPU is 
used (if you have two).

confIRm ThE 
connEcTIon

With your iPad connected 
over USB, Duet’s icon goes 
darker and its menu shows 

the iPad’s name.

VIDEo QUalITy 
SETTInGS
Put the pointer over your 
iPad’s name to access 
settings such as display 
resolution and frame rate.

How to do anything on your Mac, iPhone & iPad
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the Documents folder instead of on the 
Desktop, which is useful.

In the walkthrough below, you’ll learn 
how to customize what your Touch Bar 
displays by default and when you hold ƒ, 
and how to alter the Control Strip’s 
contents. You can tailor the Touch Bar in 
more ways, too; some apps that support it 
enable you to pick which of their controls 
are pinned to it.

So, in Safari you can add controls to add 
a bookmark, open the Share menu so you 
can use the arrow keys to choose from it 
(rather than having to reach for your 
mouse or trackpad), or view the current 

page in Reader mode. Look for a 
Customize Touch Bar item in an app’s 
View menu. While customizing the bar, 
note the “Show typing suggestions” 
checkbox; clear it if you don’t want 
predictive text suggestions, like those 
on an iPhone, to appear in the bar. 

There’s one thing to beware of when 
using Duet Display: On a Mac that already 
had a secondary display, we found Duet’s 
Touch Bar would sometimes appear blank. 
Disconnecting the existing secondary 
display resolved this, so you should find 
Duet works fine if your Mac currently has 
just the one display. AlAn sToneBridge

 
GEnIUS TIp

As well as settings 
for an energy-efficient 

connection, look in Duet’s 
preferences for an item 

that turns off macOS’s 
transparency effects 
while Duet is in use.

Get started 
Install Duet Display on your Mac 

and iPad and open both versions – it 

should detect your iPad. To show the 

Touch Bar on your iPad, click Duet’s 

menu bar icon, put the pointer over your 

iPad’s name, and click Touchbar Enabled.

Change Control Strip
At the bottom right of the 

Keyboard tab, click Customize Control 

Strip to see items you can add, including 

some that aren’t used by default; those 

shown differ based on whether the strip 

is in its compact or expanded form.

Set bar contents
Go to System Preferences’ 

Keyboard pane. Click the “Touch Bar 

shows” pop-up menu: the bar can show 

contextual app controls and a compact 

Control Strip, only app controls, or the 

expanded Control Strip.

alter expanded form
Drag a control from the selection 

shown on the main display and move it 

over the screen’s bottom edge so it 

appears, highlighted blue, on the Touch 

Bar, drag left or right till it’s in the 

position where you want it, then let go.

Set other contents
Holding ƒ usually shows 

numbered function keys in the Touch Bar. 

To change this, use the “Press Fn key to” 

pop-up to set this to show the expanded 

Control Strip or App Controls; what’s 

offered depends on your choice in step 1.

Rearrange items
To rearrange Touch Bar items, 

move the pointer over the bottom edge 

of the main display (without dragging 

anything). One bar item (or group) is 

highlighted: move left or right to choose 

the one to move, then drag it left or right.

how To Customize the Touch Bar’s contents

>>>Create
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LittLe FLocker is designed 
to keep the data on your Mac 
safe from a whole range of 
nasties including malware, 

trojans, backdoors, and badly behaved 
apps that try to access files or features 
they shouldn’t. As well as protecting files, 
it can force apps to ask you before they 
access your Mac’s mic or webcam, for 
example. It also ensures apps get explicit 
permission to install startup items, take 
control of other apps, or eavesdrop on 
your internet connection. 

Little Flockr makes it clear to you when 
your mic or webcam is in use, or when an 
app is intercepting clicks or keyboard 
strokes – thus keeping you safe from 
keyboard logging tools. And, importantly, 
it will help prevent malware from taking 
control of other apps or running from 
your user account’s Home folder.

remove malware with ease
Police apps’ access to your files and your Mac’s mic and webcam

Is there a downside? Only if you’re put 
off by a steep learning curve, or by dialog 
boxes popping up every time a threat is 
detected or permission is required. If 
those are an issue, you’ll have to decide 
for yourself whether the effort and 
inconvenience is worth the additional 
layer of security.

The learning curve can be flattened by 
using Simple Mode, which replaces Little 
Flocker’s detailed list of settings and 
configuration options with a much 
simpler interface. Simple Mode is active 
by default when you first run the utility, 
and it enables you to easily specify 
permissions for apps, for example. 
However, it doesn’t protect your Mac from 
trojans, nor does it provide the detailed 
options that are available in the main app 
window. But worry not – well show you 
how to set it all up. kenny HempHiLL

REQUIRES
Little Flocker

yoU wIll lEaRn
How to protect the files 

on your Mac using 
configurable rules 

IT wIll TaKE
30 minutes

>>>Create
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How to Configure Little Flocker

Clicks and key presses
Some apps, such as screen sharing, 

need to simulate interactions to work. To allow 

this, open Little Flocker’s preferences. Under 

the Security heading, enable “Allow software-

composed mouse clicks and key presses.”

Specify how rules work
In the same window, decide whether 

to allow the app to be able to read, write, or 

create files in that folder, and whether you 

want it to be able to execute from that path 

or mount volumes. Click Save.

Create a rule
From Little Flocker’s menu bar icon, 

pick Little Flocker Configuration. Click New 

Rule in the toolbar, choose an app, and then 

use the Browse button to choose a folder you 

want the app to access, or be denied access to.

Enable Simple mode
If you just want basic protection, click 

the menu bar icon and then Enable Simple 

Mode. This grants access to an entire folder, 

giving you less control but decent protection 

without having to allow every file path.

 
JaRGon BUSTER

Policies dictate how Little 
Flocker protects your data 
– for example, by blocking 
access to your webcam. 
Rules govern permissions  
for specific apps.

 
ToUch only?
 
If you have a MacBook 
Pro with a Touch Bar, you 
can set Little Flocker to 
require that to be used 
to respond to prompts, 
rather than having to 
use the keyboard.

Import rules on first run
When you first run Little Flocker, it 

analyzes your Mac’s startup items and creates 

rules for them. In the dialog box that pops up, 

uncheck any you don’t want to import, then 

click the Import button.

Check blocked activities
Click Little Flocker’s status icon in the 

menu bar, then choose Preferences. Under 

Policy is a list of activities that are blocked by 

default. Uncheck any you want to allow without 

having to give permission each time.

How to do anything on your Mac, iPhone & iPad
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Do you have an old Mac 
that’s incapable of running a 
recent version of OS X and so 
doesn’t receive important 

security updates to apps such as Safari? 
That Mac may otherwise be functioning 
perfectly well, and it’d be a shame to get 
rid of it. Well, there’s an alternative 
operating system – called Elementary – 
that will keep your old Mac in service, 
with a desktop environment that’s 
designed to attract Mac users thanks to 
its similar, friendly interface. It’s also 
lightweight, making it perfect for older 
Macs that are showing their age, and it 
comes with the essential apps you’ll need.

In this project you’ll learn how to 
install Elementary alongside your OS X 
installation (and Boot Camp installation 
of Windows too, if you have one), and 
how to switch between them as needed. 
Although light on resources, Elementary 
requires a reasonably fast dual-core 

Speed up an old Mac
Discover Elementary, a Mac-like operating system that’s kept up to date

processor with at least 2GB of memory, 
so you’ll need a Mac from about 2006 
onwards, running OS X 10.6.8 or later.

Before you go any further, we suggest 
you try out Elementary first. The simplest 
solution is to install Elementary in a 
virtual machine within VirtualBox (free, 
virtualbox.org); when setting up the 
virtual machine, select the “Ubuntu 
64-bit” option – this is the version of 
Linux that Elementary is based on. Mount 
the ISO file (see below) as a virtual DVD 
drive and you’re good to go.

before you Start

If you decide to then install Elementary 
as a startup option for your Mac in its 
own right, perhaps to use as its primary 
operating system, it pays to take some 
precautions. Start by making a full backup 
of your entire hard drive, so you can roll 
back if things go awry. Use a tool like 
Carbon Copy Cloner ($40, bombich.com), 

REQUIRES
Dual-core Intel Mac, 

1GB memory,  
30GB free space

yoU wIll lEaRn
How to set up a  

dual-boot Mac for  
OS X and Elementary 

IT wIll TaKE
5 hours

Elementary 
provides your 
aged Mac with a 
modern, updated 
operating system, 
and a whole new 
lease of life.

>>>Create
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and create rescue media that you can use 
to restore your Mac before you begin.

When you’re ready, download 
Elementary in ISO format. Go to 
elementary.io, where you can enter 0 
in the Custom field to avoid paying for it, 
then click “Download elementary OS.” 
Save the ISO file to your Mac’s hard drive 
– it’s more than 1GB in size.

Once done, download and install Etcher 
(etcher.io). You’ll also need a 2GB or 
larger flash drive. With only that USB 
drive plugged in, open Etcher, click Select 
Image, select the ISO file and Etcher 
should find your flash drive. Click 
“Flash!,” enter an admin account’s name 
and password, and wait for Elementary’s 
files to be copied to the drive. When this 
completes, you’ll be told the drive isn’t 
readable – this is normal, so click Ignore.

If you don’t have a suitable flash drive, 
put a blank DVD into your Mac’s DVD 
drive instead, ≈-click the ISO file and 
choose Burn Disc Image instead.

the boot Manager

Next you need to install a boot manager 
that enables you to switch between OS X 
and Elementary. This will appear every 

time you start up your Mac, and shows 
icons for the available systems; use the 
arrow keys to highlight one and press ® 
to choose it. Download rEFInd from bit.
ly/2kKdZM0: click the “binary Zip file” 
link and save the file to your Downloads 
folder. If Safari doesn’t automatically 
extract the Zip file’s contents, double-
click the file in Finder to do so.

Open the folder this creates, then open 
Terminal from /Applications/Utilities and 
drag the refind-install script file from 
the folder onto Terminal’s window, so 
its name appears in the command line. 
Press ® and enter your password to 
install rEFInd. It should end with an 
“Installation has completed successfully” 
message. Restart your Mac and you should 
see the rEFInd boot menu; it’ll always 
default to the last system you started in.

The final preparation step is to free up 
space on your hard drive for Elementary. 
You’ll need to take this space from your 
existing Mac partition (Boot Camp is off 
limits, so you’ll have to take unused drive 
capacity from your OS X partition). Look 
to take a minimum of 20GB, or more if 
you plan to make Elementary your 
primary operating system on this Mac. 

Use Disk Utility 
to free up space 
on your hard drive 
for Elementary to 
reside in.
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Extensible Firmware 
Interface (EFI) provides 
a software interface 
between your Mac’s 
hardware and its 
operating system.
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viSual guiDe Elementary’s desktop

applIcaTIonS
Click here to reveal a 

menu of apps. You can 
drag and drop their 
icons onto the Dock 

to pin them there.

ThE FIlES app
Access your files in 
this app, including 
those in OS X’s volume 
(provided FileVault 
hasn’t been enabled).

ThE DocK
Elementary’s Dock 

works in a similar way 
to OS X’s; tailor it in 

System Settings’
Desktop pane.

ThE mEnU BaR
You can also tailor the 
shortcuts to hardware 
and system settings 
up here by going to 
System Settings’ 
Desktop pane.

Open Disk Utility, select your hard drive  
on the left (not a volume on it) and click 
the Partition tab. Select OS X’s partition 
and reduce its size by the amount you 
want to give to Elementary. Click Apply > 
Partition. Leave the new free space as is.

tiMe to inStall

You’re now ready to embark on the 
installation process. To do so, follow the 
step-by-step guide opposite. When the 
installation finishes, your Mac will restart 
straight into Elementary. But wait: what’s 
happened to rEFInd? It’s been supplanted 
by Elementary’s own boot loader, but you 
can restore it: open the Epiphany web 
browser in Elementary and download the 
same Zip file as you did earlier. Choose 
Applications > Files from the menu bar, 
go to the Downloads folder, right-click 
the Zip file and choose Extract Here.

Open the newly created refind-bin 
folder, then right-click inside the Files 
window and choose Open With > 
Terminal. Finally, type ./refind-install 
and press ®, then enter your account 
password and press ® again; a series of 
messages should appear, confirming that 
rEFInd is the default boot manager once 
more. Finally, restart your Mac and you’ll 
find you can choose Elementary again.

uSing with el capitan or Sierra

To install Elementary alongside El Capitan 
or Sierra,  you must temporarily disable 
System Integrity Protection. Restart your 
Mac and hold ç+R till the Apple logo 
appears. When the Recovery system 
starts, choose Utilities > Terminal, type 
csrutil disable, press ® and restart the 
Mac. After installing the rEFInd boot 
manager, you can turn SIP back on. 
Choose the Apple Recovery option from 
the boot manager; in the Recovery 
system, pick Utilities > Terminal as 
before, but this time type csrutil enable 
to re-enable SIP, then restart. If you ever 
reinstall rEFInd, you’ll have to repeat this.

When prepping storage for Elementary, 
Disk Utility won’t let you create free 
space; it insists on creating a partition 
that you must later delete when installing 
Elementary. Select the disk itself and click 
Partition. Verify you have enough free 
space, then click + to add a new partition. 
Set its format to FAT32 to make it easier 
to identify, set its size accordingly, then 
click Apply and wait for it to be created. 

When you reach the “Something else” 
screen in Elementary’s installer, you’ll 
need to delete the FAT32 partition, then 
use the resulting free space as instructed. 
nick peerS

 
GEnIUS TIp

Though Elementary looks 
quite a lot like OS X, you 

might want to visit  
bit.ly/2kBXTlj for a  

handy guide to getting 
started with its desktop.

 
JaRGon 
BUSTER

An ISO file is a virtual 
image of an optical disc. 
This file format is often 

used to distribute 
bootable installation 

media over the internet.
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102   may 2017  maclife.com



Choose installation type
Elementary won’t be able to detect your 

OS X installation, so choose “Something else” 

at the next screen and click Continue. When 

the partition table appears, select the free 

space which you set aside earlier and then 

click the + button.

First steps
After partitioning your Mac’s hard drive, 

restart with the Elementary install media 

connected. Select the Penguin icon from the 

rEFInd boot manager, then choose Install 

Elementary OS and press ® to continue.

Finalize partitioning
Select the remaining free space and 

click + again. Leave all the settings alone 

except for “Mount point” – click this and set it 

to just a forward slash (/). Click OK and then 

Install Now. Review the list of changes and 

finally click Continue.

Create required 
partitions

Set the size in “Create partition” box to 

4096MB to create a swap file of 4GB in size 

(ample for most setups), select “End of this 

space,” click the “Use as” pop-up menu and 

set it to “swap area,” and then click OK.

Connect to network
When the installer appears, select 

English and click Continue. Connect to your 

Wi-Fi network if prompted. Once done, check 

both boxes to download updates and third-

party software, then click Continue again.

Complete installation
The rest of the installer will feel 

familiar; verify your time zone and keyboard 

layout, then provide a username, computer 

name, and password. Once done, the 

installation should proceed to a successful 

conclusion. You’re ready to use Elementary.

how to Put Elementary on your Mac
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System Integrity 
Protection (SIP) is  
a security feature of 
El Capitan and Sierra 
designed to protect 
against various threats. 
It also hinders a few other 
things you might want to 
do, such as installing 
another boot manager.

 
how To 
DISaBlE ThE 
BooT manaGER

In System Preferences’ 
Startup Disk pane, pick 
the volume containing 
OS X and click Restart to 
disable rEFInd. To then 
bring back rEFInd you’ll 
need to reinstall it.
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The benefiT of using an app 
such as Lightroom, or Apple’s 
now-discontinued Aperture, 
is that you get all the tools you 

need to manage, edit and export photos 
in one place. Neat and tidy, right? What 
might not be immediately obvious is that 
Apple’s own Photos app provides you with 
a surprisingly powerful set of so-called 
“roundtripping” tools.

Roundtripping is the practice of 
opening an image in one app, exporting it 
directly to another app to make changes, 
and then returning those changes to the 
original image in the first app. Photos’ 
version of this uses Extensions, which are 
tools supplied by other apps that you use 
within Photos’ own window.

Whether you round-trip an image or 
simply use an extension within Photos, 
you can get hold of far more advanced 
image editing tools than are available in 
Photos ordinarily, while continuing to 

boost Photos’ editing tools
Add Affinity Photo’s image manipulation tools to Apple’s photo manager

take advantage of Photos’ other features, 
giving you the best of both worlds.

Adding new extensions to Photos is 
easy. Once you’ve installed an app that 
includes one or more of them – Affinity 
Photo, Aurora HDR or Luminar, for 
example – open a picture in Photos’ 
editing mode. On the right you’ll see 
Photos’ own editing tools. Click 
Extensions at the bottom, and pick More 
if you don’t see your app’s extensions in 
the list. This takes you to the Extensions 
pane in System Preferences, which lists 
all the photo-editing ones on your Mac. 
Check the boxes of those you want to use.

In Affinity Photo’s case, Extensions 
work in two different ways: most of them 
make tools from Affinity Photo available 
directly within Photos’ interface. “Edit 
in,” however, passes your image to 
Affinity Photo. The edited version is 
re-imported into Photos when you save 
and close it. Dave STevenSon

REQUIRES
Affinity Photo, 

OS X 10.11 or later 

yoU wIll lEaRn
How to add Affinity 
Photo’s controls to 
Apple’s Photos app

IT wIll TaKE
10 minutes

>>>Create
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how To Use Affinity Photo’s extensions

Finish the job
After making changes in another app, 

to complete the round trip back to Photos 

press ç+S to save your edits, then ç+W 

to close the picture. If you don’t close it, your 

changes won’t successfully return to Photos.

Editing within Photos
Only a few extensions require you to 

pass pictures to third-party apps; others work 

within Photos. Click Extensions again and pick 

Affinity Haze Removal. This provides a very 

useful way to remove low contrast.

Reset your image
If you later decide an edit wasn’t quite 

what you wanted, don’t worry: the original data 

is still present. Remember that you can always 

choose Image > Revert to Original in Photos. 

Your original shot is never lost!

Haze removal
Adjust the Distance and Strength 

sliders and drag the before/after divider to 

check the results; use the Exposure Correction 

slider to fix issues with darkness. Click Save 

Changes to return to Photos’ own editing tools.

 
JaRGon BUSTER

Roundtripping is the 
process of exporting  
a document or image 
from an app, working  
on it in another app,  
and then returning its 
edited state back to  
the first app.

 
GEnIUS TIp

Using one extension 
doesn’t mean you can’t 
also apply Photos’ tools or 
other extensions; use as 
many as it takes to get 
your desired result.

add affinity Photo
Select an image in Photos and press ® 

to switch to editing mode. At the bottom of the 

tools on the right, click Extensions and choose 

More to see those that are installed; add check 

marks to those you want to use.

Edit in affinity Photo
We want to replace the overexposed sky 

in this picture with a better one. This kind of 

cutout work can only be done by choosing Edit 

in Affinity Photo. When you do so, that app will 

spring into life and the picture will open in it.
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Quick Look Navigating the Maps app

AppLe’s MAps App has come 
on in leaps and bounds since 
its, shall we say, disappointing 
debut in 2012. For instance, as 

well as plotting directions to get from A to 
B by car or on foot, it now offers public 
transport directions, and it can tell if a 
ride-booking service such as Uber that 
serves the local area has its own app, and 
provides links to download and use them. 
It’s the little things that count.

Find your way with Maps in ios 10
Discover points of interest and get directions in Apple’s navigation app

Despite the improvements, you may 
still find Maps doesn’t know as much 
about businesses as Google Maps, so the 
more info you can provide the better. 
“Starfish Hotel,” say, might not be 
enough – a town, a street, or especially 
a zip code will help the app along. Bear in 
mind too that while the app stores some 
recently viewed maps on your iPhone, it 
really needs an internet connection to 
keep properly up to date.

For turn-by-turn navigation, it’s a good 
idea to get a windshield mount for your 
iPhone. Using GPS drains the battery 
faster than usual, so an in-car charger 
is advisable as well.

If Settings > Maps > Show Parked 
Location is on and your car has Bluetooth 
or CarPlay tech, Maps marks your car’s 
location when you park to help you find 
it again. So let’s see how to use Maps to 
get from A to B, and maybe stop off at C 
along the way. Rob MeAd-GReen 

REQUIRES
An iPhone with internet 

and GPS connections

yoU wIll lEaRn
How to search for places, 

get turn-by-turn directions 
and take a detour

IT wIll TaKE
5 minutes

Info panEl
This initially shows a 

search bar and places 
you might want to go. 

It changes as you 
search or tap the map.

yoUR locaTIon
Tap this arrow to re-center 
the map on your location. 
Tap it again to reorient 
the map to the direction 
you’re facing.

SEaRch baR
Enter a place name, 
address or zip code.  

Enter a person’s name to 
look up their addresses 
from the Contacts app.

MaRK locaTIon
Drop a pin by holding 
a finger on the map. 
The info panel shows 
the location’s address 
and how far away it is.

>>>Create
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Route suggestions
Next, tap the blue button on the 

panel for a route, starting where you 

are. At the foot of the screen, choose 

a mode of travel: driving, walking, 

public transport, or a ride-booking 

service (if one’s app covers your area).

Where to?
Swipe up on the info panel to 

browse smart suggestions of where 

you might want to go, including any 

address on the Clipboard, the last pin 

you placed, past searches, and your 

favorite places.

Get a better view
Tap Go next to a route to start 

being guided. Tap the summary at the 

screen’s foot for options to divert for 

gas, for example. Tap one to see the 

time it’ll add; an option at the top of 

the screen resumes your main journey.

Some extra options
Tap My Location to set a new 

starting point, then tap Route to 

refresh the route. For public transport, 

tap Leaving Soon to set a travel time. 

In the panel, tap the route for a list of 

directions, and to share them.

Identify a place
Tap the search bar and enter 

details of somewhere specific you have 

in mind to go, or tap the category icons 

below the bar to find nearby amenities; 

tap one on the map or panel for details 

and an option to get directions to it.

Changing a journey
To stop turn-by-turn navigation 

or alter the route (to avoid jams, say), 

tap End, then return to step 1. You can 

press the Home button and use other 

apps during a journey; the status bar 

turns blue – tap it to resume directions.

Look ahead
When you’re following walking 

directions, the bar at the screen’s top, 

which shows the next instruction to 

follow, has a series of dots under it. 

Swipe horizontally on the bar to 

inspect later turns along the route.

Other routes
Alternative routes are shown 

as fainter lines on the map; tap one to 

select it, or swipe up on the panel for a 

list of them; with public transport and 

driving, tap Options to avoid tolls, or to 

pick transport types.

Manually pinpoint
You can also pinch and swipe 

the map to find where you want to go, 

then rest a finger on it to mark it with 

a pin. Swipe up on the panel to take 

action: share the location, set it as a 

favorite, or fine-tune the placement.

How to Use turn-by-turn directions
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Copy the number
To find more information about 

a call you’ve received, open the Phone 

app, go to the Recents tab, tap the 

circled ‘i’ next to the call, and then 

hold down on the number near the 

top of the screen to copy it.

Paste it into Hiya
Next, open Hiya. It should ask 

if you want to look up info for the 

number on the Clipboard; tap Yes to go 

to the Identify tab. Otherwise, paste 

the number into that tab’s search bar, 

then tap the suggestion to identify it.

Review caller info
Hiya searches its database for 

any info it has about the number, such 

as whether it’s a cell or landline. It also 

gives you options to report or block 

the number, along with a summary of 

other people’s experiences of it.

These days it’s easier than 
ever to stay in touch with 
people all over the world, but 
there’s a downside in that it’s 

also easy for unsolicited calls to reach you. 
One cause of this can be that you’ve given 
your personal data to social networks, 
apps, or services, perhaps because they 
require it as part of setting up an account.

Even if you trust that they won’t share 
your details, a security breach could leak 
data and lead to fraudsters, phishers, 
and identity thieves calling you – not to 
mention the barrage of telemarketers.

This is where Hiya (apple.co/2kI5Qsg) 
tries to help out: The service maintains 
a database that collates the numbers of 
known spammers and scammers, and 
will warn you when one is trying to call.

On the Phone app’s incoming call 
screen, Hiya adds a yellow alert for spam 
calls from the likes of telemarketers and 
surveyors, or a red “No entry” shield next 
to any number it identifies definitively as 
a “scam or fraud” – and you have the 
option to block both or pass them to 
voicemail if you prefer.

Block nuisance calls
Make sure fraudsters, phishers, and telemarketers can’t talk to you

You can help boost Hiya’s effectiveness, 
too. Within the app there’s a page for 
reporting or blocking unwanted numbers; 
the info you provide there is sent back to 
Hiya’s developer, which, after a number is 
reported enough times, will add it to the 
public database. That database is updated 
daily and automatically, so you don’t have 
to worry about constantly installing app 
updates – everybody who uses Hiya is 
protected as quickly and easily as 
possible, thanks to community efforts.

Make preparaTions

One thing that might raise concern when 
you first open the app is that it asks for 
permission to access your contacts. 
According to Hiya’s privacy policy, this 
is to “filter out numbers that may look 
spammy, but are actually legitimate (like 
your Doctor’s office).”

After you’ve run through the app’s 
intro, go to Settings > Phone > Call 
Blocking & Identification and ensure the 
switch next to Hiya at the top of the page 
is on. Then read on to learn how to work 
with Hiya. adaM sMiTh

REQUIRES
iOS 10 or higher

yoU wIll lEaRn
How to report and stop 

annoying or risky numbers 
that keep calling you 

IT wIll TaKE
15 minutes

how To Look up information about a number

>>>Create
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Report a call
In the event you receive an 

unwanted call, it’s time to take action. 

You have the option to report it to 

Hiya’s developer in the Identify tab. 

You can also block the number from 

there, or go to the separate Block tab.

Explore options
Go to Hiya’s Options tab; from 

this screen you can access the app’s 

Frequently Asked Questions page, 

contact its support team by email, and, 

most crucial of all, tailor how you want 

the app to respond to suspicious calls.

Categorize the call
When you tap the Report 

button, you can choose from a list of 

categories for Hiya to classify the 

number. Or you can mark the number 

as Not Spam to correct inaccuracies 

in Hiya’s database.

Block spam
For low-threat calls (spam), you 

can choose whether Hiya should alert 

you by adding a yellow sign next to the 

caller ID on the incoming call screen, or 

simply “block” spam by default, which 

sends it to voicemail.

Provide more detail
Once you’ve chosen your 

category, you have the option of 

providing more specific details about 

which information the caller was trying 

to get from you, such as your credit 

card information.

Check for fraud
For calls that pose a higher risk 

to you, such as those from fraudsters, 

you can also choose to send them to 

voicemail too, or be given a clear 

warning with a red “no entry” sign 

on the incoming call screen.

> add an exTra layer of proTecTion

A measure to keep your main number private

Thousands of spammers and fraudsters are added to Hiya’s database each day, 

so hopefully you’ll find it useful in reducing the number of unwanted calls that you 

pick up. However, while Hiya can protect you from the symptoms of spam calls, 

ensure you also take steps against the cause. Try unlinking your number from 

social media accounts, or use an app like Sideline (free, apple.co/2kh99Dd) to 

provide you with a second phone number to use, which is especially helpful when 

you’re unsure whether to give an organization your main mobile number.

how To Take action over an unwanted call

how To Tailor actions for spam and scam calls
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You maY think you know 
about every single way you can 
use the Clock app, but in iOS 
10 it has gained a new feature, 

Bedtime, that’s well worth checking out.  
As its name suggests, it’s all about 
helping you get a good night’s rest, and 
it’ll also give you some insight into your 
sleep patterns.

Tap Bedtime’s icon in the app’s bottom 
bar and you’ll be asked a few questions, 
one at a time, such as how many hours 
of sleep you need, when you want to be 
woken up, and how far in advance you 
want your device to prompt you to get 
ready for bed. The last of these can be 
set to occur up to an hour before bedtime.

If you already make use of the Clock 
app’s Alarms feature, rest easy in the 
knowledge that instructions you give to 
Siri, such as “Delete all of my alarms” 
and “Turn off my alarms,” don’t affect 
Bedtime’s wake-up call. In contrast to 
alarms, Bedtime offers a more gentle 
selection of sounds to rouse you from your 
slumber. In fact, they’re so gentle that 

Get a good night’s rest
Use iOS’s Bedtime feature to ensure you get some quality shut-eye

until you’ve tried it out for at least a few 
days to ensure your pick of sound effect 
and volume are effective, we recommend 
you keep a regular and more boisterous 
alarm set for shortly after Bedtime’s 
wake-up call, to ensure you don’t end 
up being late for work.

Once you’ve set up your bedtime 
schedule, it’s worth complementing it 
with iOS’s Do Not Disturb and Night Shift 
features. The former ensures only 
essential communications get through to 
you between certain hours; go to Settings 
> Do Not Disturb to configure when this 
should be active.

Optionally, you can allow a group of 
people you’ve set up in the Contacts app 
to get through to you anyway – useful for 
relatives, or if your job requires you to be 
available on call, say.

Meanwhile, Night Shift reduces the 
amount of blue light that’s output by 
your device’s screen so that it’s warmer, 
ostensibly to help you relax late in the 
day. To set it up, go to Settings > Display 
& Brightness. alan StonebridGe

REQUIRES
iOS 10’s Clock app 

yoU wIll lEaRn
How to set up and use the 

Clock app’s Bedtime 
feature

IT wIll TaKE
5 minutes

Sleep/wake times
After running through Bedtime’s 

initial setup, its page shows a switch that 

toggles it on or off. When on, drag the 

alarm and moon icons on the clock face 

to set bed and wake times; your sleep’s 

expected duration is shown in the middle.

Scheduling/sounds
Tap Options to set days on which 

the feature is active, and how long before 

you’ll be reminded to wind down. You can 

pick the sound that’ll wake you (vibrate 

only is an option), the volume it’ll build 

up to, and have your iPhone vibrate, too.

Review your rest
With your iPhone next to you, it’ll 

analyze your movements. The current 

week’s sleep is visualized at the bottom 

of the page; tap “More history” to look 

further back and correlate with data  

from accessories or entered manually.

how to Manage and monitor your sleep patterns
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Locate iCloud settings
In the recent iOS 10.3 software update, 

Apple consolidated settings that relate to 

your Apple ID, iCloud, and the iTunes and App 

Stores in one place, which is conveniently at 

the top of Settings. Start by tapping that row.

iCloud storage usage
Tap iCloud near the top of the next 

page. You’ll see a color-coded breakdown of 

what’s using your iCloud storage – not just 

iCloud Drive, but email and backups, too. 

Tap that, and then tap Manage Storage.

It’s temptIng to leave certain 
settings on your iPhone or iPad 
on their defaults, not least 
iCloud Backup – how many 

times has the importance of backing up 
been hammered into your brain, after all. 
That may seem like the safest strategy, 
but ask yourself whether it’s costing 
you more money than necessary.

While writing this tutorial, we were 
shocked to discover that iCloud Backup 
was putting 941MB of data from Tweetbot, 
and 459MB from Amazon Music online. 

save money with iCloud settings
Be frugal by reclaiming wasted online storage capacity 

Neither of those apps stores anything 
we can’t easily obtain again. So, if you’re 
trying to stay within the 5GB Apple 
provides for free with all iCloud accounts, 
we suggest checking the space your 
backups of app data are taking up, and 
whether that’s close to costing money 
that you don’t really need to spend. 

However, if you’re already paying 
for more space in your iCloud account, 
and an ample amount remains free, you 
may not care to follow the advice here, 
as it isn’t going to change anything for 
the better for you.

The following walkthrough is written 
with iOS 10.3 in mind, which was released 
just as we went to press. That update 
relocates some of the settings you’ll 
need to access, but the same principles 
apply in previous versions – instead of 
tapping the new consolidated row for your 
Apple ID, iCloud, iTunes, and App Store 
accounts at the top of Settings, scroll 
down and look in the discrete iCloud 
submenu instead. AlAn stonebrIdge

 
Get more space 

If you prefer to back up 
everything regardless, but 
need more space to do so, 
tap the storage breakdown 

in iCloud’s settings, then 
Change Storage Plan.

reQUIres
iOS 10.3

yoU wIll learn
How to stop apps using 
an unwanted amount of 
precious iCloud storage

It wIll taKe
15 minutes

How to Reclaim wasted iCloud storage

>>>Create
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Finer details
The next page breaks things down more 

precisely. Ignore the Documents & Data section 

lower down, despite it listing how much iCloud 

storage each of your apps is using. Instead, 

under Backups, tap the device you’re using.

Is it necessary?
Several of our apps’ backups were 

using a significant amount of the storage 

iCloud gives you for free. Consider turning off 

backups for apps that contain media that’s free 

to redownload, or for which there’s no benefit.

What saves to iCloud
As well as disabling backups for apps, 

consider whether apps should save content to 

iCloud Drive at all, or if you’re content to use 

File Sharing (see apple.co/2nObcTV) to move 

files to and from your Mac manually.

Identify space hogs
Under the heading Choose Data to Back 

Up, tap Show All Apps, and then work your way 

down the list, noting any apps whose usage 

you consider excessive or unnecessary. You 

may be surprised by what’s backed up online.

Free up the space
When you switch off an app’s backups, 

you’re asked to confirm; doing so deletes the 

backup data from iCloud immediately, freeing 

up space for what really matters, such as data 

that actually warrants being backed up.

Limit select apps
At the top of iCloud’s settings, scroll 

past “Apps Using iCloud” to third-party apps. 

Check online whether those that use lots of 

space support an easy transfer method (File 

Sharing, or AirDrop); switch off those that do.

 
JarGon BUster

iCloud Backup is a 
feature of iOS that will 
automatically back up the 
data contained in each of 
the apps you’ve installed 
on your iPhone or iPad. 
It includes everything 
from your photo library to 
saved progress for games.

 
per-devIce 
control
 
You’ll need to repeat 
these steps on each 
of your iOS devices 
to configure their 
backups individually.
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NEXT 
MONTH 

>>> Build a better 
backup system 

>>> Secure your 
iPhone and iPad 

>>> The first HomeKit 
camera, reviewed
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PErsONal cOMPuTErs and tech 

support were never meant to go 

together. In 1976, when Steve Jobs 

pitched the Apple I to Paul Terrell, 

manager of The Byte Shop, the deal 

was that Jobs and his partner Steve 

Wozniak would deliver the machines to 

the store. What happened after that 

wasn’t any of their concern.

Dealing with customers was the 

retailer’s job, and that was largely how 

it would stay in the low-margin, high-

volume microcomputer market. Even 

when direct-sales giants like Dell and 

Gateway sprang up offering PCs over 

the phone, the last thing they wanted 

to invest in was a shop front to which 

users could bring their problems.

– just a day later, in Johnson’s 

recollection – was Genius Bar. To ensure 

his “geeks” were both approachable and 

effective, Johnson created a unique 

three-week in-house training program 

covering troubleshooting, repairs, and 

how to interact with people.

The result was, and still is, service that 

sets Apple Stores apart. Today, expanded 

Family Room areas offer advice and tips, 

and the redesigned Union Square store 

in San Francisco features a Genius Grove 

where assistants mingle under a canopy 

of trees – far from a Geek Bar.

It was only after Jobs returned to 

Cupertino in 1997 that his legendary 

control-freakery shifted Apple’s sales 

focus from working with resellers to 

building its own stores, where the 

presentation could get the same 

attention to detail as the products. 

As newly hired retail chief Ron Johnson 

pointed out, that also brought a chance 

to solve users’ problems face to face.

Jobs’ reaction? As Johnson told 

Silicon Valley journalist Kara Swisher in 

March 2017: “He said, ‘I’ve never met 

someone who knows technology who 

knows how to connect with people.’” 

The idea was “so idiotic” that they might 

as well call it “the Geek Bar.” But the 

trademark that the company registered 

NEXT ISSUE oN SAlE

May 30

raNdOM aPPlE MEMOry

Genius Bar
Talking to customers was the last thing a computer 
maker wanted, finds adam Banks – so Apple did it 

>>>RAM
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